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preface

After completing my master’s degree, | moved from Poland to Germany and began
working as a .NET developer for a company full of experts in ... Clarion. The Clarion
folks were developing the company’s flagship—very successful leasing software—and |
was left to do “the rest”: a bit of interfacing with web services (no way to do it from
Clarion at that time), a rewrite of a Pocket PC leasing calculator, a piece of a website
for a customer in Switzerland, and so on.

Over time, | was given more and more small software gems to manage. “How about
introducing a source-control system?” | thought. | was uneasy about the “zip and store
on a share” method my old friends were using. Fortunately, my bosses were open-
minded, and | was given a free hand. | could do whatever | wanted to make my work
life easier. And believe me, there was a lot to change! | started with Visual SourceSafe
and a plug-in for Visual Studio. This made a difference, but | didn’t stop searching.

It was a time of Agile hype. The popularity of test-driven development was increas-
ing, and my adventure with unit testing began. We moved from Visual SourceSafe to
Subversion, and about that time | saw some information about CruiseControl.NET. It
was a build server. | thought that was cool: all | had to do was write a build script and
check the source into the version-control system, and CruiseControl.NET would
detect my changes, pull the source, and perform the build; it would include the tests
automatically, deploy the created bits to the test server, and tell me right away if some-
thing was wrong. | knew this continuous integration (Cl) process would change the
way software was developed on my team. All the pains of late consolidation were allevi-
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ated: we had a fairly ready, tested piece of software every time we checked in to the
source-control system.

| had to learn MSBuild to write my build scripts. The learning curve wasn’t too
steep; soon, | had a custom-built script for every project we worked on. | was lucky to
have virtually no hardware limits from my bosses. | got a fairly old server and created
my first build machine. Boy, was it cool to see all the “yet another successful build”
messages from the Windows tray-notification tool.

From day one, | was a fan of and a believer in the Cl concept. I’'m strongly con-
vinced that it was the sole attraction that kept me in the Chaos Developer Club in
those days. Now I'm running my own company, and one of the most important tools
in my repertoire is the Cl server.

Back in 2007, | wrote an article about Cl for a Polish computer magazine. It reso-
nated in the community and was generally well received. Sometime after that, a
friend suggested that the topic was worth more exploration—perhaps in a book. |
couldn’t have agreed more. | ran the idea by a few Polish publishers, but they all
said the topic was too specific for the Polish market. “Well,” | thought, “if the Polish
market is too narrow, how about the global market?” It was the first time 1'd consid-
ered writing the book in English. | was concerned because English isn't my mother
tongue. | knew the language well enough to read just about anything written in Eng-
lish, but would | be able to write in it? With the support of Manning, and Craig as
coauthor, | decided to give it a try. You are holding the result!

MARCIN KAWALEROWICZ
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about this book

Continuous integration is what it is, regardless of whether it's done in .NET or some
other technology. It’s a set of best practices aimed at easing the integration pains that
arise during the course of a software project. .NET has its own set of tools to make Cl
happen, but the basic rules stay the same: use a source-control system, build by issuing
one command, test, analyze, and deploy. Be ready.

Who should read this book?

This book is for developers who want to dive into state-of-the-art Cl techniques. It pro-
vides simple guidance on how to create a full Cl process with minimal effort and cost.
The book wasn’t written for experienced build masters and old-time Cl practitioners,
but we hope they will find some gems of knowledge as well.

Roadmap
The book is divided into three parts:
Part 1 “Make it happen” includes chapters 1-6
Part 2 “Extend it” consists of chapters 7-8
Part 3 “Smooth and polish it” covers chapters 9-12
Marcin wrote chapters 2 through 10. Craig contributed chapters 1, 11, and 12.
Chapter 1 lays the foundation. It describes the Cl process and gives you advice

about how to introduce it to your company. We'll show a simple way to set up a Cl pro-
cess using a CMD file.

Xix
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Chapter 2 describes the sine qua non for Cl: a source-control system. You'll learn
what the code repository is and how to use it. We’'ll help you choose the right tool for
your needs. We’'ll describe Subversion and TFS source control as examples of source-
control systems that are ready to be used in Cl.

Chapter 3 goes deep into build automation. We'll describe how to set up a system
that lets you build an entire project using one command. We'll present MSBuild as our
tool of choice.

In chapter 4, we'll help you choose a Cl server. We'll describe how to install and set
up CruiseControl.NET, TFS in its basic configuration, and JetBrains TeamCity.

In chapter 5, we'll examine the responsiveness of Cl servers. We'll look at the feed-
back mechanisms available in these systems, including web-based reports, system tray
notifications, email, and SMS notifications. At the end, you’'ll use a USB LED toy to get
immediate feedback from your system.

Chapter 6 describes unit testing and how it’s a characteristic of the Cl process.
You’ll use NUnit and MSTest to build a simple test suite, and you’ll integrate the test
results with the Cl server. We'll examine test coverage and sending reports as feedback
to developers. You'll learn how to mock some of the tests and how doing so affects the
Cl process.

In chapter 7, we'll extend your test repertoire with integration, system, functional,
and acceptance tests. You'll use various frameworks to test various technologies: White
to test Windows Forms and Silverlight, Selenium to test Web Forms, and FitNesse to
establish user-acceptance testing. You'll learn if and when it's OK to introduce these
kinds of tests to the Cl process.

Chapter 8 describes how to perform static code analysis. You'll analyze precom-
piled .NET intermediate language using FxCop. We’ll show how to use StyleCop to
analyze C# code even before it’s precompiled. And we’ll explain how to use NDepend
to do additional analysis. We’'ll provide information about how to extend and inte-
grate this analysis with CI.

Chapter 9 describes XML comment notation and how to generate MSDN-style doc-
umentation from it. We’ll show you how to generate documentation continuously.

Chapter 10 deals with deployment and delivery, including using Visual Studio to
create setup files, and using WiX and MS Deploy. We'll show you how to use these tech-
niques on the Cl server.

Chapter 11 deals with continuous database integration. We’'ll show you how to main-
tain a database using Visual Studio and how to perform tests at the database level.

Chapter 12 is about extending Cl. We’'ll explain how to deal with slow builds, how to
scale the Cl process, and how to check the maturity of the Cl process you're using.

Code conventions and downloads
All source code in listings or in text isin a fixed-width font like this to separate it
from ordinary text. Code annotations accompany many of the listings, highlighting
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important concepts. In some cases, humbered bullets link to explanations that follow
the listing.

This book includes a fair amount of source code that is available for download.
The source code illustrates the techniques described in the book. It is nof produc-
tion code. We provide many configuration files, especially for CruiseControl.NET.
You can access the source code from the publisher’s website at www.manning.com/
Continuouslntegrationin.NET.

Author Online

Purchase of Continuous Integration in .NET includes free access to a private web forum
run by Manning Publications where you can make comments about the book, ask
technical questions, and receive help from the authors and from other users. To
access the forum and subscribe to it, point your web browser to www.manning.com/
Continuouslntegrationin.NET. This page provides information on how to get on the
forum once you are registered, what kind of help is available, and the rules of conduct
on the forum.

Manning’s commitment to our readers is to provide a venue where a meaningful
dialog between individual readers and between readers and the authors can take
place. It is not a commitment to any specific amount of participation on the part of
the authors, whose contribution to the book’s forum remains voluntary (and unpaid).
We suggest you try asking them some challenging questions lest their interest stray!

The Author Online forum and the archives of previous discussions will be accessi-
ble from the publisher’s website as long as the book is in print.
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about the cover iflustration

The figure on the cover of Continuous Integration in .NET is captioned “Bride from Sinj
in Dalmatia, Croatia.” The illustration is taken from a reproduction of an album of
Croatian traditional costumes from the mid-nineteenth century by Nikola Arsenovic,
published by the Ethnographic Museum in Split, Croatia, in 2003. The illustrations
were obtained from a helpful librarian at the Ethnographic Museum in Split, itself sit-
uated in the Roman core of the medieval center of the town: the ruins of Emperor
Diocletian’s retirement palace from around AD 304. The book includes finely colored
illustrations of figures from different regions of Croatia, accompanied by descriptions
of the costumes and of everyday life.

Sinj is a small town in the center of an area in Dalmatia known as Cetinska krajina, a
group of settlements situated on a fertile plain through which the river Cetnia passes.
Sinj lies between four mountains which give the area its specific sub-Mediterranean
climate. The town grew around an ancient fortress (held by the Ottomans from the
sixteenth century until the end of seventeenth century) and a Franciscan monastery
with the church of Our Lady of Sinj, a place of pilgrimage.

The bride on the cover wears a red cap over which she ties a blue scarf, and a white
dress embroidered with red wool that she wears over a white shirt. She has tied a red
linen apron around her waist and added a long, dark blue vest decorated with red
wool. A small bouquet of flowers completes the bridal costume.

Dress codes and lifestyles have changed over the last 200 years, and the diversity by
region, so rich at the time, has faded away. It is now hard to tell apart the inhabitants
of different continents, let alone of different hamlets or towns separated by only a few
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miles. Perhaps we have traded cultural diversity for a more varied personal life—
certainly for a more varied and fast-paced technological life.

Manning celebrates the inventiveness and initiative of the computer business with
book covers based on the rich diversity of regional life of two centuries ago, brought
back to life by illustrations from old books and collections like this one.



Part 1

Make 1t happen

technically savvy programmer and project manager once asked how
we’'d describe continuous integration (Cl) to someone who had never heard of
it. We said there are two types of answers, and which one to give depends on how
much time the listener has. The longer answer starts with part 1 of the book.
The shorter one is not really an answer—it’s another question that can give you
an idea about what Cl is. Do you remember the last time you released software?
That’s the time in the project when you gather all the bits and pieces required to
deliver the software to the customer. Was it painful? Yes? Well, that’s where CI
can come to the rescue.

In the first part of this book (chapters 1 through 6), we’'ll lay the groundwork
for a well-designed Cl process in .NET. You'll learn the basics required for any Cl
system. We'll start by looking at Cl in general. We'll define the term and talk a lit-
tle about how to do Cl in .NET. After that, we’ll introduce the source control sys-
tem as part of the Cl tool chain that can’'t be omitted. We'll help you choose the
right one and introduce it into your day-to-day work.

As a second ingredient that’s required for Cl, we’ll describe build automa-
tion. We’'ll show why you need a single command-build process and how modern
XML-based build systems are perfect for the .NET Cl process. You'll also find out
how to choose the right Cl server to bind all the ingredients into one.

We'll then look at unit testing—what it is and how to use it in Cl. You'll
learn to write unit tests and automate their execution. We'll discuss Cl servers
and their ability to give immediate feedback about the state of the build pro-
cess. It’s a core concept of the Cl process that every degradation in code qual-
ity should be immediately visible, so the team can react as swiftly as possible to
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make obstacles disappear. This is the purpose of controlling and reporting mecha-
nisms in modern Cl servers. We'll look at how you can extend these reporting capa-
bilities with your software.

After reading this part of the book, you’ll be able to set up your own Cl process
using free or inexpensive software. You'll understand what the Cl process is and
how to use it to your team’s benefit. And you’ll be ready to extend Cl to better suit
your needs.



Understanging
continuous integrai@n

This chapter covers

= Continuous integration theory
= A Hello World Cl example

= A preliminary list of Cl tools

As developers, we're interested in creating the best possible applications for our cus-
tomers with the least amount of work. But with applications becoming more com-
plex and having more moving parts, creating great applications is getting harder,
even with advances in tools such as Visual Studio and the .NET Framework.

One of the keys to improving applications and productivity is to automate some
of the work. Continuous integration (Cl) is one of the best ways to do this.

Have you ever written code that did its small task perfectly, but then discovered
unexpected side effects when you integrated that piece of code with the rest of the
application? Do you always have success integrating your code with code from
other developers? Have you ever shipped an application, only to find that it didn’t
work for the customer but you couldn’t duplicate the error? Can you always pre-
dictably measure the state of the code for your current project? Cl helps alleviate
these problems and more.

In this chapter, you’ll learn what Cl is all about, why should you use it, and how
to overcome objections to its adoption from your team. We'll briefly introduce you
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1.1.71

CHAPTER 1 Understanding continuous integration

to several free or low-cost tools such as CruiseControl.NET, Subversion, MSBuild, Team
Foundation Server, and TeamCity that are part of a complete Cl process. Throughout
the rest of the book, we’'ll explain in detail how to use these tools.

This chapter also demonstrates a simple Cl process through an example using
batch files. We'll also get started on a more complex Visual Studio Solution that we'll
use to demonstrate various Cl tools and techniques. But before we do any of that, you
need to understand exactly what Cl is.

What does it mean to integrate continuously ?

When you adopt Cl, it’s likely that you’ll make major changes in your development
processes because you’ll move from a manual system to an almost completely auto-
mated system. Along the way, you may meet resistance from your team members. This
section provides you with reasons to use Cl and how to overcome objections. But
before we take you there, we need to define Cl.

Defining continuous integration
One of the best definitions of continuous integration comes from Martin Fowler
(www.martinfowler.com/articles/ continuouslntegration.html):

Continuous Integration is a software development practice where members of a team
integrate their work frequently, usually each person integrates at least daily—leading to
multiple integrations per day. Each integration is verified by an automated build
(including test) to detect integration errors as quickly as possible. Many teams find that
this approach leads to significantly reduced integration problems and allows a team to
develop cohesive software more rapidly.

This definition contains an important phrase: “multiple integrations per day.” This
means that several times each day, the Cl system should build and test the application.
But multiple integrations per day isn’'t where you begin your journey into Cl; we rec-
ommend against this because many shops not using Cl will meet enough resistance
just automating the build, let alone doing multiple builds per day. (We’ll talk more
about overcoming team resistance later in this chapter.) Ideally, you should set up
your Cl process just as you create software: by taking small steps, one at a time.

Here is another definition:

Cl is the embodiment of tactics that gives us, as software developers, the ability to make
changes in our code, knowing that if we break software, we'll receive immediate feedback ...
[1t is] the centerpiece of software development, as it ensures the health of software through
running a build with every change.
—Paul Duval, Continuous Integration
(Addison-Wesley, 2007)

The key phrase here is “the centerpiece of software development.” This means what-
ever development process and methodology you use, Cl is a key part of it.

vww . allitebooks.cond
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1.1.2

What does it mean to integrate continuously?

Our definition is similar to those we’'ve mentioned. Here’s how we define continu-
ous integration:

An automated process that builds, tests, analyzes, and deploys an application to help
ensure that it functions correctly, follows best practices, and is deployable. This process runs
with each source-code change and provides immediate feedback to the development team.

As we were discussing this definition, we wondered what a build is. |s it the same as
clicking Build on the Visual Studio menu, or something more? We finally decided that
the definition varies depending on what you’re doing. Early in the development pro-
cess, a build can be as simple as compiling and unit testing the code. As you get closer
to release, a build includes additional and more complete testing and running code
metrics and analysis. You can also go as far as combining all the different files into an
install set and making sure it works correctly.

Finally, don’t get caught up with the meaning of continuous. Cl isn’t truly continu-
ous, because integration occurs only at specific intervals or when triggered by a spe-
cific event. Integration is continuous in that it happens regularly and automatically.

Now that you know what Cl is, let’s see how it changes your development process.

Cl and your development process
Is your development process agile? Do you use extreme programming (XP), scrum,
or something else? I's your company deeply rooted in waterfall methodologies? Does
your process fall somewhere between agile and waterfall?
It really doesn’t matter which methodology you use, because you probably follow
pretty much the same process when it comes to writing code:
1 Check out the needed source files from your source code repository.
2 Make changes to the code.
3 Click Build on the Visual Studio menu, and hope everything compiles.
4+ Go back to step 2. You did get compile errors, didn’t you?
5 Run unit tests, and hope everything is green. We hope you’re running unit tests.
6 Go back to step 2. Unit tests do fail. In this case, you'll see red. Perhaps in more
ways than one.
7 Refactor the code to make it more understandable, and then go back to step 5.
8 Check the updated code into the source code repository.

When you start using Cl, you’ll follow the same process. But after you check in the
source code, you'll take additional steps (see figure 1.1).

9 An automated system watches the source control system. When it finds changes,
it gets the latest version of the code.
10 The automated system builds the code.
11 The automated system runs unit tests.
12 The automated system sends build and test results to a feedback system so that
team members can know the current status of the build.
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Figure 1.1 In the ClI process, developers check code into the version control
repository. The automated Cl system polls the repository for changes and then builds
and tests the code. Results are posted to a feedback system where team members
can see the results.

At this point, you may be asking yourself several questions, such as, “Why do tests need
to be run multiple times?” or “Why can’t | just click Build in Visual Studio?” The
answer to these questions is the same: automating the building, testing, and running
of other processes through Cl ensures that the code from multiple people integrates,
compiles, and functions correctly, and that it can be reproduced the same way every
time on a different machine than your workstation. Also, consider that you may have
an application with many assemblies. When you click Build, you may only build the
assemblies you're responsible for. Even if you're a one-person shop, adopting Cl will
improve the quality of your software.

Automating the build and the unit tests are steps in the right direction, but a good
Cl process can do more—and eventually you'll want it to, so you can maximize its
usefulness. Things like running code-analysis tools, running tests in addition to unit
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testing, building an install package, and simulating an install on the customer’s PC are
all possible through a Cl process. But you won'’t do all these things with every change.

Do I need to build with every change?

The Cl steps we've outlined make it sound like every time a developer checks in
code, a build is triggered. This is the ultimate goal and the reason it’s called continu-
ous integration. Reread the quote from Paul Duval: he says you should build “with
every change.” Martin Fowler says, “multiple integrations per day.” That’s pretty close
to continuous. But, remember, continuous is the eventual goal. You don’t want to
start there.

One way to begin to set up your Cl system is to start by getting the latest changes
from source code and building the application. Then add unit tests. And only do this
daily at first. You can call this a daily build; but as you'll see in a moment, a daily build
includes other things that don’t run when you do the incremental build.

When you have this build running every day, add two or three builds per day that
only build and test. It won’t take long, and you’ll be building continuously and adding
different builds to do different things. The exact types of builds you need depend on
your environment and applications. Some of the more common builds are listed in
table 1.1.

Table 1.1 Some of the different types of builds you can do with Cl
Build type How it’s used
Continuous/Incremental Runs when code is checked in. Does a quick compile and
unit test.
Daily/Nightly Does a compile and full suite of unit tests and possibly

additional testing such as FitNesse.

Weekly Does a compile, full unit testing, and additional testing
such as FitNesse.

Release Creates an install set and then runs and tests the inst
all process.

QA Creates a build just for the QA team.

Staging Builds and copies assemblies to a staging server.

The most important build, and the one you want to get to, is the continuous or incre-
mental build. This build is automatically triggered whenever source code is checked in
to the repository. Because this build can potentially run several times per day, and one
build may run immediately upon completion of another, you want the continuous
build to run quickly—preferably in under 5 minutes. This build should get the

updated code, rebuild the assembly it’s in, and then run some preliminary unit tests.
Reports are sent to the feedback mechanism.
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Next is the daily build, often called the nightly build. Rather than running whenever
the code changes, the daily build is scheduled to run once per day, usually in the
middle of the night. Because you don’t need to worry about the next build starting
immediately, the daily build typically runs a complete suite of unit tests against all the
code. Depending on your environment, you may want to add additional automated
tests or code analysis.

Another build type is the weekly build, which runs automatically and usually on the
weekend. Once a week, you should run a code analysis and additional tests with tools
like Selenium, FitNesse, and NUnitForms. You may also want to create documentation
with Sandcastle or do continuous database integration. As you get closer to your
release date, you may want to run the weekly test build more often. You'll also want to
run a release build.

The purpose of the release build is to create and test an install set. The release
build is typically manually triggered. But after the build is started, all the other steps
are handled automatically. In a release build, you'll build all the source code, incre-
ment the version number, and run a full suite of tests. You'll then create the install set
and simulate the install. Good Cl server software will have a way to check if the install
was successful and then roll back the changes, so that the test system is ready for the
next round of install testing.

Your environment may require other types of builds. For example, you may have a
build that copies assemblies to a QA environment after the build. Or you can copy files
to a staging or production server. The bottom line is that many different types of
builds are needed for different purposes. But because steps are automated, you can be
sure that things are done the same way every time.

As you introduce Cl and different types of builds, some team members may resist the
changes. It's important to overcome these objections so your Cl process is successful.

Overcoming team objections

With all these builds going on and developers having to change their routine and
check in code more often, you may get objections from team members. Some com-
mon objections are as follows:

+ Cl means increased maintenance.
Someone will have to maintain the Cl system. This will take them away from
programming duties. At first, there will be extra overhead to set up the system;
but when a project is fully integrated, your team will save time because it will be
faster and easier to test the application and detect and fix bugs. Many teams
report that after the Cl process is running, maintenance takes less than an hour
per week.

« This is too much change, too fast.
It’s difficult to adapt to the new way of doing things. Don’t implement every-
thing at once. Start out with a simple build once per day, and then add unit test-
ing. After the team is comfortable with this, you can add one or two additional
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builds per day or start doing code analysis. By taking the process in baby steps,
you’ll get more buy-in into the process.
+  Cl means additional hardware and software costs.
Start out small with an old PC as your Cl server if you need to. Eventually, you'll
want better hardware so that you can run builds quickly (remember, the inte-
gration build should run in under 5 minutes); but for a build two or three times
a day, older hardware will work. If you use the tools we discuss here, your soft-
ware costs will be minimal.
+  Developers should be compiling and testing.
We’re not taking those responsibilities away from developers. We’re moving
much of the grunt work to an automated system. This allows programmers
to use their brains to solve the business problems of the application. This
makes the developers more productive where it counts: writing and debug-
ging code.
« The project is too far along to add Cl.
Although it’s better and easier to place a new project under a Cl process, the
truth is, most of the work we do is maintenance on existing projects. An
existing project may not have unit tests, but you’ll still use source control and
need to do builds. You can benefit from Cl no matter how far along your
project is.
One of the authors once worked in an environment where each developer was respon-
sible for a different executable in a 15-year-old C++ application. Each executable was
built locally and then copied to a shared folder on the network where QA picked it up
and tested it. Problems arose because each developer used a different version of third-
party components, and each developer used different compiler switches. This meant
that if one developer was on vacation, and a bug in their code needed to be fixed, it
was difficult to reproduce their development environment on another developer’s
workstation. It was so troublesome that management finally decided that unless the
customer was down due to the bug, the fix would wait for the responsible programmer
to get back to the office. If Cl had been in place, many of the issues with the software
wouldn’t have happened.
Here are several reasons to use Cl in your development process:

'+ Reduced risks —By implementing good Cl processes, you'll create better software,
because you’'ll have done testing and integration earlier in the process, thus
increasing the chances of catching bugs earlier. We'll talk more about reducing
risks in the next section.

«  Deployable software —If you automate the installation process, you’ll know that
the software installs as it should.

 Increased project visibility —The feedback mechanism allows project members to
know the results of the build and where the problems are. Bugs can be fixed
sooner rather than later, reducing costs and the time spent fixing bugs.
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+ Fast incremental builds —In October 2009, ZeroTurnaround released results of a
survey of more than 500 Java developers. In the survey, 44% said their incre-
mental builds took less than 30 seconds, and another 40% said build times were
between 1 and 3 minutes. The overall average build time was 1.9 minutes.1
Although the survey was for Java apps, there’s no reason not to believe your
.NET projects will have fast incremental build times. Fast incremental build
times means you get build and test results sooner, helping you to fix bugs ear-
lier in the development process.

Don’t let team objections get you down. The initial resistance will eventually give

way to acceptance as the team works with the Cl system. Virginia Satir, a family ther-
apist, developed the Satir Change Model, which shows how families deal with

change. Steven Smith wrote that the same model can be used to show how new tech-
nology is adopted (http://stevenmsmith.com/ar-satir-change-model/). The change
process involves five steps:

1 Late status quo —Everyone is working in the current process and knows how
it works.

2 Resistance —A new element is introduced. People are hesitant to change how
they’re working. The late status quo works fine. Why change it?

3 Chaos—The new element is adopted. There is no longer a normal way of doing
things. Daily routines are disrupted.

« [Integration —People slowly become adjusted to the new way of doing things. It
gets easier to do their jobs with the new methodology.

5 New status quo —The new element becomes fully integrated into the system. Peo-

ple now look at it as normal.

Almost every team has adopted new methodologies at one time or another. This pro-
cess should sound familiar to you.

As you meet resistance from the team, be persistent in implementing the changes.
Team members will eventually accept them. Some team members will adopt Cl more
quickly than others, who may need more convincing. Perhaps you should show them
how CI reduces risk in the development process.

1t’s all about reducing risk
Your customer doesn't like risk. Your manager doesn’t like risk. Your project manager
should have plans in place to mitigate risk. In the end, you shouldn’t like risk either.
Cl is all about reducing risk.

Perhaps the biggest risk in software development is schedule slippage—in other
words, the project being delivered late. Because of the feedback mechanism in the Cl

1

Alex Handy, “Survey finds that incremental Java builds are speeding up,” Software Development Times, Oct. 29,

2009, www.sdtimes.com/link/33867.
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process, team members always know the status of the current build, which helps you
know whether the project is getting behind schedule. Feedback mechanisms will be
presented in chapter 5.

The next biggest risk is bugs. It’'s been shown that the later in the process you find
a bug, the more costly it is to fix. Some estimates suggest that it costs as much as
$4,000 to fix a single bug in internal, home-grown corporate web applications. In
2005, a well-known antivirus company had a bug in an update. That single bug caused
customers to lose confidence in the antivirus software and forced the company to
lower its quarterly income and revenue forecasts by $8 million. Do you want your
company to experience similar costs? One of the caveats of Cl is that bugs are fixed as
soon as they’re reported. By integrating and testing the software with each build, you
can identify and fix bugs earlier in the process. We'll discuss unit testing in chapter 6
and application testing in chapter 7.

Have you considered how many different code paths exist in your application?
Have you tested each if/else combination? How about every case of a switch
statement? In his book 7esting Computer Software (John Wiley & Sons, 1999), Cem
Kaner mentions a 20-line program written by G. J. Meyers that has 100 trillion
paths. Code coverage is a methodology that checks which paths are tested and which
aren’t. A great thing about code coverage is that you can automate it in your Cl pro-
cess. It’s impossible to test every combination; but the more you test, the fewer
issues will be uncovered by your customers. Code coverage will also be presented in
chapter 6.

Another risk is database updates. It’s never easy to add columns to a table or new
tables to a database. With continuous database integration, you'll know that database
changes work properly and without data loss. We'll discuss continuous database inte-
gration in more detail in chapter 11.

Developers often hate coding and architectural standards, but they have a useful
purpose: they ensure that the application follows best practices, which in turn makes
the application perform better and makes it easier to maintain. Code reviews catch
some of these issues; but because code reviews are a manual process, things are
missed. Why not automate standards compliance as part of your Cl process? We'll
cover code analysis in chapter 8.

Comments are rarely put in code, and documentation is generated even less often.
Many people say that if you're agile, you don’t have documentation, but this isn’t true.
Agile says that you value working software over documentation. But some documenta-
tion is still needed, especially if you're creating assemblies for use by other developers.
Here’s another opportunity for automation in your Cl process, and one that’ll be cov-
ered in chapter 9.

How do you know that your installation process works correctly? There are few
things that frustrate users more than when they can'’t install an application. Create
and test the entire installation process in your Cl system. We’'ll cover deployment and
delivery in chapter 10.
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Finally, Cl also increases visibility. It’s easier to see problems hiding in the project
that without ClI wouldn’t be found until much later in the development process, when
they would be harder and much more costly to fix.

Now that you know what continuous integration is and how it can improve your
development process, let’s see Cl in action.

A simple Hello World-type Cl example

It seems that just about every computer book starts with a Hello World application. To
help you understand the Cl process, we've developed a simple C# application and sim-
ulated a Cl server using a Windows script. Make sure you have .NET Framework 4.0
Extended installed. Throughout the book, we’ll use Visual Studio 2010. If you have it
installed, you’re good to go.

To install the demo, create a miniCl folder, and then copy the demo files into it. To
run the demo, open a command window, change the directory to the miniCl folder,
and type Build. The results are shown in figure 1.2.

The build script is an old command-line batch file. We used this tool to show you
how easy it is to create something that resembles the Cl process. We aren’t the only
ones to try something like this: there are PowerShell scripts made to do the Cl server’s
job (see http://ayende.com/Blog/archive/2009/10/06/texo-ndash-my-power-shell-
continuous-integration-server.aspx). The Cl script, shown next, verifies that the input
and output folders exist, compiles the Equals.cs file into an .exe, and then runs it to

- = _| ——
BN CWindowssystermEdiomd. moe —— :_ﬁ:

—— = 2

Figure 1.2 The miniCl application builds updated files, tests and deploys them, and
then keeps checking for changes in the source code files.
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verify that it works. The application takes two parameters and returns true if they're
equal or false if they aren’t.

Listing 1.1 Script for the miniCl demo system

@echo off

cls

echo Setting up environment

if not exist work md work Vel’iﬁes bulld
if not exist deploy md deploy environment
if not exist equals.cs echo Dummy >> work\equals.cs

:Start

echo Checking for changes in files

fc equals.cs work\equals.cs /b > nul

if not errorlevel 1 goto :End

echo Compiling

copy equals.cs work\equals.cs

C:\Windows\Microsoft NET\Framework\v3.5\Csc.exe work\equals.cs Builds
echo Testing source file
equals.exe test test

if errorlevel 0 goto :TestPassed

echo Test failed. Application not deployed

goto :End

:TestPassed

copy equals.exe deploy\equals.exe

echo Test passed. Application deployed.

:End

ping 1.1.1.1 -n 1 -w 5000 > nul

goto :Start

In the ClI script, you verify that the work area on the build server is set up correctly
B. The original source file is compared to the file in the work area. If it’s different,
it’s copied to the work area. To detect the differences, you can use the fc.exe tool
that comes with Windows, which compares two text files, prints the differences on
screen, and redirects the output of the command to the null device to hide it from
the user. The new work-area source file is then compiled into an .exe and tested C.
To test the application, the script uses a little fake: it outputs 0 if the strings are iden-
tical. This is because you have to check the error level in the batch file. If the pro-
gram returns something bigger than 0, you’ll assume it’s an error. If the test is
successful, the .exe is copied to the deploy folder. The feedback mechanism is also
updated with the result.

Now that you’ve seen a simple example of how Cl works, it’s time for us to intro-
duce you to the tools that do the real work in continuous integration.

Cl tools

A complete Cl process consists of several tools. You can buy expensive Cl systems
that are feature rich and often easy to set up and maintain; or you can use tools
that aren’t as feature rich and often require some work to set up but are either
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free or low cost. Either way, no one tool does everything you need in a complete
Cl system. In this book, we’'ll work with free or low-cost tools and show you how
they work and how to integrate them into a fully functional Cl process. In this sec-
tion, we’ll give a brief introduction to several tools, starting with those that you
must have.

1.3.1 Essential tools
Five tools are required to get started with Cl. At a minimum, you should have these
tools as part of your initial Cl setup.

SOURCE CODE CONTROL

The first essential tool is source control. Source control systems are most often used
to store each revision of the source code so that you can go back to any previous ver-
sion at any time. But you should also use the source control system to store cus-
tomer notes, development documentation, developer and customer help files, test
scripts, unit tests, install scripts, build scripts, and so on. In fact, every file used to
develop, test, and deploy an application should be saved into source control. There’s
a debate in the developer community about whether this should include binaries

that you can build; that decision is up to you and should be based on the needs of
your team.

You have many source control options, ranging from high-end enterprise tools
from IBM Telelogic that integrate with requirements and bug-reporting systems, to
Visual SourceSafe (VSS) from Microsoft, which has been around for years. You can
spend thousands of dollars on these tools or find ones like Subversion and Git that are
open source and free. Even if you don’t use Cl, you should have source control, no
matter the size of your team.

NOTE  Microsoft discontinued the aging and not well-respected VSS in early
2010 and replaced it with Team Foundation Server Basic. But many teams
continue to use VSS and have no plans to change in the near future.

This book looks at mostly free tools from the Subversion family and mostly paid tools
related to Microsoft Team Foundation Server (TFS). If you choose Subversion, make
sure you also install another tool such as AnkhSVN (http://ankhsvn.open.collab.net/),
VisualSVN (www.visualsvn.com/visualsvn/), or TortoiseSVN (http://tortoisesvn.tigris.
org/) that integrates into Windows Explorer or Visual Studio and makes it easy to work
with Subversion. TortoiseSVN (see figure 1.3) seems to be the most popular (according
to StackOverflowz and SuperUsers), so that’s what we’ll use for our examples. If you're
using TFS and have Visual Studio 2010 installed, you’re ready to go.

2 http://stackoverflow.com/questions/ 108/ best-subversion-clients-for-windows-vista-64bit
® http://superuser.com/questions/33513/which-subversion-client-should-i-use
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CONTINUOUS INTEGRATION SERVER

The second and most important tool you need is one
to drive your Cl process. This sits on the Cl server,
watches for changes in the source code repository, and
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There are many ways to provide feedback to the team, Figure 1.3 TortoiseSUN
integrates into Windows Explorer

and we'll discuss them in chapter 5. But the most com- to make it easy to manage your
mon method is through a website. Subversion repository.

BUILD MANAGER
Next, you need something to do the actual build. The two most common options are
MSBuild and NAnt. MSBuild is part of the .NET Framework, so it's free and most closely
matches what happens when you click Build from the Visual Studio menu. NAnt is
designed after the Java tool Ant. It’s an open source solution, but it has received few
updates in the past couple of years. Both applications are controlled by XML configu-
ration files, but you can find GUI tools such as MSBuild Sidekick (see figure 1.5) to
make the configuration files easier to maintain.

The build-manager application takes a Visual Studio solution or individual proj-
ect files and calls the correct compiler, generally C# or VB.NET. The compilers
come free as part of the .NET Framework. Some shops use MSBuild for the actual
compilation of the source and then use NAnt for the remaining steps, such as run-
ning unit tests.
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Figure 1.4 Part of the XML configuration file for CruiseControl.NET

UNIT TEST FRAMEWORK

The last essential tool you need is a unit testing tool. The two most common options
are MSTest and NUnit (see figure 1.6), but there are others such as MbUnit and
xUnit.net. These tools run the unit tests that you write for your application and then
generate the results into a text file. The text file can be picked up by your Cl server
software; a red/green condition for fail/succeed is reported to the team through the
feedback mechanism.

Although NUnit has a GUI tool, it can also be run as a console application as part of
your Cl process. Many of the tools we'll discuss in this book have both a GUI and a
command-line version. The command-line tools provide results as text or XML files
that can be processed by your Cl server software; the results are displayed using the
feedback mechanism.

Now that you know the required tools, let’s turn our attention to other tools that
will help you write better code: code-analysis tools.
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1.3.2 Code-analysis tools

Code analysis plays an important part in the development process. Code from multi-
ple team members should use the same naming conventions. And the code should fol-
low best practices so that it’s robust, performant, extensible, and maintainable.
Several code-analysis tools can assist in the process.

The first, FxCop (see figure 1.7), a free tool from Microsoft, analyzes code and
reports possible issues with localization, security, design, and performance. The tool is
targeted at developers creating components for other developers to use, but applica-
tion teams are finding FxCop a useful part of their Cl process.

Another free Microsoft tool is StyleCop (see figure 1.8). It comes with Visual Stu-
dio and is delivered with a set of MSBuild plug-ins for standalone usage. This tool
checks your code against best-practice coding standards. It compares your code to rec-
ommended coding styles in several areas including maintainability, readability, spac-
ing, naming, layout, documentation, and ordering.

Both of these tools generate analysis reports that can be used by your Cl server soft-
ware and integrated into the build report available via the feedback mechanism.

NCover (see figure 1.9) is a coverage tool that checks that all code paths are
being tested. So is NCover an analysis tool or a testing tool? The truth is, it’s a little
of both.

NCover uses either MSTest or NUnit to run the tests and can integrate with several
Cl server applications. But there are additional test tools, and they’re the subject of
the next section.
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Figure 1.7 FxCop reports problems in code that can be issues with design, performance, security,
or localization.
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Testing tools

Earlier in the chapter, we talked about unit testing tools as an essential part of the Cl
process. But other test tools can be run against your code to help ensure that the
application functions correctly.

One such tool is Selenium, an open source tool developed by ThoughtWorks. Sele-
nium has record and playback capabilities for authoring tests that check web applica-
tions. If you’re creating WinForms, Windows Presentation Foundation (WPF) or
Silverlight applications, you may be interested in White: it allows testing of your Ul
classes. Finally, there’s FitNesse. This testing tool allows you to specify the functionality
of the application; then tests are run against the code to ensure that it works as speci-
fied. Chapter 6 is devoted to showing how to integrate these tools with your Cl process.

There are also several other tools you can add to your Cl system.

Other tools

Have you ever put XML comments into your code? You can, and then extract them and
compile them into useful documentation. That’s the purpose of Sandcastle. These
comments are most often added by component and framework vendors for building
help files. But they can also be useful for other team members or even for yourself
when you have to make changes to a module a month from now.

You can also automate the building of your deployment. It doesn’t matter if you
use ClickOnce, Visual Studio Installer, WiX, Inno Setup, or something else. Having
your Cl process automatically build the application, create the install set, and then test
the install are big steps to ensuring a good, solid application.

The tools presented here are by no means an exhaustive list. You can find many
tools for things like code visualization, performance testing, static analysis, and more
through a web search. Some of the tools cost several thousand dollars, and others are
free. In this book, we take the low-cost approach and discuss tools that are free or
available at a minimal cost. Tools like this emerge continuously in the community. To
keep track of what’s new and hot, you can check community sites like StackOverflow
and ALT.NET (http://altdotnet.org/).

Now that you’'ve been introduced to many of the tools you'll be using in your Cl
process, it’s time to introduce you to the project we’ll use throughout the book.

A project for Cl: leasing/ credit calculator

To better understand the Cl process, you should have a simple but real-world example
of software that you can put under source control in the next chapter and eventually
integrate continuously. At this early point, you'll only create a Visual Studio solution
and the project files. You'll add the code in later chapters.

You want a sample application that isn’t trivial but is as easy as possible for demon-
stration purposes. How about a leasing/credit calculator? It may not be a tool that’ll
prevent the next worldwide financial crisis, but it's a piece of software that’ll provide a
straightforward answer to a simple question: how much will you pay monthly for your
dream car or house?
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A project for Cl: leasing/ credit calculator

Windaws Ul Wb Ul

Figure 1.10

You'll create a Cl process for an application
consisting of one shared library with two Uls:
Windows and web.

The architecture will be sophisticated, as you can see in figure 1.10.

The application will consist of one shared library with two clients. One client will
be made using WPF and the other with Web Forms. You'll create a full Cl process for
this tool throughout this book. But remember, the project is only a pretext to show
you how to set up a Cl process and not a goal in itself.

You’'ll use Visual Studio 2010 to develop the application. In this chapter, we’'ll pres-
ent two examples using ASP.NET and WPF, but the techniques described are suitable
for other kinds of .NET applications like Windows Forms, ASP.NET MVC, Silverlight,
and mobile apps. The details may differ, but the easiest way to set the Cl process cor-
rectly is to think about it from the beginning. It never hurts to first think about what
you want to accomplish and then do it afterward—not the other way around. The first
part of the example we’ll look at is the core of the application: a shared library used
with the finance mathematical part of the software.

Calculation core

The financial library project will contain all the necessary code to perform the finan-
cial calculation. You’ll start small with one class to perform a leasing/credit install-
ment calculation.

DIRECTORY STRUCTURE

Pick a directory to work with. By default, Visual Studio stores projects somewhere
deep in the user folder structure, which makes all the paths long and error prone. It’s
better to make the path shorter—anything on the first level in the directory structure
will do, such as C:\Project, C:\Development, or C:\Work. For this example, let’s use
C:\Dev.

Consider organizing your project directory a little better than the Visual Studio
defaults. If you create a project, you'll get a solution file named after the project.
Visual Studio will also create a directory under the solution file, again named after the
project, and place the project file inside. That may be all right for a quick shot, but
you should consider taking this structure under your control.

First, if you plan to have more than one project in a solution, consider naming the
solution differently than any of the projects. Second, remember the golden rule of Cl:
keep everything you need to integrate inside the repository. To meet this rule, you'll
need a directory to keep all your stuff in. You can name it lib or tools. And you can go
even further, as you can see in figure 1.11.
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Organizing your files in logical groups makes the solution directory tidy. For example,
source files go in a directory called src, and documentation-related stuff goes in the doc
directory. Of course, this isn’t divine knowledge, and you may have a good reason to do
it differently. You may want to put the documentation in another repository or to not
have a separate source directory. It’s up to you, but you should at least think about it.

ORGANIZING THE PROJECT STRUCTURE

Here are the steps to organize the project:

1

7

Launch Visual Studio, and create a new solution. Select File > New > Project from
the Visual Studio menu. The New Project dialog box opens (see figure 1.12).

In the Installed Templates list, select Other Project Types > Visual Studio Solu-
tions, and then choose Blank Solution.

Enter Framework for the solution name and C:\Dev\ for the location, and

click OK.

To add the financial-calculation library to the newly created solution, first
choose File > Add > New Project. Then choose Visual C# > Windows, select
Class Library, and name the library CalcCore. (In a real solution, you may have
other libraries parallel to the core—for example, a project containing database-
access classes or controls ready for reuse in various projects.) Your Solution
Explorer should look similar to figure 1.13.

You need to change some Visual Studio defaults to give better results when you
build the project and put it under the Cl process. From the Solution Explorer,
right-click the CalcCore project, and select Properties.

Switch to the Build tab. Under Errors and Warnings, check if the warning level
is set to 4 (see figure 1.14).

Under Treat Warnings as Errors, select All.
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Figure 1.12 You should start with a blank solution. Doing so will give you the ability to name it
differently than the project inside and to place the projects where you want them. Don’t take a shortcut
by creating a project first and letting Visual Studio create the solution file for you. You'll end up with
the Solution Explorer window shown.

These settings will cause the compiler to throw an error every time your code
contains the slightest warning (including the least severe and even informa-
tional warnings). It’s because the number

of warnings have the tendency to grow Solution Bxplores *0x
and in end effect can be completely = 2]
ignored. If you’re conscious that there’s - Selution ‘Framewerk' (1 project)
no way around the warning you can always s+ | GalcCore
suppress it by typing its number into the % Properties
=al References

“Suppress warnings” text box. You do this
to eliminate unnecessary noise. If you're
like many developers, you have a tendency
to stop reacting to too-frequent stimula-
tion. Soon enough, you'll have dozens of Figure 1.13 The initial project
warnings and miss an important one that structure in the VlsuaIlStud|o Solution

, Explorer. Remember, it's not necessary
may lead to a problem. And you don’t

to correspond to the folder structure on
need any problems, do you? the hard drive.

) Classl.cs

NOTE  Pay close attention to the platform shown in figure 1.15. In Visual
Studio 2010, it defaults to x86 by executable .NET applications and to Any
CPU for class libraries. This is different than in Visual Studio 2008, which
defaults to Any CPU. If your assembly doesn’t use native Windows func-
tionality, it’s safer to set it to Any CPU. It'll run properly on either a 32- or
64-bit processor.
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Figure 1.14 Build properties set the right way. All warnings are treated as errors and
given the maximum warning level. This setup is used for every configuration defined.

8 Signing the assembly with a strong key gives your assembly a globally unique
name. It makes identification and administration easier. It makes it possible to
create a reference to an explicit version of software, and it prevents others from
spoofing your libraries. Without a strong name, you won’t be able to add a
library to the Global Assembly Cache (GAC), which may be a good idea for the
financial-calculation library. But keep in mind that signing the library will make
the versioning more complex. You can’t call a nonsigned library from a signed
one. The general rule of thumb is to sign the libraries and leave the executables
alone; you’ll have to decide for yourself what to do.

To sign the assembly, switch to the Signing tab (see figure 1.15), and select
the Sign the Assembly check box.

s From the Choose a Strong Name Key File drop-down list, select New. The Cre-
ate Strong Name Key dialog box opens.

10 Enter CalcCore for the Key File Name, and deselect Protect My Key File with a
Password. Press Enter in the resulting dialog box (shown in figure 1.15).

11 Delete the default Class1.cs file. You need to add a new program file that’ll
eventually contain the code.

12 Delete all unused references. Everything that’s mentioned in the references is
loaded into memory at runtime. If it isn’t needed in your program, it will have
nothing to do in memory.

vww.allitebooks.cond
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Figure 1.15 It’s worth signing your reusable assemblies. Doing so makes it possible to reference them

using strong assembly names.

13 Right-click the CalcCore project, and select Add > New Folder from the context

menu. Name the folder Math.

14 Create a class called Finance inside the
folder. Did you notice that the namespace
in the new program file contains the path
to the file? It’s generally a good idea to
have the path and namespace match.
Using folders, you won't clutter your solu-
tion with files, and it’ll be easier to man-
age a lot of files in the Solution Explorer
window. Your Solution Explorer should
look like figure 1.16.

The Finance class will contain simple financial
mathematical operations. The implementation
details are irrelevant now; we'll pay closer atten-
tion to the financial library in chapter 6, where
you’ll write unit tests for the library.

Solution Explorer ~Ax

3 Solution ‘Framework” (1 project)
a 2 CalcCore
4 | Properties
#] Assemblylnfe.cs
# | References
<3 System
4 |5 Math
] Finance.cs
5 CalcCore.snk

Figure 1.16 Model solution with no
unnecessary references. The project is
signed and uses folders (that match the
namespaces).
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Now, let’s create two additional projects that you’'ll put together with the core
library in the source control repository.

1.4.2 Calculators

You'll need a user interface for the library. Using the same technique as for the frame-
work solution and core project, you'll create two user interfaces: one for Windows and
one for the web.

Follow these steps:

1 Create a new blank solution and name it WindowsCalculator. From the Visual
Studio menu, select File > Add > Project...

2 Select Visual C# > Windows > WPF Application from the list of project templates
(see figure 1.17).

3 Name the project WinCalc.

¢ Set the location to C:\Dev\.

5 Set the warning level as you did for the CalcCore project in the previous sec-
tion. Don’t sign the executable project.

You now need to create a web application for the web-base Ul for the calculator project:

1 Create a new blank solution and name it WebCalculator. From the Visual Stu-
dio menu, select File > Add > Project.
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Figure 1.17 Create a Windows Forms application for the finance calculator project.
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Figure 1.18 Creating the web calculator solution in Visual Studio 2010 is straightforward and should
be familiar to users of earlier versions.

2 Select Visual C# > Web > ASP.NET Web Application from the list of project tem-
plates (see figure 1.18).

3 Name the project WebCalc.

4 Set the location to C:\Dev\.

5 Set the warning level as you did for the CalcCore project in the previous sec-
tion. Don’t sign the executable project.

The solutions and projects for the loan calculator are now finished. Your folder struc-

ture should look like figure 1.19.
You’ve built the initial construction site. It
contains three solutions, each with one proj-

ect. In the next chapter, you’ll place the appli- ¢ Dev
cation under source control. Framework
¢ CalcCore
summary 1 WebCalculator
. WebCale

You should now understand what continuous
WindowsCalculator

WinCalc

integration can do for you and your team. It
may seem confusing to set up and maintain Cl

with all the essential tools; but as you'll learn i

X o . Figure 1.19 If you've followed the steps
throughout this book, it's simple if you take in this chapter, you should end up with a
things a step at a time. directory structure similar to this.
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In this chapter, we presented information to help you overcome objections from
team members and reduce project risk. We also gave you a simple example that shows
how CI looks for file changes and then builds and tests the code; and we introduced a
more complex sample application that you’ll use throughout the book.

In addition, you were introduced to some of the tools you’'ll see in depth later in
the book. Specifically, we’'ll focus on CruiseControl.NET, TeamCity, and TFS as Cl serv-
ers, and show you how to integrate other tools with them. One of those, source con-
trol, is the first tool you need to set up and is the topic of the next chapter.



Setting up a sour,
control sytem

This chapter covers
= Choosing the right source control system
= Using Subversion on the server and client sides

= Setting up a TFS 2010-based source control
system

Continuous integration (Cl) isn’t possible without a source control system. As a
matter of fact, it’s difficult to set up any reasonable software manufacturing process
without one, regardless of whether you’re using Cl. As soon as you progress beyond
being a lonely developer spitting out code in a dark corner of a dorm room, you’ll
have to think about setting up a proper place for your code to reside. You need a
place you can send the fruits of your work and from where you can receive the work
of your colleagues.

In the dawn of time, there was a harsh division of functionality, and every devel-
oper had their own EXE or DLL to work on. Everyone worked on a separate part of
the code and submitted their work to someone whose sole task was to integrate the
code from various developers into one codebase. Those times are long gone. We
now have automated systems that do the trick. They reside somewhere in the net
(intra or inter doesn’t matter). Every developer works closely with the system. They

29
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CiarTER2  Setting up a source control system
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Figure 2.1 Most common source control systems involve a centralized server and a bunch of
clients reading from and writing to the source control repository.

push their work onto it and regularly pull the work of others out to a local construc-
tion site.

Source control systems, also called version or revision control systems, are programs that
let you manage changes in files. More important, source control systems hold the
files containing the source code for your software. But generally, it doesn’t matter
what kind of files are managed: documents or binary files are also welcome. As shown
in figure 2.1, source control clients are able to read from and write to a revision con-
trol repository.

In this chapter, you’ll learn why a source control system is essential not only for the
Cl process, but also in the day-to-day life of the developer. You'll choose a suitable tool
for your needs, taking into consideration a number of attributes. Subversion (SVN)
and Team Foundation Server (TFS) source control will prove to be the source control
systems to choose from. We’'ll look at the VisualSVN Server as a suitable Subversion
package for the Windows platform. You'll learn how to use TortoiseSVN, a great SVN
Windows client. And last but not least, you'll prepare and dispatch to source control
the sample project introduced in chapter 1. After that, you’ll learn how to do the
same with TFS source control. But first, why do you need a source control system in
your Cl environment?

Choosing the right source control system for you

Let’s imagine a Cl process without a source control system. It could be a one-person
shop where everything happens on a single machine. That’s fine, but as soon as you
start to work on a team, you’ll run into problems.

There must be one single place where developers commit their work and the CI
process pulls it to integrate. It may be a single folder on network share where develop-
ers manually copy their new features; the Cl process periodically checks the folder for
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changes and integrates the code when something new is detected. That approach will
probably work too. But why do it the hard way? Why not make a full-blown system to
do the job?

Many great source control systems are available. Many of them are free—and
free in this field doesn’t mean an inferior product. They’re feature rich and well-
established. Installation is easy, and the list of benefits is huge. Let’s examine them
quickly before you decide what source control system to use.

Benefits of source control systems

With a source control system, you have a full development history of everything
you’ve committed—always. Have you ever wished you had the version from last Fri-
day where everything worked correctly, and not the mess you created on Monday
when you were tired after a long and eventful weekend? Of course, you didn’t think
about making a secure copy on Friday. And now you have to look for a nasty bug,
and you don’t have working code to compare. With a source control system, that’s
not a problem. You always have a full history of everything you’'ve done. You can
pull the version from Friday (assuming, of course, that you didn’t forget to com-
mit!). You can pull and check every version from the time you set up your source
control system.

If you can pull every historical version that exists in your repository, nothing pre-
vents you from reverting the changes you made to the current version. For example,
the bad code you wrote after an eventful weekend can be replaced with a working
copy in a minute.

Most source control systems let you lock a file one way or another. Think about a
situation in which you want to have a file just for you. You don’t want anyone changing
something while you work on this particular-new-very-important feature. With some
source control systems, you can explicitly lock the file you're working on: no one can
edit the file, but everyone can still pull it and compile with it. Some systems only let
you mark the file as locked: others aren’t prevented from editing other files, but no
one can check out a file someone else locked. Either way, you can have the file avail-
able to only you.

Source control systems let you label revisions if you want. Assume you're releasing
a new version. The revision number is 4711. Do you have to remember it, in case you
have to fix a bug in this particular version when it’s in production with a customer?
No: you can label this revision by giving it a meaningful name and marking it so it will
be easy to find and work with. If needed, you can take the labeled version, fork it, and
set a separate Cl process for it.

Let’s say you've found a bug in a labeled production version. You've fixed the bug
in this version, but it also resides in the main version. That means you’ll have to imple-
ment the fix there, too. But you don’t have to do this manually. In most cases, you can
merge the changes you’'ve made in the labeled version with the main version using
only source control system features.
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Or, suppose you’re working on a new feature. You aren’t sure the technique you've
chosen is the right one. No problem: you set a labeled version and don’t mess with the
main version. But in the end, you realize that your technique was correct (of course!).
What do you do? You merge.

One more thing is especially important if you’re considering setting up a Cl pro-
cess. The golden rule of Cl says to keep all the files you need to fully integrate your
software in the project directory. You should keep not only your source but also all the
tests and third-party tools and libraries you use—literally everything you need for full
integration, including executables for documentation generation, installation, and
deployment. Now, think about this project directory residing in your source control
system. You can point new developers to one place and have everything ready for
them to pull and start to work. They don’t need to install anything extra to start com-
piling, testing, and working. The same setup applies to the Cl process. You can point it
to the same place every developer uses, and it can do the work it’s designed for, wher-
ever it’s installed. Not bad, eh?

Now that you know the most important source control system benefits, let’s look
for the right one for you.

2.1.2 Source control aspects to consider

The benefits we’ve discussed are mostly universal among modern version control sys-
tems. If you find one that doesn’t perform all the functions described earlier, you
should forget it. The important aspects to consider are the following:

+ Centralized vs. distributed

+  Transactional vs. nontransactional

+ File blocking vs. non—file blocking

+ Free vs. paid

Table 2.1 lists several popular source control systems; you can use it as a reference for
your decision making.

Table 2.1 Important source control aspects of several different tools
Sub i TFS Version Visual Git Vault
ubversion Control SourceSafe I au
Free vs. paid Free $ $ Free $
Centralized vs. Centralized Centralized Centralized Distributed Centralized
distributed
Transactional vs. Transactional Transactional Nontransactional Transactional Transactional
nontransactional
File blocking vs. Non-file Both File blocking Non-file Both
non—file blocking blocking blocking
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FREE Vs. PAID

The first thing you should consider is the cost-benefit factor. Commercial version
control systems like that included in Microsoft TFS tend to do a lot more than you’d
expect. For a lot of money, you get a lot of functionality. (Beginning with Visual Stu-
dio 2010, anyone with an MSDN Professional subscription or above gets a license for
TFS. This significantly drives down the cost of implementing TFS.) The revision con-
trol system is a small part of the TFS infrastructure; we’'ll look at TFS features in the
next chapter.

Other commercial tools are available, such as Vault. It was designed to replace the
old Microsoft Visual SourceSafe (VSS).1 If you're familiar with VSS, and you're afraid
of the learning curve with something else, consider using Vault (it has the coolness
factor of being written in .NET, too0).

NOTE  Microsoft discontinued Visual SourceSafe with the release of Visual
Studio 2010. It was replaced with Team Foundation Server Basic.

On the other hand, you have free systems like SVN and Git. Most of them are even
open source. They control your source—period. For everything else, you have to use
other tools.

CENTRALIZED VS. DISTRIBUTED

Another important aspect is the choice between centralized and distributed source
control systems. You can see the concept behind distributed version control systems in
figure 2.2.

Maybe because Linus Torvalds, the creator of Linux, started to work on Git, distrib-
uted source control systems are gaining popularity. The idea is to have a full reposi-
tory containing all the revision history locally on the developer’s machine. There is no
single central server to administer the source—instead, there are many “central repos-
itories.” You initially commit locally; what to merge globally is up to a superuser. Dis-
tributed source control is a fairly new concept, but it's used to develop the Linux
kernel and many other open source applications.

On the opposite end of the spectrum are centralized systems, with one server
somewhere that manages the source. This group includes Subversion, TFS, VSS,
and Vault.

Both distributed and centralized systems have their advantages and disadvantages.
From the Cl point of view, the centralized approach can be considered better. With a
single repository and full control over history, centralized systems are easier to incor-
porate for a wider audience, and they demand less knowledge about source control
system infrastructure.

' To use Visual SourceSafe with Visual Studio 2010 you will need to install additional package from here: http://
code.msdn.microsoft.com/KB976375.
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Figure 2.2 A distributed source control system with an optional main node. Every client has its own
repository and can commit directly to other clients.

TRANSACTIONAL VS. NONTRANSACTIONAL

Although it almost isn’t an issue with modern source control systems, this aspect is
something you should keep in mind. It wasn’t so long ago that repository operations
within the source control system weren’t atomic. If the operation to pass new files to
the repository failed due to a network error or some other problem, some of the files
were checked in to the repository and some weren’t. This situation could easily render
the repository unstable, in an unknown state and prone to further errors. For exam-
ple, the VSS was nontransactional. Almost all of the modern source control systems are
transactional. You should definitely go this way, too.

FILE BLOCKING VS. NON—FILE BLOCKING

Another aspect you may consider while choosing a source control system is the ability
to explicitly check out files from the repository, preventing others from modifying
them. Essentially, a file-blocking system is able to prevent you from editing a file some-
one else has blocked. A non—file blocking system lets you edit everything every time,
which may eventually lead to a conflict.

Think about a situation where two developers have made changes to the same file.
The first developer checks his changes into the repository, and the second developer
is blocked from check-in because her version of the file conflicts with the one already
in the source control system. This aspect often isn’t addressed directly, but it may be
essential if your build depends on files that can’t be automatically merged. Two devel-
opers working on such a file could be a disaster. It’s a question of work culture, too: a

vww.allitebooks.cond
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sick developer with an explicitly checked-out file is a real problem. You often end up
with a lot of partial classes in separate files that have been created by various develop-
ers to bypass another user’s blocks.

TFS can work in both modes. Subversion can only lock files, preventing parties
from checking in rather than stopping them from editing. VSS works only in explicit
checkout mode. From our experience working with text-only .NET source files, you
don’t need an explicit checkout mode; work goes smoothly if you don’t block any-
thing. Conflicts are an exception rather a day-to-day problem.

MAKING A CHOICE
We don’t know if you're lucky if you’re in a situation where you can choose among
the various source control systems. If you're a startup, you can take your choice. If
you’re offered a job at a company that develops without one, consider running
away unless they give you permission to set one up before you write the first line of
code. If you have a system that works fine, and everybody is happy with it, you
should stick to it. Just make sure the source control system you choose will work
with your Cl server.

If you're in the luxury position where you can choose, and you want to do it
cheaply but professionally, pick Subversion. We're totally convinced that you won’t be
disappointed. Working with SVN is where we’re heading in the next section.

Setting up a Subversion source control server

Subversion is a good, established, free, and open source version control system. It’s
widely adopted in open source projects and in corporations. It has a neat feature to
make all the operations on the repository atomic. That means all you do is check-in,
checkout, merge, whatever, all enclosed in a transaction. Either all the files go
through or none at all. And there is no way someone else checks in the same time
you do.

TIP A great source of information about SVN is a free book called Version
Control with Subversion by Ben Collins-Sussman, Brian W. Fitzpatrick, and C.
Michael Pilato, available online at http://svnbook.red-bean.com/.

In this book, you’ll use SVN as the tool of choice for setting up a source control pro-
cess. Installation is straightforward. Let’s set it up.

Installing VisualSVN Server

VisualSVN Server is a great choice if you want to quickly set up the SVN server on a
Windows machine. It contains all you need to set up a Subversion server. It has a user
interface to create repositories and users. It cuts out all the friction you’d have with
setting up an Apache server on a Windows machine, configuring SSL to work on it,
creating users, and setting repositories manually. It comes in a free version that has
some limitations.
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One of the limitations of a free VisualSVN Server version is the lack of remote con-
trol. You’ll have to install both the Server and the Management Console together on
one machine. If you want to manage your server remotely, you must buy the Enter-
prise version.

You can get the latest version from www.visualsvn.com/server/. If you have a dedi-
cated machine to host your source control server, you obviously should install Visu-
alSVN Server on this machine. This book’s example uses a standalone Windows 2008
server to host the Subversion server.

Figure 2.3 shows the most important step in the installation process. You need to
decide where to install the server software and where to place the repositories. Please
consider a good location for the repositories. They should reside on a reasonably fast
hard disk. You should activate SSL to encrypt communication; it will be difficult to
read the content of the files you host on the source control server if you aren’t autho-
rized to do this. If you don’t plan to make your repositories available from the inter-
net, you don’t have to activate a secure connection. Although it isn’t considered a
good idea, your server will react faster if you don’t use SSL, because SSL connection
negotiation is a fairly expensive process. The port use must be free in order for Visu-
alSVN Server to use it. You can select Subversion authentication or choose to integrate
user management with Windows authentication for additional security. If you’re run-
ning Active Directory in your organization, you should obviously go with it and use
Windows authentication (keep in mind that the version of VisualSVN that integrates
with Active Directory isn’t free). You’ll avoid managing your users separately and in

',ﬁ Visa
Custom Setup
Select the way you want fealures to be instaled,

alSvl Server 0.7 Setup

Change if necessary installation path and initial VisualSVN Server settings.

Locatian: |c; \Program Files {Vis  SEVN Server),

|

Riepositories: |C: ‘Flepositaries),

Server Portz | #43 *| © Usasecure connecton (https: /)
A thentication
% Lise Subversian authenticalian
VisualSVN Server will maintain own users and groups.

" Use Windows authentcation
VisualSvN Server will use Windows users and groups.

Figure 2.3 Where to store your repositories, whether to encrypt
communication, and what user management to use are some of the important
decisions you need to make when you install VisualSVN Server.
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effect doubling your administrative effort. If you don’t have Active Directory, it’ll be
easier to go with the built-in Subversion authentication (accounts are kept in text files
with passwords hashed).

When all the necessary processes are installed, your source control server is ready
to be used. You can administer VisualSVN Server using the VisualSVN Server Manage-
ment Console (or VisualSVN Server Manager, as it’s called in the Start menu). You'll
find it in Windows by choosing Start > All Programs > VisualSVN.

Creating users and groups

VisualSVN Server comes with a handy Management Console. Using this tool, you can
easily organize your source control system, manage your repositories and users, orga-
nize them into groups, and issue rights to the repositories.

If you associated your Windows authentication with SVN authentication in the
Setup dialog box in figure 2.3, you can use your Windows user credentials to log in. If
not, and you decided to let the VisualSVN Server manage your users, you'll have to
create accounts for every member of your team, as shown in figure 2.4.

You can put users together in groups, as shown in figure 2.5.

After you create the users and groups, you can start creating repositories.

Creating the repository
You’'ll store your source code on the server in a structure called the repository. Keeping
a healthy source code repository is important, even if you don’t use Cl. But in this sce-
nario, it's somewhere near vital. You want to have the repository organized the right
way. You don’t want it to be cluttered with unnecessary files. You need a clean division
for your customer between work in progress and work being used. You also want to
easily manage the content of the repository and probably cross-reference repositories
between each other.

Creating a repository in VisualSVN Server is as straightforward as creating a user.
As you can see in figure 2.6, you have to assign a repository name, and you can decide
to create the default structure right away. You'll learn why this is a good idea later in
the chapter.

Ueer Fisse: |~1an:r|
Plii":ﬂi: ["!!"!!Fl!!"‘
Figure 2.4
Confrm oasswond: [--n-------u Creating users managed by VisualSVN
Server is straightforward: just assign a
i) User name and password are case sensitive, username and password. But you should

consider associating SVN with Windows

E 0K I Caresd authentication so you won't double the

administration effort.
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Figure 2.5 Creating groups using the native user management in VisualSVN. This step isn’t
necessary if you use Windows authentication. The way you set the rights to the repository stay
the same: use the repository context menu.

To connect to the repository, you must provide an address to your files, in the form of
a URL (see figure 2.7). The VisualSVN Server Management Console is kind enough to

show you that address. If the address looks familiar, you’re right: VisualSVN Server is
nothing more than Subversion bound to a web server (Apache, in this case).

Rapastery Mame:
I Repositary_Mame
Fapostory URL: hitps:HAL jmm Repostory_Name

¥ Create default structure (runk, branches, tags)

Wiou can reate desred repﬂw'rmuuw ussing Create Folder
and Create Project Structure commands. Leam about recemmended Figure 2.6
repgsiney bvout. When creating a repository, in

oK I Cancel addition to naming it, you should

create a default structure.
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Protocol Virtual directory Directory

L
"'// \ Figure 2.7

Server name/IP Repository Subversion URL construction

The URL contains the protocol or file-access method name. You'll connect to the
server using HTTP if you’re using non-encrypted communication or HTTPS if you
turned on SSL. It’s also possible to use SVN with local folders or to use other protocols.
We won'’t cover these in this book.

You connect VisualSVN Server using the server name or |P address and a port num-
ber. If you have firewalls on the way from the client to the server, remember to open
this port. VisualSVN Server creates a kind of virtual directory named svn. The rest is
the path to the files. The path always starts with a repository name and can be supple-
mented with directories in the repository.

Keeping a healthy repository

It’s sometimes considered good practice to have one repository throughout a
whole company or department; this means you store all your projects in one repos-
itory, using directories to logically divide it. Others prefer to have one repository
per project.

The first approach makes a lot of things easier, such as source control server admin-
istration. After assigning users to the single repository and giving them enough rights,
you can virtually forget about administration. Adding a new project is a matter of add-
ing a new directory to the existing repository—no other administration is needed.
Daily work with the repository is also easier. Copying, merging, and peeking for the dif-
ferences (diff) is easier when you do it on a path basis rather than cross-repository. And
you don’t lose any historical data while moving, copying, and merging files.

You can set up something similar to the structure shown in figure 2.8. This is a sin-
gle repository, called Projects, with a directory structure underneath.

A single repository isn’t a good idea if you have a lot of users with different per-
missions to the code base. For example, it’s difficult to assign one user only the
read permission to one project and read/write to another. You should consider
using multiple repositories if you plan to store different file types or when the revi-
sion number plays a special role in your development process. Another possible lay-
out is shown in figure 2.9: Framework, WebCalculator, and WinCalculator are all
separate repositories.

Look closely at the URLs shown in figures 2.8 and 2.9. Do you see the difference?
The first figure shows http://HYMIE:81/svn/Projects/ Framework, where Projects is a
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Figure 2.8 One repository throughout a company or department makes it easier to
maintain the structure. You don’t have to set up every repository separately.

repository and Framework is a directory within this repository. The second, http://
HYMIE:81/svn/Framework, has Framework as the repository. From the client point of

view, it doesn’t matter. With SVN, you can pull a given directory. You don’t have to
work at the repository level.
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Figure 2.9 One repository for (roughly) every solution makes it possible to vary the user
rights to the repositories. Generally, this approach is used to store various types of files—
separating documentation and source code.
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BRANCHES, TAGS, AND TRUNK
One other thing you have to consider when setting up your repository is the division
of the branches, tags, and trunk. Creating these directories in your repository isn’t
mandatory, but it helps to maintain the project. The frunkis the main development
line. Think of it like a tree trunk. It’s the place where you spend the most time and
where new features are implemented. The trunk drives new development. It’s the
obvious place to hook up to the Cl process.
A branch is a separate line of development. It shares the same history but lives inde-
pendently from the trunk and other lines of development. It’s used mostly for release
stabilization (long-lived branch), a place where you can work on a feature without
considering influence from others (medium-lived branch), or as a try-out field for
experimental development (short-lived branch). Generally, it's a good idea to have a
branch for every software version used by a customer. This makes it easier to find and
fix bugs in a particular version.
Some branches can be considered good material for the Cl process. For example,
release-stabilization branches should be continuously integrated, experimental ones
shouldn’t, and feature branches may be.
A tag is a snapshot of your repository taken at a given time and given a mean-
ingful name. It’s used every time something important happens, such as when you
make a release or implement an important feature. We consider tags irrelevant for
the Cl process.
CREATING THE DIRECTORY STRUCTURE
You should go with the repository layout that works best for you. In this case, you'll use
a repository per project, with the default directory structure shown in figure 2.9. Fol-
low these steps:
1 From your source control server, launch the VisualSVN Server Management
Console.

2 Right-click the Repositories node in the tree view in the left panel, and select
Create New Repository. The Create New Repository dialog box opens (see fig-
ure 2.10).

Create Meiw Repoditory:

Repodibory huame:
Framesuark

Repository URL: hbkpsHYTIE :&1f svnyFramework

W Creste default struckure (trunk, branches, tags)

Yfous can creake desied reposiory structure later using Creats Folder
and Create Project Structure commends. Learn sbout recommended

layauk

Figure 2.10

TEQLR R

When creating a new SVN repository,

oK [ Cancel you can optionally create a structure
for the trunk, branches, and tags.
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3 In the Repository Name text box, enter Framework.

¢ Select the Create Default Structure (Trunk, Branches, Tags) check box, and
then click OK to create the repository.

5 Use the same steps to create two more repositories: one named WebCalculator
and the other named WinCalculator.

Notice how the repository names match the Visual Studio solutions you created in
chapter 1. It’s a good idea to keep these names the same to make source code man-
agement easier. With a repository structure in place, you can feed it some data. To do
this, you need an SVN client.

TortoiseSVN and working with the repository

Thus far, we've shown you the SVN server. To work with it, you can use command-line
utilities supplied with SVN, but it’s much easier to work with the repository with an
SVN client. A client allows you to send files to and receive them from the repository, by
supporting one or many of the Subversion protocols (http://, https://, svn://,
svn+ssh://, file:///, and svn+ XXX://). Many clients are available with various inter-
faces, from a command-line interface to standalone programs to tools that integrate
with Windows Explorer or Visual Studio.

The command-line tools are great for automation. You'll use them a lot in your Cl
process. They let you script things so the process can perform unmanaged, but they
aren’t so good for day-to-day work. And there is a learning curve for all the com-
mands, switches, and parameters.

If you feel geeky enough to use the command-line interface feel free to do so. If
not, think about using something with an easier user interface. You can use a stand-
alone SVN client such as SmartSVN. You may also choose a plug-in for Visual Studio.
The creators of VisualSVN Server have one called VisualSVN, but it isn’'t free. There’s
also a free plug-in for Visual Studio called AnkhSVN. But in this case we’ll go with Tor-
toiseSVN, which is one of the most popular SVN clients for Windows. It integrates with
Windows Explorer and is easy to use.

Subversion client: TortoiseSVN
You can download the last version of TortoiseSVN from http://tortoisesvn.tigris.org/.
The installation is straightforward. TortoiseSVN integrates itself with Windows
Explorer (see figure 2.11), so you'll have to restart your system to see the changes. You
can then access TortoiseSVN from the Windows Explorer context menu: select a
folder and right-click to see the context menu.

With TortoiseSVN properly integrated with Windows Explorer, you can start using
your repository. Let’s import the solution and project files you created in chapter 1
into the SVN source repository.
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Figure 2.11 TortoiseSVN integrates itself with Windows Explorer by
adding a context menu you can use to manage your source.

Creating a working copy

If you followed along in section 2.2.4, you should have a repository layout similar to
the one shown in figure 2.9. The repositories are empty except the initial trunk,
branches, and tags structure. Before you can start normal work with the repository,
you have to populate it with some real data.

There are lots of ways to do that. You can import data into the repository and pull
it out again and do additional maintenance, but probably the easiest way is to check
the empty trunk into the folder with your project. Doing so creates a working or local
copy of your repository.

In addition to your files, the working copy contains SVN artifacts (in the svn direc-
tory). This svn directory is vital for the SVN client to work. You should never mess with
it or try to manage it manually—let the client do this work for you.

Follow these steps to create a working copy in the Framework directory:

1 Using Windows Explorer, navigate to the Framework directory, right-click, and

choose SVN Checkout. The Checkout dialog box opens (see figure 2.12).

2 You can read the repository URL in the VisualSVN Server Management Console
(shown earlier in figure 2.9). After you enter the server URL, and click OK, Tor-
toiseSVN informs you that the folder you’re trying to check out to isn’'t empty
(see figure 2.13).
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Figure 2.12 Checking out from the repository. Provide a URL to your
repository, and check out everything from the HEAD (newest) revision.

3 It’s all right, because you created your Visual Studio project in this folder and
you do want the local copy to exist in this folder. Click Yes.

¢« If you set up the SVN server to use SSL, you have to accept the SSL certificate

issued by VisualSVN Server (if you’re using SSL).
5 |If prompted, enter your repository credentials.

TortoiseSVN pulls the empty repository to the folder with your project, as

shown in figure 2.14.

s Follow the same steps to create a local repository for WebCalculator and

WinCalculator.

Notice the new icons associated with the development folders on your local drive. The

integration of TortoiseSVN with Windows Explorer tells you either that the files are
checked in (a green checkmark) or that the state of the file is unknown (a blue ques-
tion mark). As you work with the files and folders, you'll see other icons, most of

which are self-explanatory.

TortoisaSVN

- The target folder
g C\Dev\Framework
* 1% nok :mp!:,-!

Are you sure you want te checkout/export into that folder?

i"l'ﬁ}"u

vww.allitebooks.cond

Figure 2.13

TortoiseSVN displays a warning if you
initially check out into a populated
directory.
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Figure 2.14 The initial checkout into the project folder. TortoiseSVN creates a working copy.

You now have a local copy of the repositories, but none of the source code has been
stored on the server. Committing the changes to the repository is the next step.

Committing changes
You now have to send files to the repository and fill it with your project:

1 Right-click the Framework folder in Windows Explorer, and select SVN Commit
from the context menu. TortoiseSVN searches in the folder for everything dif-
ferent than the checked-out version and presents you with a Commit dialog box
(see figure 2.15).

2 Enter some text in the Message box. You should make it a habit to provide a
message for everything. The message should clearly explain what changes were
made in this revision. This way, you’ll always have historical information that
you may need in the future. Because the messages are searchable in Tortoise-
SVN, it’s easy to find a particular revision where you fixed a specific issue or bug
if you use, for example, the reference number assigned to the bug. Some tools
can resolve the issue based on the commit message.

3 Working with your project re-creates Visual Studio artifacts that aren’t welcome
in the repository: temporary data, compiled output, and user-specific files. Cur-
rently you have the normal results of the Visual Studio build: the bin and obj
folders (containing compilation artifacts) and all the *.suo files (personalized
additions to solution file) and *.user files (additions to project files). You
shouldn’t include these files in the repository. Select everything, and then dese-
lect the files and directories you don’t want to have in the repository.
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Figure 2.15 Initial commit. TortoiseSVN finds everything that's different from the checkout.

¢ Click OK to begin checking in the project files. The progress dialog box is dis-
played (see figure 2.16). If all goes well, the Framework source files will be
stored in the repository.

5 Repeat the commit process for the Windows and web calculator projects.

Path Mime type E
C:\hev'\Framewark\Core \Properties

C: Dy Frameswork YCor e \Proper es | AssemblyInfo,cs
C:\0ev Framework\Framework, sn
C:\DevFramewark \Core\Core.cspraj

C:\De \Framework\Core\Proper ies | Assemblyinfo.cs
C:\Dev Framework\CoreMath Fnance. s

C:\De Framework Framework. sin

C:\Dev Framewark\Core\Cone enk

At revision: 2 -

12 kEytes rarsferred in 0 minute(s) and 15 second(z)
Added:B

i

T
Hiii

Figure 2.16 TortoiseSVN displays a progress dialog box as it sends files into the repository.
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As you work with the project further, you'll end up with more and more artifacts that
shouldn’t be included in the repository. Your build process is likely to produce many
artifacts that you don’t want to host in the repository, including reports, deployment
files, and so on. All these files can be ignored. You can ignore entire directories, sepa-
rate files, and files with wildcards. You can clear the check boxes to do this, but it’s
inconvenient to browse the file list every time you want to commit something. To help,
you can permanently ignore some files (see figure 2.17). TortoiseSVN will never try to
commit the ignored files.

NOTE  Using TortoiseSVN, you can right-click an artifact and tell Subversion
to ignore it. After you mark a file or directory to be ignored, you have to com-
mit it to the repository. If you want to include something you’ve ignored ear-
lier, choose Add from the TortoiseSVN context menu.

As usual, that’s only one way of preparing your construction site. You could create the
project in Visual Studio after making the initial checkout or import everything into

the repository and then make it clean. The thing is, you want to make the repository
clean at the beginning and quickly get to your day-to-day tasks: working with files,
updating, and committing.

[ kin File folde
= Math 1027200 File falder
7] gl 10y 200 File falde
Ly e 10,22 File fe
& c Open in new window 10/2/2000 805 AM 1 €2 Proiact B
% C Shiare with v al Studio B
@ VN Checkout...
W ToroiseSiN k| i, Repo-browser
Festore previous versions Zi Bport..
| 1 k -
R I [T Create repository here
Sendto & Add..
Cut Al Import..
Copy a Add ta ignur: bzt k ub:l E
Create shomout ﬂ; Fetings
Delets ? Help
Rename ﬁ?’ At
Properties

Figure 2.17 Making your repository tidy requires you to ignore files that you don’t want in
your repository.
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2.3.4 Updating and committing files
Day-to-day work with the source control system consists mostly of updating and com-
mitting to and from the repository. As we said in chapter 1, when you have a real Cl
process, the developers on the team commit their work at least once a day. Generally,
the more commits the better.

Pull the changes before you commit, and check if everything is still working fine.
It’s possible that someone committed something while you were working, and your
copy of the file is out of date. It’s even possible that someone worked in the same file
you did. The Update function pulls all the changes from the central repository to your
working copy. If necessary, SVN merges the changes others made into files you've
worked with (see figure 2.18).

If TortoiseSVN isn’t able to merge the files properly, you may get a conflict that you
have to resolve. You can do so using the context menu for the conflicted item in the
Update window, as shown in figure 2.19.

Conflicts occur rather infrequently on a well-organized team. But when they do
occur, you must resolve them manually. A clean code base is important for a friction-
less ClI process. TortoiseSVN les you easily resolve conflicts using the Merge dialog box
(see figure 2.20).

When you’ve updated your working copy, run the same build process the Cl
server will use, and verified that everything is still working, you need to send the
changes to the central repository so others can benefit from the fruits of your work.
To do this, you must commit the changes. To issue this command with Tortoise-

SVN, from the context menu, choose TortoiseSVN > SVN Commit. TortoiseSVN will

~ CADeAFramewnrk - Update - TortoiseSYM Finished! |
Action Path Mime typs
Menged C 1 DeviFramewart Core ath\Finarce. o5

Complated At revision: 3

0 Bytes transferred in O minute(s) and 5 second(s)
Merped: 1 -
Show log... [ oK |

Figure 2.18 Always pull the changes before you commit. There may be changes already in the central
repository. Check if everything still works after update. Commit only if you’re sure you won't break the
Cl build.
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Campare with working copy
Edit conflicts
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Resobve conflict using ‘theirs’
Resobve conflict using ‘mine’
Show log

Warning!  One or more fles are in a conficied state,

v eeePp

Open
Open with..,
Open parent folder

0 Bytes transfenmed in 0 minute{s) and 5 second(s)
Conflicted: 1

g O

Copy to clipboard Camcel

Figure 2.19 Changes in the repository and in your local copy overlap and are too big for TortoiseSVN
to resolve. You have to step in and resolve the conflict.
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Figure 2.20 Resolving the infrequent case of a conflict with TortoiseSVN. You must do this if you update
changes that someone made to the same files as you and SVN can’t automatically merge the files.
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=" Commit - TeroiseSVN Finished! e || = ]
Action Path Welime type
Modified Ci\peviFrameswark
Miodified C1\Dev\Frameswork Cons
Maodified CrDeviFrameworkCoreMath\Finance. s
Sending content  Cr'\DeviFrameserk\Core Math\Finanos.cc
Complzted AL revision: 5

0 Bytes transTerred in 0 minute(s) and 10 second(s)
Modified:3

——

Figure 2.21 After your work is done, you have to send the changes to the repository. To do so, you
must commit the changes.

push the changes into the repository and display the progress dialog box (see fig-
ure 2.21).

There’s a lot more to source control management than updating and committing.
By now, you should have a pretty good idea how the Subversion server and client
work. You know enough to use it in your CI process. If you want to master your SVN
skills, see the Subversion book at http://svnbook.red-bean.com/. Try reverting changes,
copying within the repository, and branching the trunk. We’ll now pay close attention
to referencing.

Referencing

Let’s go back to the example calculator project. It’s divided into a shared calculation
library CalcCore (from the Framework solution) and two clients, WinCalc (from the
WindowsCalculator solution) and WebCalc (from the WebCalculator solution).

You've built your repository structure, as shown in figure 2.9. But the shared library
and the clients aren’t referenced with each other. You could compile the library and
reference the clients with a DLL, but you’ll probably want to work in the projects
simultaneously. You want to separately pull the projects from its repositories and cre-
ate one solution that references them. One of the solutions to this problem is pro-
vided with Subversion external definitions.

When you set up an external reference, you tell Subversion to check out a differ-
ent repository when you pull something else. This way, you can automatically have an
external directory or repository present in your working copy. You'll set Framework as
an external definition in the Windows and web calculator clients. Follow these steps:

1 In Windows Explorer, go to the WindowsCalculator folder, and bring up the
context menu. Select TortoiseSVN > Properties. The Properties dialog box
opens (see figure 2.22).
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Figure 2.22 The TortoiseSVN Properties dialog box is used to manage properties for a
particular item.

2 Click New. The Add Properties dialog box opens (see figure 2.23).

3 In the Property Name drop-down menu, select svn:externals.

4 In the Property Value field, enter the word Framework, press the spacebar, and
then enter the URL to the Framework repository. The easiest way to get the URL
is to right-click the Framework folder in Windows Explorer, select TortoiseSVN
> Relocate, and copy the URL from the Relocate dialog box.

5 Click OKin the Add Properties dialog box, and then click OK to close the Prop-
erties dialog box.

¢ Right-click the WindowsCalculator folder, and select SVN Update. Doing so
pulls the Framework folder into the WindowsCalculator folder. To inform the
repository about the external reference, you’ll have to do the commit.

7 Repeat these steps for the WebCalculator folder.

Figure 2.23

You can add many different properties using
the Add Properties dialog, including
references to external repositories.
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ChDey

A ™,

Framework hittps:ffhymie: &1 sen/Framewark/trunk

.

WindowsCaleulator hitps:/ hymie:B1 svnWinCalculater/trunk

\\. External

- 1
|
Framework hittps:/ hyrle B favn/ Framewark/ trunk
WinCale
L webCalculator https:/hymie:B1/svn/WebCalculator,/trunk
\ External
) |
Framework https:/ hymie: 81 svnSFramewarktrunk
WebCalc

Figure 2.24 Directory structure including SVN external references to WinCalculator and
WebCalculator, which contain the folder Framework that points to another repository or
directory

You now have the directory structure shown in figure 2.24. The directory structure has
changed, whereas the repository layout remains the same.

Now you can reference Framework from a subdirectory pulled by SVN within your
Windows and web clients. Go back to Visual Studio. In the Solution Explorer, right-
click the Windows Calculator solution, and choose Add > Existing Project. Choose the
CalcCore project from the subdirectory within the project folder. Your solution
should look like figure 2.25.

The library project is shared (including the source) among the client projects.
Doing it this way requires more work than creating a solid project structure up front
and checking it in. But this way, you have every project in its own repository, and
you can reference them as you like. This approach can be handy in some scenarios
such as simultaneous development of two projects that are destined to live sepa-
rately in the future and are placed in separate repositories. In some scenarios (such
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externals. Let’s say you're ready to deliver .
@ | (2] e

the software to the end user. You must tag
both the client project and the referenced

s |iZA CalcCore
project. The same thing applies to branch-

| Properties

ing: if you branch one project, the external <3 References
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the Cl servers. If you use them, you can be

-7 Solution 'WindowsCalculater' (2 projects)

sure that the Cl server will be able to read and Figure 2.25 Visual Studio solution layout with
resolve the externals without any problem. a reference to a library project from the client

project. This way, you can work simultaneously

Setting up Team Foundation Server  “htwo separaie repositories.

Team Foundation Server 2010 brings a big

change to the TFS licensing model. It’s much more affordable than the earlier ver-
sions. Whereas an average setup of TFS 2008 with server, user licenses, and Visual Stu-
dio Team System (VSTS) cost around $10,000, the new TFS 2010 for five users is about
$500. It works with all editions of Visual Studio except the Express Editions. And even
better, if you have a Visual Studio Professional with MSDN subscription or higher, TFS
is included. The cost factor is no longer a big deal.

One thing that drove this change was Microsoft’s desire to encourage VSS users to
move to TFS Version Control, which is a part of the TFS family of tools. The old VSS is
infamous (for good reasons or not) for its instability. A corrupted repository is the last
thing you want to experience after a hard day of work. And the sad truth about VSSis
that corruption happens way too often. TFS Version Control can’t be compared to VSS:
it uses a completely different file-access mode (changes are transactional), and it uses
SQL Server as its repository. You can also use SQL Server Express. TFS scales safely to a
large number of users. Now that it isn’'t so expensive, you definitely should give it a try.

Installing TFS20710
The TFS installation process has been completely reworked in TFS 2010. In earlier ver-
sions, you had to walk through a pre-install checklist and make sure all the prerequi-
sites were in place before you could continue. The new process installs many of the
prerequisites for you.

There’s also a new TFS Basic, designed for VSS users, that installs a subset of TFS. If
you select the Basic configuration during installation, you don’t get the full TFS
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experience, but you get source code control, work items, and Cl automation. It lacks
the SharePoint portal and Reporting Services integration, but it can be a good first
step for getting source code control and a Cl system set up and running.

You can install the Basic configuration on a local workstation. It can also use
SQL Server Express for its data store. We elected to go with the TFS Standard Sin-
gle Server configuration for this book. The only prerequisite is that SQL Server
needs to be installed on the server, including Reporting Services, Analysis Services,
and Full-Text Search.

Follow these steps: Select leatures bo nstall:

i Launch the TFS Setup program. = @& Team Foundation Components

_+_| Team Foundalinn Server

2 Select Team Foundation Compo- )% Tl Fidiaiation oeviee PG

nents and Team Foundation Server &2 Build Service
(see figure 2.26).
3 Make sure Team Foundation Server Figure 2.26 Installing the core TFS features

. with the build service
Proxy is unchecked.

The TFS Proxy is nothing more
than a caching mechanism for distributed teams. Typically, it’s installed in a
local area network to provide a transparent service for a local team and connec-
tion to a real TFS server over a slower connection. We'll deal with it a little more
in chapter 12, where you’ll scale Cl. If you don’t need proxy/cache functional-
ity, leave this feature unchecked.

4 Make sure Team Foundation Build Service is checked.

You’'ll definitely need it in chapter 4, where we'll deal with the Cl server, so
you want to install it here. It will be the workhorse for your Cl setup. Although
it’s typically installed on a separate machine from source code control, for bet-
ter performance you’ll leave it selected. You can always install another build ser-
vice on other machine later.

5 Click Install to begin the base install process. When it's completed, click Finish.

6 Make sure Standard Single Server is selected, as shown in figure 2.27, and click
Start Wizard.

7 What happens next depends on how your server is already set up. For example,
if Internet Information Services (11S) is installed, the TFS Configuration wizard
won'’t install it. Go ahead and work through the wizard, answering prompts as
needed. Installation may take a while.

TFS 2010 installation has been greatly streamlined from earlier versions and is now a
straightforward task. When installation completes, the TFS Administration Console is
launched. Now you can begin organizing your Team Projects layout—and that’s the
topic of the next section.
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Figure 2.27 Choose the Standard Single Server configuration in the Team Foundation Server
Configuration tool to set up one server with full TFS functionality.

TFS collections

The main organizational unit in TFS is a fteam project. To understand what a team proj-
ect is, you have to remove yourself from the source control perspective: think about
TFS as a general team-collaboration tool, with revision control as only a part of it. A
team project is a set of work items, code repositories, build definitions, and so on. It’s
a central place that connects a software application with the team developing it.

Team projects are organized in collections. The team projects grouped in a collec-
tion can share the same resources and are stored in the same database. From the code
point of view, a team project collection can share the same code base, and that makes
possible branching, merging, and other common source control activities. Let’s create
a collection for the loan calculator application:

1 If it isn’t running, launch the TFS Administration Console.

2 In the left panel, select Application Tier and then Team Project Collections

(see figure 2.28).
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Figure 2.28 TFS Administration Console with a default team project collection
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Figure 2.29 When you create a new team project collection, you give it a name and an
optional description.
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Figure 2.30 In the second step of creating a new team project collection, you specify the database
settings for your source files.

s Click the Create Team Project Collection link. The Create Team Project Collec-
tion wizard opens (see figure 2.29).

4 Enter Loan Calculator for the name, and an optional description; then
click Next.

5 Select the SQL Server instance and database (see figure 2.30) to use to store the
source files. In this case, keep the default settings. Click Next.

s The remainder of the settings—SharePoint, Reports, and Lab Management—
are beyond the scope of this book. Click Verify to have the wizard check
whether everything is prepared for these settings. Then click Create.

7 It will take a few minutes for the wizard to complete. When it’s finished, click
Complete and then Close.

The newly created team project collection is ready. You can now populate it with some
team projects. You won'’t do this from the TFS Administration Console. From now on,
you'll work on your development machine with Visual Studio. Let’s switch to it and
populate the collection.
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2.4.3 Using Visual Studio Team Explorer
All you need to manage your code with TFS
2010 is a copy of Visual Studio 2010. The avail-
able versions (except Express) have Team
Explorer built in. Follow these steps:

1 Launch Visual Studio 2010, and select
View > Team Explorer from the menu.
An empty Team Explorer window opens
(see figure 2.31).

2 In Team Explorer, click the Connect to
Team Project icon. If this is your first
project, you must configure the connec-
tion to TFS.

3 You're prompted to select a TFS server,
because this is the first time you’ve set

Setting up a source control system

Tearn Explover ~AX

| Connect te Team Progect |

Figure 2.31 Team Explorer, ready to be
used. First you must connect to the server
and then to the team project.

up a project under TFS. Click Servers..., and then click Add in the resulting

dialog box.

¢ The Add Team Foundation Server dialog box opens (see figure 2.32). Enter
the name of your server. If you used the default settings for the TFS server,
everything else is filled in for you. Click OK to finish making the connection to

the server.

5 |f you're prompted to log in, do so with proper credentials. The wizard should
choose the newly created server connection for you, and you have to pick the
collection. Choose the one you recently created, Loan Calculator, and click
Connect. You'll land back in Visual Studio and see something like figure 2.33 in

your Team Explorer.

.
Add Team Foundation Server ——

Mame aor URL of Team Foundation Server:
HYMIE

Preview: hitp:/ ymie:S080/ts
Connection Details
Path: te
Pert number  goan

Protocol & HTTP HTTPS

QK

Cancel

|
X

Figure 2.32 You need to tell Team Explorer which server has the TFS

installation you're using.
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6 Team Explorer now points to an empty T .
project collection. You need to add a A%
project to it. To do so, right-click the col- T hymie\Loan Caiculator
lection in Team Explorer, and choose [F] My Favorites

New Team Project. The New Team Proj-
ect wizard is launched (see figure 2.34).
7 Enter the name (for example, ClinDot-
Net Calculator Sample Application), and
click Next.
s You need to select the process template

to use (see figure 2.35). In this case,
choose the MSF for Agile Software Devel- Figure 2.33 Team Explorer now shows
. the Loan Calculator project collection.
opment template to work with, and then
click Next.
TFS doesn’t limit the methodology you use to develop your software. It
comes with two process templates: Microsoft Solution Framework (MSF) for

ﬂ Specify the Team Project Settings

The New Tearm Project Wizard uges the team project name you type here when créating vanous
cnmpcnlﬂh. After the tearmn Fl\u_j:cl: 3 created, the name 15 used I::.rl!um members to locate the beam
project.

Mzke sure that the name you pick for the team project is not already in use by Team Foundstion Server or
any ether software used in the deployment (for examgle, SharePoint Products or SQL Server Reporting
Services).

What is the name of the team project?
ClinDotMet Calculator Samiple Application

‘What is the description of the team project?

e

Figure 2.34 When adding a team project to the collection, you need to specify a name and optional
description.
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ﬁ Select 2 Process Template

The process ternplate defines key agpects of how the team project is managed. The process template may
include work tem types, work products, reports, queries, and process guidance for your team project.

‘ Which process template should be used to create the team project?

MSF for Agile Software Development v5.0 - Betad -

This Tearn Systemn project template allows you to organize and track the progress and health of 2 smallte «
| medium agils project.

Q‘ Download additional Process Templates online
(==

| <previeus || pwas | [ Ensh || canea

Figure 2.35 You have a choice of process templates to use for the new team project.

Agile Software Development and MSF for Capability Maturity Model Integration
(CMMI) Process Improvement. The templates describe how TFS organizes your
work in the project. We recommend MSF for Agile because it’s less process-
heavy than the CMMI template. Anyone can create or edit a process template.
The best way to do this is to use the Team Foundation Power Tools and its Pro-
cess Editor. The TFS Power Tools are freely available over the MSDN website.
Additionally, at the bottom of figure 2.35, you can see the link where you can
download prebuilt templates. An interesting one is Microsoft Visual Studio
Scrum 1.0, which is suitable for teams using the scrum methodology to manage
the project lifecycle.

9 |f you wish to create a new SharePoint site, select that option and click Next.

10 You're prompted to specify source control settings. As long as your source con-
trol repository is empty, you can only create a new folder. Because you have
nothing to branch yet, click Finish to complete the wizard. You'll be connected
to the new team project (see figure 2.36).

You’re now ready to manage your source code inside the team project.
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Managing TFS source contro/

Unlike the example you saw earlier with
Subversion, you don’t need any external
tools to manage code with TFS if you'’re
using Visual Studio. As we said earlier, TFS
is a lot more than source control. The
source control tooling is tightly integrated
with Visual Studio. From this perspective,

it can be easier to use TFS than to gather all
the SVN tooling, because everything is done

from inside the development environ-

ment. It's possible to use command-line
commands to manage TFS source control.
In this case, you’ll go the Visual studio way.

Tearn Explarer *0OX
2l 1= | 5
34 hymie\Loan Calculator

J h‘}fFWEIﬂH
4 3 QinDotNet Calculator Sampile Application
J_-F Work ltems
_d Documents
Reports
% Builds
& Source Contrel

Figure 2.36 Team Explorer in Visual Studio 2010
connected to a server named hymie and Loan
Calculator collection with one project inside.

Let’s get the application source code checked in to TFS:

1 If you followed along earlier in this chapter and set up the loan calculator

under Subversion, you need a fresh directory and project that aren’t currently
under source control. When that’s done, continue to step 2.

2 Open the Framework solution in Visual Studio. Right-click the solution, and
choose Add Solution to Source Control. The Add Solution to Source Control

dialog box opens (see figure 2.37).

Add Selution Framesort 1 Source Contral

Irdicate whers to store your solution and projects in the tesm foundation server and inyour

gl works pace,
Tearmn Foundstion Server Detsils

Server;  hymeeiLoan Calouletor
Team Project Locatian:
I'd_ ChnDotMNet Caliulster Sample Appheation

Blake Mevw Folder

Type & name for the sehatesn folder:
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Figure 2.38 When you add files to TFS source code control, any files that are new or changed are
flagged as pending changes.

3 Click OK to accept the default settings. The Pending Changes dialog box opens
(see figure 2.38).

+ Because you want all the files to be saved, click Check In. If you're prompted to
check in all items, select Yes.

5 Repeat these steps for the WebCalculator and WindowsCalculator solutions.

When all the files are checked in, notice the change in Solution Explorer. Each file now
has a small lock icon displayed next to it (see figure 2.39) to indicate that the file is
checked in. Other icons are used to indicate different source code control statuses.
Consult the Visual Studio documentation for help understanding the different icons.

From now on, you can manage your code from the context menu in the Solution
Explorer. The management concepts are the same for TFS as for SVN. You check in,
check out, branch, merge, and so on. This time, you can perform all the operations
from within Visual Studio. To check in files, right-click the solution, and issue the
Check In command.

In a way similar to other revision-control software, you can add a message to every
operation. TFS makes it possible to associate a work item with a given source control
operation. We won’t deal with work-item management and tracing in this book, but
we strongly recommend that you look into it. You should start at http://msdn.micro-
soft.com/en-us/vstudio, where you can find a lot of information about Visual Studio
itself and TFS 2010 in particular. It helps the development process to know exactly
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why you’re checking something in, what user
checked in a file, and what work item was asso-
ciated with it.

Locking and shelving
TFS source control, unlike SVN, lets you perma-
nently lock the files you’re working with. The
difference lies in the fact that you can choose
to prevent the files from being checked out by
other users. This not only can prevent check-
ing in changes to a locked file but also can pre-
vent the file from being checked out.

To lock a file or directory, right-click in the
Solution Explorer, and choose Check Out for
Edit. The Lock dialog box opens, as shown in
figure 2.40. Then choose a lock mode and click

Lock. Note that if you choose Check Out, other users will have to wait until you com-

a @5 Properties
&) Assemblylnfo.cs
=3 Peferences
a4 [y Math
&%) Finance.cs
&ty CalcCoresnk

Figure 2.39 A newly added solution
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being ready for the first check-in.

mit your changes to the repository before they can begin to work with the file.

Another useful feature of TFS source control is the ability to shelve changes. This
lets you stack the changes you want to keep safe under source control but don’t want
to check in yet. Imagine that you’'ve worked all day Friday on a new feature. You aren’t

’
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Figure 2.40 Locking a file in TFS source control prevents other users from checking in (just as

with SVN) or prevents check in and check out.
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Figure 2.41 Shelving pending changes in TFS source control is nothing more than making a secure copy
of work in progress under version control.

finished, so you don’t want to check in the file; but the changes are too valuable for
you to keep on your laptop over the weekend. You can create a shelf in TFS source
control and send your changes there.

To create a shelf, right-click the file in Solution Explorer, and choose Shelve Pend-
ing Changes. The Shelve dialog box opens (see figure 2.41). Name the shelveset, and
click Shelve.

TFS 2010 source control, unlike Visual SourceSafe, is a product worth recommend-
ing. If you're planning to base your Cl process on TFS, make sure you're using its
internal source control capabilities. Mixing SVN and TFS is possible but troublesome.
If you have the luxury of choosing a source code control system, refer to chapter 4,
where we discuss Cl servers and how to choose the program that’s best for you.

Summary

Setting up a clean and well-thought-out source control system is vital for the Cl pro-
cess. Without one, you won't be able to integrate your work continuously. There won’t
be a single repository containing all you need to build your software. It’ll be difficult

to know when something changed. It’ll be impossible to trigger a Cl build.
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A well-designed repository structure should play along with the project layout.
Depending on your needs, you'll use single or multiple repositories to host your proj-
ects. You'll have to decide whether you need external references. The keys to the right
solution are circumstances and experience. We're convinced that the solutions pro-
vided in this chapter play well while building a Cl process.

If you're one of the rare software houses that hasn’t been using source control sys-
tems until now, incorporating Cl may be a great opportunity to introduce Subver-
sion—a terrific, free revision control system. As you’ve seen, setting up a VisualSVN
Server is simple, and administration with the VisualSVN Management Console is more
than easy. If you choose to use the TortoiseSVN client, you'll be able to do anything
you need to keep a consistent and clean code base.

If you're planning to use Microsoft Team Foundation Server, for which the 2010
version is a big milestone, especially for smaller teams, you should seriously consider
using TFS source control to host the changes in your source code. TFS 2010 is afford-
able and is keeping up in the way of features with the best open source revision con-
trol systems.

The financial calculator you pushed to your source control system in this chapter
will help provide a full-blown Cl process later in the book. The next step will be to cre-
ate a fully automated build process for this project. This build will be used within the
Cl process to check whether integration is going well, along with team commits. In the
next chapter, you'll create a build process.
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This chapter covers

Choosing a build-automation tool for the
Cl process

Using MSBuild
Extending MSBuild

Having a single repository that contains everything you need for building your soft-
ware is the first step on the path to a good Cl process. The second, which is also
important, is to have the software build. To do this, you need a kind of metaphori-
cal lever that will help you jack up your source code from transcription of ideas into
working software. You'll use this lever in your day-to-day work as well as in the Cl
process you’re building. Your build lever must be designed in a way that’ll let you
build your application in one step.

The first thing that may come to mind as a lever in the .NET Framework world is
Visual Studio. It seems to have everything that makes for a good lever. When you
press the F6 button, you start a build process that leads to working software. But is it
enough? Does it make a good lever? We're afraid not. It’s able to compile and start
a program, but nothing else. We need more to incorporate Cl: something that’ll let
you test everything, analyze the code, generate documentation, deploy, and create
installation routines. We’re looking for something powerful, customizable, and
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extensible. Visual Studio is a great development environment, but a poor software-
automation tool—and we want to automate the entire software build process.

If your build process doesn’t take care of everything in addition to compiling,
those elements will most likely be neglected. You don’t click one button to compile,
another to test, and another to deploy. The key is automation—and that means you
have to get rid of the human factor.

We want to create a build process that can work autonomously, without supervi-
sion. The way to achieve this goal is through an automation platform.

In this chapter, we’ll browse through various build-management systems and deter-
mine which ones are suitable for the .NET integration process. We’'ll look at NAnt, but in
the end we’ll choose MSBuild as the best build tool. You'll use built-in and community-
owned MSBuild features to create a build-and-deploy process. Finally, you’ll extend
MSBuild with your own functionality.

Build automation
In the CI context, an automation platform is a tool or a set of tools that helps automate
the entire software build process, including doing the following:

+ Compiling the source code

+ Preparing the database

+ Performing tests

+ Analyzing the code

+ Creating installation routines and deploying
+ Creating documentation

What we're looking for should be easily maintainable. And it should be stored in the
source control system like everything else that takes part in the Cl process.

The obvious way to automate the build process is to script it using human-readable
text. You should avoid everything that doesn’t use text as a description of a build pro-
cess. Compile managers are bad, bad things. You should ban from your mind any
automation tool that keeps the build description in binary format and requires you to
manually click to make it run. Text form is easier to create, read, edit, and keep track
of (using version control) than binary form.

In chapter 1, you saw a simple example of automation using ordinary command-
line commands organized in a batch file; software automation was done this way at the
dawn of time. It makes the process faster in comparison to manually issuing com-
mands, it reduces redundant tasks because you don’t have to be involved in every
build, and it lets others maintain the build. Now, let’s walk through some rea/ automa-
tion tools and search for the best one.

Make and its children
Software-automation platforms are older than most active software developers. The
great-grandfather of almost all current tools is the UNIX make utility, which was created
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at the end of the 1970s and has been used mostly in the *ix world. It has a Windows ver-
sion called nmake and a fairly good clone called Opus Make. All the make systems use a
text file called a make file to describe the software build process.

Later-generation tools like Jam and Cook changed this. They used more sophisti-
cated statements to hide some of the lower-level aspects of software automation.
With time, the automation platforms became bigger and more complex and began
to be called automation systems. One of them is GNU Automake with the GNU Build
System (GBS—a set of small tools that comes in handy when you’re building soft-
ware on *ix systems).

Finally, we have automation tools that use a specific programming language to
describe the build process. For example, SCons uses Python, and rake uses Ruby.

All the tools we’'ve mentioned can be used to set up a Cl process. But we’ll look at
the vanguard of build automation: the XML-based build systems Ant (NAnt) and
MSBuild. The XML-based systems are a step away from tools that use fairly compli-
cated commands or a programming language to describe the build process. Using
them, you can declare the steps in an XML build script, and the steps are easy to
extend and adapt.

NAnt and MSBuild are two of the tools you should choose from if you're creating a
build process in a .NET environment. Both do the same job using similar techniques.
NAnt is an open source tool maintained by the community, and MSBuild comes from
Microsoft. Table 3.1 shows the most significant differences between them.

Table 3.1 NAnt vs. MSBuild: significant differences

Feature NAnt MSBuild
Actively developed no yes
Built-in features yes some
Open source yes no
Cross-platform (Linux, Mono) yes no
Good if you already know Ant yes no
Built in to .NET Framework yes yes
Integrated with Visual Studio no yes

Let’s take a quick look at NAnt and see why we’ll go with MSBuild instead.

1t’s not an Ant

Once upon a time, there was Ant. It was a good, established tool used to build appli-
cations in Java shops. It was ported to work in the .NET world and called NAnt (Not

an Ant). From its Java ancestor, it inherited the XML declarative automation descrip-
tion language.
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Let’s try to use NAnt with this full-blown, single-line C# program:

class c{static void Main() {System.Console.Write("Hello NAnt");}}

Place this program in a file called HelloNAnt.cs. Now write the following NAnt script
to build an application. Call it HelloNAnt.build.

Listing 3.1 NAnt build script to clean and compile a Windows application

<?xml version="1.0"?>
<project name="Hello NAnt" default="build" basedir=".">
<property name="debug" value="true" overwrite="false" />
<target name="clean">
<delete file="HelloNAnt.exe" failonerror="false" />
<delete file="HelloNAnt.pdb" failonerror="false" />
</target>
<target name="build" depends="clean">
<csc target="exe"
output="HelloNAnt.exe"
debug="${debug}">
<sources>
<include name="HelloNAnt.cs" />
</sources>
</csc>

</target>
</project>
An NAnt script is an ordinary XML document. First you declare the project, specifying
the name (Hello NAnt), the default target (Build), and the working directory (dot [.]
for the current directory). Next, NAnt gives you the ability to define properties. A prop-
erty is a kind of named variable to which you can assign a value. The overwrite attri-
bute lets you set the variable from the command line. The debug variable is used by
the C# compiler task in a moment. The Clean target uses two delete tasks to erase
unnecessary files. Setting the failonerror attribute tells NAnt to ignore possible
errors—for example, if there’s nothing to delete. The second target, Build, first runs
the Clean target because of the depends attribute, and then runs the csc target to
compile the source file.

One of the rules of Cl that we keep mentioning is placing everything you need to
fully build a project inside the project directory/repository. To use the script you just
wrote, you need NAnt executables (available from http://nant.sourceforge.net). Place
the NAnt executables in the tools/nant folder. NAnt is now ready to use.

Open a command window, navigate to the project folder, and type tools/nant/
bin/nant.exe to launch NAnt (see figure 3.1). Run the script, and build your one-line
program. Now that the script is working, you can extend it, declare more steps, and
integrate more actions.

At the time we started writing this book, the open source NAnt project seemed to
be dead. But in mid-2010, just as we were finishing writing, a new version of NAnt
emerged. We felt that delaying publication didn’t merit reworking examples and text
to include NAnt. From a technical point of view, it isn’t a big deal. NAnt is a good
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Figure 3.1 Starting a Hello World—style NAnt script. The build performs a clean followed by a
build task. As an artifact, you get a compiled executable.

alternative for software developers with a Java background who are familiar with its
ancestor, Ant. Many developers use MSBuild only to compile the source code and use
NAnt to integrate all other tools into the ClI process.

The Microsoft worker: MSBuild

Microsoft first shipped its own build tool for the .NET platform with the second ver-
sion of the .NET Framework. Updated versions were shipped with .NET Frameworks
3.0, 3.5, and 4.0. If you check C:\Windows\Microsoft. NET\Framework\, you’ll see that
the subfolders for v2.0, v3.5, and v4.0 contain MSBuild.exe.

Using MSBuild means less work. You don’t need to worry about third-party tools
and how to integrate them with your environment. You don’t have to worry about
whether your favorite build tool is installed on the integration machine, because if
you have .NET Framework installed, the tool will be there. Pragmatic people will find
MSBuild appealing. Who knows how your business will grow? You may hit the scaling
wall with the free software and have to think about something bigger. The entire
Microsoft Team Foundation Server Build (more about it in chapter 4) is set on top of
MSBuild. Keep this in mind, and you’ll feel prepared.

MSBuild is freely distributed with the .NET platform. It has Microsoft’s machinery
behind it, so you don’t need to worry about wide adoption and popularity. It won'’t die
suddenly, leaving you without support. MSBuild is extensible and well-documented. It
uses XML syntax similar to NAnt to perform build tasks. And it’s closely integrated with
Visual Studio: it understands Visual Studio solution files and makes it possible to com-
pile Visual Studio solutions and projects without Visual Studio. It seems to be the build
tool for .NET developers who want to set up a Cl assembly line. But let’s start small with
a simple script that compiles a simple Hello World application.
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First encounters with MSBuild
To use MSBuild from the command line, you have to write the full path for the execut-
able or add it to your System Paths variable. But if you have Visual Studio installed,
you can use the Visual Studio Command Prompt, which knows the path to MSBuild.
You launch the Visual Studio Command Prompt from the Windows Start menu (see
figure 3.2).

As a small workout in MSBuild, you'll perform the same tasks as you did previously
with NAnt. Write another captivating one-liner:

class c{static void Main() {System.Console.Write ("Hello MSBuild");}}

Compile it using the MSBuild script build.proj, shown next. The .proj file should go in
the same folder as the source file for the program.
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Listing 3.2 Simple MSBuild script

<?xml version="1.0" encoding="utf-8"?>
<Project DefaultTargets="Build"
xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<Debug Condition="'$ (Delete) '=='"'">true</Debug>
</PropertyGroup>
<ItemGroup>
<CompileFiles Include="HelloMSBuild.cs" />
<DeleteFiles Include="HelloMSBuild.exe;HelloMSBuild.pdb" />
</ItemGroup>
<Target Name="Clean">
<Delete Files="@ (DeleteFiles)" />
</Target>
<Target Name="Build" DependsOnTargets="Clean">
<Csc Sources="@ (CompileFiles)"
OutputAssembly="HelloMSBuild.exe"
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EmitDebugInformation="$ (Debug)" />
</Target>
</Project>
This script should look familiar. Just as with NAnt, an MSBuild script is an XML docu-
ment, and it uses a similar set of ideas including properties, targets, and tasks. The
main element of an MSBuild script is a Project, which defines the entire build pro-
cess. It must be equipped with an xmlns attribute that defines the namespace. Option-
ally, you can define default targets. In this case, you use the Build target.

A Target is a logical part that declares a set of tasks. The target can be organized
hierarchically, so that one target depends on another. In this case, the Build target
depends on the Clean target, so MSBuild first runs the Clean target and then the
Build target.

The Build target has only one task: Csc. This task calls the G# compiler with param-
eters. In the first parameter, specified by the Sources attribute, you provide an item
containing a list of documents to be compiled. In the second parameter, Output-
Assembly, you provide a name for the output file. In the last parameter, EmitDebug-
Information, you specify whether you're interested in debug information for your
program. The value for it is defined in the Debug property.

An ItemGroup contains a list of items. In the example, items contain one or more
references to a file. You have two of them: the first defines the files to be compiled (in
this case, one file, HelloMSBuild.cs) and the second contains the list of files that the
Clean target should delete.

MSBuild properties are containers for values. Every property has a name and is
defined in a PropertyGroup. You define only one property here: Debug. It contains a
Boolean value and is used in the Csc target to determine whether the compiler should
create a .pdb debug symbols file.

If the path to MSBuild exists in system variables or you’re using the Visual Studio
Command Prompt, the only thing you have to do is start MSBuild from the command
line. Type msbuild to launch and run the build process (see figure 3.3).

Now that you’'ve written your first MSBuild script, let’s extend it a little.

Passing parameters to MSBuild scripts

Another neat thing you'll use often when creating a Cl process using MSBuild is
the ability to pass parameters from the command line to the script. Your Debug
property has one attribute, Condition, which you can set from the command line
like this: msbuild /property:Debug=false. This attribute helps set the default

value if you call the script without setting the value explicitly.

After you do this, the condition '$ (Delete) '=="" isn't fulfilled. That is, the value
is false and not empty. MSBuild uses what’s defined at the command line. In the
end, you get the compilation without the debug files.
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Figure 3.3 MSBuild is less verbose than NAnt. If you have only one file with the *.proj extension in
the directory where you start MSBuild, it's automatically executed.

3.2.2 Using predefined tasks to extend an MSBuild script
MSBuild comes with a set of predefined tasks. You've already used two of them: the C#
compiler taskCsc and theDelete task. Other useful MSBuild tasks include the following:

+ Copy copies a file.

+  MakeDir creates a folder.

+ RemoveDir removes a folder.

*  Message prints a message on the screen.
+  Exec runs any program.

You’ll use these tasks to extend your MSBuild script. Using the code from listing 3.3,
you can create something like a mini-Cl iteration step (without the loop). Using
MSBuild, you clean up the building site, compile and archive the software, and then
copy the output to a folder and start the program to test whether it works.

Listing 3.3 Extending the build script

<?xml version="1.0" encoding="utf-8"?>

<Project DefaultTargets="Build;Deploy;Execute" Defines
xmlns="http://schemas.microsoft.com/developer/msbuild/2003"> default

<PropertyGroup> largets
<Debug Condition="'$ (Delete) '=='"'">false</Debug>
<OutputFile>HelloMSBuild.exe</OutputFile>
<OutputDirectory>Output</OutputDirectory>
</PropertyGroup>
<ItemGroup>
<CompileFiles Include="HelloMSBuild.cs" />
<DeleteFiles Include="HelloMSBuild.exe;HelloMSBuild.pdb" />
</ItemGroup>
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<Target Name="Clean">
<Delete Files="@ (DeleteFiles)" />
<Delete Files="$ (OutputDirectory) \**\*" />
<RemoveDir Directories="$ (OutputDirectory)" />
</Target>
<Target Name="Build" DependsOnTargets="Clean">
<Csc Sources="Q@ (CompileFiles)"
OutputAssembly="$ (OutputFile)"
EmitDebugInformation="$ (Debug)" />
</Target>
<Target Name="Deploy">
<MakeDir Directories="Output" />
<Copy SourceFiles="$ (OutputFile)"
DestinationFolder="$ (OutputDirectory)" />
</Target>
<Target Name="Execute">
<Message Text="Starting: $ (MSBuildProjectDirectory)

\'$ (OutputDirectory) \$ (OutputFile)"
Importance="low" />
<Exec WorkingDirectory="$ (OutputDirectory)"

Command="$ (OutputFile) "></Exec>
</Target>
</Project>

The first thing that catches your eye is probably the extended DefaultTargets list B.
You define three new tasks, divide by semicolons. They’re executed in the same order
that they appear in the list. Note that the Build task still depends on Clean.

The Build target is the same as in the previous example. The Deploy target creates
the output folder (MakeDir task) and copies the executable file (Copy task) to the
folder defined in the property $ (OutputFile).

The Execute target first uses the Message task to write text to the screen. The mes-
sage contains information about what will be executed and where. The message uses
one of many predefined properties,$ (MSBuildProjectDirectory), which contains the
path to the MSBuild project. The Message task has one more parameter, Importance,
which defines the verbosity of the MSBuild execution. In a minute, you’ll learn what this
means and how to start MSBuild with different verbosity settings.

After the Message task, you use the Exec task to start the program. The Exec task
uses two parameters: Command to define the program that needs to be started and
WorkingDirectory to define where it needs to be started.

The Clean target is then extended with additional functionality to remove old fold-
ers (RemoveDir) and files (Delete).

Let’s start the automated build process. For the sake of cleanliness, delete all the
artifacts that remained in the project directory. You don’t have to do this manually!
You have all you need in your MSBuild script. You can start it with the /target com-
mand-line parameter. Using this parameter, you can start any target defined in your
MSBuild project, disregarding the DefaultTargets project attribute.

Go to the command prompt, and type msbuild /target:Clean. You should see
something similar to figure 3.4.
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Figure 3.4 You can pass MSBuild a specific target—for example, one to clean folders and files—on
the command line.

You've cleaned everything, and you're ready to start the actual build. Enter msbuild in
the command window to build and run the program (see figure 3.5).

But what happened to the Message task in the Execute target? It’s nowhere to be
seen in the output. It was omitted because of MSBuild’s default verbosity level. The ver-
bosity level defines how much information the MSBuild process writes on the screen.
The higher the level, the more information you see on screen. To see the messages
with Importance set to Low, you must start MSBuild with high verbosity. It may sound
trivial, but it’s an art to set the correct verbosity level in the Cl process. You have to set
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Figure 3.5 MSBuild can build and run a program.
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verbosity this way to be able to quickly browse through and know what’s going on.
You'll do this often. You don’t want to be flooded with information you don’t need;
instead, you want to be able to quickly and precisely locate the cause of a problem.
Only with the correct verbosity level can you do this.

Let’s run MSBuild with a nonstandard verbosity level. Go back to the command
window, and type msbuild /verbosity:detailed. Thistime, the Message task is exe-
cuted (see figure 3.6).

We've shown you how to use MSBuild with an essential set of tasks. These tasks are
built in to MSBuild. But sooner or later, you’ll need something more. MSBuild Com-
munity Tasks are a great set of additional tasks.

3.2.3 MSBuild Community Tasks

Using MSBuild, you aren’t limited to the tasks that are delivered inside the program
from Microsoft. The set of tasks can easily be extended. You can do this by writing a task
yourself, or you can use tasks others have written. A useful set of free tasks called
MSBuild Community Tasks is distributed as open source and contains a lot of ready-to-
use functionality, such as using FTP servers, sending email, manipulating XML, manag-
ing SVN, getting the date and time, and much more. For the complete list, refer to
http://msbuildtasks.tigris.org/.

The easiest way to start using the MSBuild Community Tasks is to download the MSI
package and install it on the system. But this isn’t the best way if you intend to set up a
Cl process. By installing the package, you get all the system variables set, and the Com-
munity Tasks are instantly ready to use. But if you do this, you must install the software
on the build server as well. You'll encounter a similar problem if you want to use it on
various machines for your team. Think about what it means to install the new version

B Visual Studie 2010 Command Prampt =N EoN ==

=P

Done executing tazk "Lopy’.
g ny

Task "Message™
Starting: CrxDevsHEBuild2s0utput HelloMEBuild.exe
" tazk W -

k] B3

Using “Exec™ task From assembly “Hicvosoft . Build.Tasks, Version=Z.B.8.8, Caltur
ke=neutral, PublicKeyToken=hB3F5f 7F11d50a3a"

Task "Exec"
Conmanid:
HelloHEBuild. cxe

Hello HEEuild?
Done executing tack “Exec.

8 Warningcz)
B Erraris)

Time Elapsed BB:80:088.89
CovDeyMHEBuild2 > _ et

Figure 3.6 MSBuild is more verbose if you start it with a /verbosity:detailed switch.
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" ..
MEEuidCammunity Tasks

T

LS,

build. proj

T Figure 3.7
HelloMS5Buildecs The directory structure for a project should include the
MSBuild Community Tasks.

on every machine—that’s one of the reasons to keep everything you need in the proj-
ect directory.

Create the folder tools/ MSBuildCommunityTasks under your project directory.
Download the Community Tasks zip archive, decompress it, and copy the content of
the bin directory into your tools directory (see figure 3.7). This way, everyone can use
the Community Tasks after they get the latest version of the project from your source
control system.

Now, let’s put the Community Tasks to work. Listing 3.4 uses three of the many
tasks that are available. These tasks let you archive your software, give the archive a
unique name, and send it using email. To keep the script brief, it omits some parts
that are duplicates from listing 3.3.

Listing 3.4 Build script using MSBuild Community Tasks

<?xml version="1.0" encoding="utf-8"?> |mp0rts Community Tasks B
<Project DefaultTargets="Build;Deploy;Execute"
xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<UsingTask
AssemblyFile="tools\MSBuildCommunityTasks\MSBuild.Community.Tasks.dll"
TaskName="MSBuild.Community.Tasks.Zip" />
<UsingTask
AssemblyFile="tools\MSBuildCommunityTasks\MSBuild.Community.Tasks.dll"
TaskName="MSBuild.Community.Tasks.Mail" />
<UsingTask
AssemblyFile="tools\MSBuildCommunityTasks\MSBuild.Community.Tasks.dll"
TaskName="MSBuild.Community.Tasks.Time" />

<PropertyGroup>
</PropertyGroup>
<ItemGroup>
<DeleteFiles Include="*.zip" /> I nsert code from
</ItemGroup> Iisting 3.3

<Target Name="Clean">

</Target>

<Target Name="Build" DependsOnTargets="Clean">
</Target>




78

3.8

CHAPTER3  Automating the build process

<Target Name="Deploy">
<MakeDir Directories="Output" />

<Copy SourceFiles="$ (OutputFile)"

DestinationFolder="$ (OutputDirectory)" /> j ﬁﬁ't: current

<Time Format="yyyyMMddHHmmss">
<Output TaskParameter="FormattedTime"
PropertyName="BuildDate" />
</Time>
<Zip Files="$ (OutputFile)" Archives
7ipFileNane="HelloMSBuild.$ (BuildDate) .zip" /> program
<Mail

SmtpServer="adres"

To="email" E Sends
From="email" email

Subject="New build!"
Body="This is an automated message."
Attachments="HelloMSBuild.$ (BuildDate).zip"/>
</Target>
<Target Name="Execute"> I nsert code from
</Target> listing 3.3
</Project>
First, you must inform MSBuild that you're about to use an additional task B. You do
this in the UsingTask tag, giving it an attribute with the path to the MSBuild Commu-
nity Tasks library and specifying what task you'll be using. Here, you use the Zip, Mail,
and Time tasks in the Deploy target.
You use the Time task Cto set a new property with the current date and time. This
property is named $ (BuildDate) and is used in the next task, Zip D. This task creates
an archive with the name defined in the attribute ZipFileName, which contains the
files defined in the Files attribute. The last step is to send the archived file to a given
email address using the Mail task E. The Mail task needs to be configured: you must
provide the SMTP server name, the username and password if necessary, and the mail
recipient. In a development environment, you might think about using a fake SMTP
server to test the functionality. We like Antix SMTP Imposter (www.antix.co.uk/Proj-
ects/ SMTPImpostor)—it has everything a normal SMTP server has, but it keeps the
messages unsent and ready for review.
Run MSBuild as before, and you’ll see that the MSBuild Community Tasks are run
just like the native MSBuild tasks (see figure 3.8).
Additional Community Tasks are handy when you write your own build script.
Another important feature of MSBuild is its integration with Visual Studio.

The happy couple: Visual Studio and MSBuild

MSBuild is used mostly in conjunction with Visual Studio, because they understand
each other so well. MSBuild has tasks that can read and compile entire Visual Studio
projects or solutions. And project files since Visual Studio version 2005 are nothing
other than MSBuild scripts, which means you can extend your project file directly.
IntelliSense and validation for MSBuild scripts are present in Visual Studio.
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@ Visusl Studio 2010 Command Prompt =

Deleting file "HelloMSBuild.sxe®™. g
Deleting File ™HelloRSBuild. Z0@91004133735% . 2ip". =
Remowing divectory “Output’™.

CosDew s MEBuiild3

Creating directory "Output'.
Copying File Fron "HelloMSBuild.exe" to "OutputsHelloMEHuild.exe™.
Creating zip File "HelloRSBuild.ZB@71084123887 .21ip"'.

added “"HelloMEBuild.exe'.
Created =ip File “"HelloMSBuild 2009180412388 .=1ip" successFully.
Emailing “marcinBkavalerowlics.net".

Hello ASBuild®

Huild succesded
B Warning{s2

@ Erroris}

Eim Elapzed BA:AA:05 .61

swDeusMEBuildd » >

Figure 3.8 The extended MSBuild script in action. Using MSBuild Community Tasks, you can archive
the output and send it as an email attachment.

Examining a project file
In chapter 1, you created some Visual Studio projects. This set contains one shared
mathematical library and two clients for a leasing calculator. Open one of the project
files: for G# projects, the name is *.csproj; and for VB, it’s *.vbproj.
To open the project file in text form in Visual Studio 2010, unload the project (by
choosing Unload Project from the project context menu in Solution Explorer) and
edit it (also using the context menu). Don’t forget to reload the project afterward. You
can do the same thing using the PowerCommands plug-in (available from http://
visualstudiogallery.msdn.microsoft.com). It’ll let you open the project file by right-
clicking in the Solution Explorer and choosing Edit Project File from the context menu.
The following listing shows part of a project file. To save space, we cut out the
PropertyGroups responsible for project configuration and the ItemGroups that define
references, includes, and files.

Listing 3.5 Visual Studio project file, which is an MSBuild script

<?xml version="1.0" encoding="utf-8"?>
<Project ToolsVersion="4.0" DefaultTargets="Build"

xmlns="http://schemas.microsoft.com/developer/msbuild/2003">

<PropertyGroup>
<Configuration Condition="

'$(Configuration)' == '' ">Debug</Configuration> Omitted project
</PropertyGroup> . .
<TtemGroup> configuration

<Reference Include="System" /> Omitted references,
</TtemGroup> imports, compile
<Import Project= items, embeds

"$ (MSBuildToolsPath) \Microsoft.CSharp.targets" /> <1—B Does magic


http://visualstudiogallery.msdn.microsoft.com/
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<!-- To modify your build process, add your task

inside one of the targets below and uncomment it.
Other similar extension points exist, see

Microsoft.Common.targets.
<Target Name="BeforeBuild">

</Target> 66 Project extension points
<Target Name="AfterBuild"> <FJ

</Target>
——>

</Project>

This project file should look familiar, because it’s an MSBuild script. It has a default tar-
get named Build, a PropertyGroup, and so on. But wait! Where’s the definition of the

Build target? It's nowhere to be seen. To solve this riddle, you have to look in the

imported Microsoft.CSharp.targets project B. Itsan import of the standard C#

targets file. You can check it by opening the CalcCore project you created in chapter 1;
the project file name is CalcCore.csproj. The property $ (MSBuildToolsPath) points to

the default MSBuild installation folder. Effectively, you're inserting the contents of the
file C:\Windows\Microsoft.NET\Framework\[version number]\Microsoft.CSharp.targets
into your project file. This file defines the standard targets in the compilation pro-
cesses of C# projects. A similar file for Visual Basic resides in the same directory. Both
of them import Microsoft.Common.targets that defines the common tasks for vari-

ous project types.

The project files are ordinary MSBuild scripts, and it's possible to override and
redefine the targets. You have to remember one rule: the target definition that’s
closer to your MSBuild script counts. So if you override the BeforeBuild or After-

Build target in your file, MSBuild will take this definition and not the definition with

the same name from an imported target file. BeforeBuild and AfterBuild are visible

in every project file C. They’re commented out, and all you have to do is to uncom-
ment and define them to extend your build process.

Let’s implement one of them to start the executable after the build. You can easily
do so like this:

<Target Name="AfterBuild">
<Exec Command="bin\$ (Configuration)\WinCalc.exe"></Exec>
</Target>

Similar functionality is offered with the pre-build and post-build events. These are
legacy events from pre—Visual Studio times. They’re simple command-line commands
that are executed line by line. You can use macros with them; these so-called macros
are nothing more than MSBuild properties translated to strings by execution. These
events are available in project properties in Visual Studio and are saved in the

project file as PreBuildEvent and PostBuildEvent targets. To see the windows

shown in figure 3.9, right-click the project file in Solution Explorer, choose Project
Properties, click the Build Events tab, click the Pre- or Post-Build button, and click
the Macros.
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Figure 3.9 Using pre- and post-build events, you can add simple command-line commands enriched with

MSBuild variables.

MSBuild integrates with Visual Studio solution files, but the integration looks different
than it does with project files. MSBuild knows how to execute the solution files, as

you’ll see next.

Examining the solution file

Unfortunately, Visual Studio solution files (*.sIn) aren’t MSBuild projects. But MSBuild
knows how to talk to them. Using a task calledvsBuild, you can execute an MSBuild proj-

ect from another MSBuild script. The MSBuild task has one neat feature: it can execute

the Visual Studio solution file, which is the same thing Visual Studio does. Let’s try it.

You can use the leasing calculator from
chapter 1 as a test field. Your goal is to compile
the solution without using Visual Studio. To do
that, you'll need an MSBuild script. The easiest
approach is to place it in the same folder as the
solution file and make it a solution item (see
figure 3.10). The Solution Items folder in Solu-
tion Explorer is created if you add any file
directly to the solution. Create a text file, and
name it build.proj. It helps to name the build
scripts the same way in every solution (you'll
learn why in the next section).

Solution Exploser *0 X

o
3 Solutson “WindowsCalculatar' (2 progects)
& [ Schution Iterns
| Build.proj
2 CalcCore
. WinCale

Figure 3.10 Custom build script as a
solution item in Solution Explorer
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To perform clean and rebuild operations on the solution, you must provide the
Targets attribute to the MSBuild task. The targets are analogous to the action that
Visual Studio performs when you choose Clean Solution and Rebuild Solution
from the solution’s context menu in Solution Explorer. The other attribute is the
name of the solution file on which the MSBuild project file is to perform the targets.
Here’s the code:

<Project DefaultTargets="Build"

xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<Target Name="Build">
<MSBuild Targets="Clean;Rebuild" Projects="WindowsCalculator.sln" />
</Target>
</Project>
Save this file and reopen it to make Visual Studio realize that it’'s an MSBuild script and

turn on IntelliSense and code coloring.

3.83.3 Starting an MSBuild script with Visual Studio
During the course of setting up a Cl process, you'll work extensively with MSBuild. So
it’'s a good idea to integrate it more closely with Visual Studio. It would be handy to be
able to execute the script directly from Visual Studio. To do so, you can set MSBuild as
an external tool. In Visual Studio, choose Tools > External Tools, click Add, and name
the tool MSBuild. Complete the definition as shown in figure 3.11 and outlined in

table 3.2.
Vit "
External Toaks =
Menu contents:
[ Craate &GUID l Add
Detfuscator Sefoware Senvices Delete
Emor LooBtkup )
ATL/MFC BiTrace Tool
S‘P’r'&' +
l Move Up
Move Down
Tithe: #SBuild
Command: sresaft MET Framewarkiod 0. 2050605 Buildexe 7
Argumnents: §(SobutionDirl build. proj (»] Figure 3.11
e - - — Setting a new external tool in
Al ke onr: $(SohutionDir) 1 k l Visual Studio. The name will
: appear in the Tools menu. The
| Use Qutput window | Prompt for arguments command will be executed
Treat cadput a2 Unicode Close an et using the arguments provided
) ’ : in the Initial Directory field,
oK ] Cancel | Apply | and the output will be sent to
the Output window.
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Table 3.2 MSBuild external tool definition in Visual Studio

Setting name (as in figure 3.11) Value

Title MSBuild

Command C:\Windows\Microsoft.NET\Framework\[version number]\
MSBuild.exe

Arguments $(SolutionDir)build.proj

Initial directory $(SolutionDir)

Use Output window Checked

Treat output as Unicode Unchecked

Prompt for arguments Unchecked

After you define the new external tool, an MSBuild item appears on the Tools menu.
Click it, and look at the Output window. The script build.proj is executed. As you can
see, the convention of always naming build projects the same way is necessary here:
otherwise, you have to define the external tool for every project file name. The output
of the MSBuild script is visible in Visual Studio, as shown in figure 3.12.

Visual Studio and MSBuild integration are a great productivity boost. A similar situ-
ation exists with MSBuild extensibility; it’s easy to write your own custom tasks.

Extending MSBuild by writing and using custom tasks
Extending MSBuild is easy. To write your own tasks, you need to implement the Micro-
soft.Build.Framework.I Task interface or inherit from Microsoft.Build.Utilities. Task.

The second solution is easier: all you have to do is override the Execute method. Let’s
use it to do something useful.

Output * B
Show cutput frame | M5Buikd R S e - BT |
skipaling target “cencraleTargelrraseworionikerattribube™ Because all sutget Files are up-to-date with respect to tr
CoraComp]le:

CiuindowsMicrosoft .RET\ Freamework v, 8. 21886 0o . axe fnoconfig /nowirnzl?el, 1782 /nostdliks férrorrepart:proept #
copyFilesTadut putDirectory:
Copying file from “obj'\Detup\CoalcCore.dll® to “bin\Debugh\CalcCore.dil=.
caloCore -» C:\DeviiindowsCaloulator\Framewori\CaloCore\biniDebugicalcfore.dll
Copying file from “ob]\bebug\CalcCore.pdb™ to “bin\OebughCalcCoro . pdl™.
Gomt Building Project “C:\DevidindowsCalculater'Frasework'\CaleCortiCaledore. csprof™ (Rebulld tarpet(s)).
pors Building Project “CoipeviMindewsCalculatoriWisdowsCaloulator sIn™ (Clean;rebulld target(s)).
pore Building Project “CoiDeviindowsCalculatoribulild.prof”™ (default targets).

Bulld swcceeded,
& Werningis}
@ Erroris)

Time Dlapsed s, 52

" 3

Figure 3.12 Custom build script output in the Output window in Visual studio
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Major version Build
Bsgembly: RssemblyVersion{"12Z.34.567.8%0")]

Figure 3.13

/,.L'I I—k Assembly versioning in .NET. You can use

* to let the system auto-manage your
Minor version Revision  build and revision numbers.

Let’s assume you want to associate the assembly version number with the Subversion
(SVN) revision number. For some compelling reason, you decide that the revision part
of the assembly version should be the current SVN revision number. For example, you
want your Cl process to update the version number every time it builds.

The assembly version is kept in the assembly: AssemblyVersion attribute in
Assemblylnfo.cs. This file resides in the Properties folder in every project. Figure 3.13
shows how .NET Framework versioning works.

The revision number is easily readable with SvnInfo, a new MSBuild Community
Task. It uses the SVN command-line client to read information about a given SVN path.
So in addition to the MSBuild Community Tasks in your tools folder, you need the SVN
client executable (available from http://subversion.tigris.org/).

Another MSBuild Community Task can help you easily update the Assemblylnfo.cs
file with the new version number, including the revision number. Keep in mind that
the version numbers have a maximum value of 65535.

One additional thing you want to do is archive the output in a zip file named after
the version number. You can write your own MSBuild task to read this number directly
from Assemblylnfo.cs.

3.4.1 Implementing a custom task
It’s time to implement your custom task. Follow these steps:

1 Create a new solution named CustomBuildExtensions.

2 Add a new class library project named BuildTasks.MSBuildTasks. If you can
go without the newest C# features, it's best to create the task in .NET Frame-
work 2.0; this way, you can use it in every MSBuild version.

3 Add references to Microsoft.Build.Framework.dll and Microsoft.Build.Utilities.dlI.

¢ Add a new class to the BuildTasks.MSBuildTasks project, and name it Assembly-
InfoReader.cs. Here’s the code.

Listing 3.6 MSBuild task to read the assembly version from Assemblylnfo file

namespace Calc.MSBuildTasks
{
using System.IO;
using System.Text.RegularExpressions;

public class AssemblyInfoReader : B Inherits
Microsoft.Build.Utilities.Task , base task
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private string path;
private string property;

private string value;

[Microsoft.Build.Framework.Required]
public string Path
{
get { return path; }
set { path = value; }
}

[Microsoft.Build.Framework.Required]
public string Property
{
get { return property; }
set { property = value; }

}

[Microsoft.Build.Framework.Output]
public string Value
{
get { return this.value; }
set { this.value = value; }

}

public override bool Execute ()

{

Regex regex = new

Regex (@"*\ [assembly:.+?" + Property + ".+2$",

RegexOptions.Multiline);
value = string.Empty;

try
{

Match match = regex.Match(File.ReadAllText (path));

if (match.Success)

{
value = match.Value.Substring(

match.Value.IndexOf ("\"") + 1,

match.Value.LastIndexOf ("\"")

match.Value.IndexOf ("\"") - 1);

return true;

}
catch
{
// Ignore
}

return false;

}

Lo

Lo

L

L

Contains path to
Assemblyl nfo file

Contains property
to be read

Output
property

Does actual
work

To implement your own functionality and be able to use it in an MSBuild script, you

must inherit the Microsoft.Build.Utilities.Task class B. It has everything you
need. The only thing you have to do is to override the Execute() method F. This
method does the actual job and returns true if it succeeds or false if it fails. It uses
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custom properties that you can define, for example, to pass data in to the task. In the
required property Path C, you must set the path to the Assemblylnfo file. The other
required property is Property D, which contains the attribute to be read. The output
is set in the value E property. The reading in the Execute () method is done with a
mix of regular expressions and hack-and-slash string manipulation.

Another thing you can do here is synchronize the version number among all the
assemblies in the project. Doing so may be a good idea if you always release the files
simultaneously and you want to have the version synced over the release. You do this by
creating a common assembly info file and adding it as a link in each project of the solu-
tion. The assembly info file must still be updated, but you can add that as a task in the
build script. We leave the implementation of this as an exercise for you to complete.

Now, let’s use your new task to do something useful.

Putting it all together
Your custom task is ready, so let’s implement versioning using MSBuild and Subver-
sion. To use your task, you have to put the compiled version in the tools directory of
your framework. This is the project you intend to share with other projects. This way,
the new MSBuild task is available in all the projects that are using it.

Do the same with the SVN client you downloaded. You should end up with the
directory structure shown in figure 3.14.

o "

C:ADay

- . .
OO

Framework

\— tools

— hSBuildCommunityTasks

/1 My MABUild Extensions

5vn

— POO1Win Figure 3.14

The project directory structure with a
reusable Framework/tools folder that
contains MSBuild Community Tasks,
your own tasks, and the SVN client.

build.proj
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You'll version your leasing calculator. Go to the build.proj script you created in sec-
tion 3.3.2, and extend it as follows.

Listing 3.7 Project versioning with Subversion and a custom MSBuild task

<Project DefaultTargets="Build;Deploy;"
xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<MSBuildCommunityTaskPath>
$ (MSBuildProjectDirectory) \Framework\tools\MSBuildCommunityTasks
</MSBuildCommunityTasksPath>
<RevisionNumber Condition=" '$ (RevisionNumber)' == '"' ">
X
</RevisionNumber>
<Configuration Condition=" '$(Configuration)' == "' ">
Debug
</Configuration>
</PropertyGroup>
<Import Project="Framework\tools\MSBuildCommunityTasks

\MSBuild.Community.Tasks.Targets"/>
<UsingTask AssemblyFile="Framework\tools\MyMSBuildExtensions

\BuildTasks.MSBuildTasks.dll"
TaskName="BuildTasks.MSBuildTasks.AssemblyInfoReader">

. Maps task to
</UsingTask> - .
<S/etupszurceFiles Include="WinCalc\bin\ Implementlng
assembly
$ (Configuration) \WinCalc.exe" />
</ItemGroup>
<Target Name="Build">
<SvnInfo RepositoryPath=
"https://HYMIE/svn/WindowsCalculator/trunk"
Username="[user]" Password="[password]"
ToolPath="Framework\tools\svn">
<Output TaskParameter="Revision" C Reads SVN
PropertyName="RevisionNumber" /> <]_[ revision number
</SvnInfo>
<Filelpdate Files=" WinCalc\Properties\AssemblyInfo.cs" D Uses regex to
Regex="(\d+) \. (\d+) \. (\d+)\. (\d+) " QJ :gggl:fbly info
ReplacementText="$1.5$2.$3.$ (RevisionNumber)" />

<MSBuild Targets="Clean;Rebuild" Projects="WindowsCalculator.sln" />
</Target>
<Target Name="Deploy">

<AssemblyInfoReader

Path=" WinCalc\Properties\AssemblyInfo.cs" E Custom task

Property="AssemblyVersion"> reads assem bly
<Output TaskParameter="Value" ItemName="Version" /> version

</AssemblyInfoReader>

<Zip Files="Q (SetupSourceFiles)"
ZipFileName="WindowsCalculator.% (Version.Identity) .zip"
Flatten="true" ContinueOnError="false" />

<Copy SourceFiles="WindowsCalculator.% (Version.Identity).zip"

DestinationFolder="c:\Dev\Release" />
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<Delete Files="WindowsCalculator.% (Version.Identity).zip"/>

</Target>
</Project>
You extend the default build for the Windows calculator project and add the deploy
target. You import the MSBuild Community Tasks using the predefined targets file.
And you tell MSBuild that the task AssemblyInfoReference defined in TaskName that
you intend to use is implemented in the assembly defined in the AssemblyFile attri-
bute B. Then you extend the build target. You read the SVN revision number Cfirst,
using the SvnInfo Community Task. The revision number is saved in the $ (Revision-
Number) property. Next, you use the FileUpdate Community Task D to update
Assemblylnfo.cs with the new version number. After that, you perform the build on
the solution. When the build target is ready, MSBuild fires the Deploy target. Using
your custom task, you read the version number into the $(Version) property E.
Using the property metadata % (Version.Identity), you create a zip file. The archive
is copied into the release directory and deleted.

You’ve put everything together. The script you wrote is ready to be used as a part of

a Cl process.

Summary

Build automation is an essential part of the Cl process, because Cl occurs behind the
scenes. You need an automated process that will perform the entire build every time
it’s needed.

Ideally, the automation process is scriptable. Changes can be made manually, or
automatically with a tool like Visual Studio. You should be able to define various exe-
cution paths. Using conditions and parameterization, you should be able to perform
various types of builds according to the situation. And your build process should be
easily extensible.

Many tools deal with the build automation. Right now, MSBuild seems to be the
best choice for .NET developers using Windows and Visual Studio; it’s integrated with
.NET Framework and used in the Ul. But there are alternatives, such as NAnt. The
choice is yours.

In the next chapter, we’ll look at ways to bend the build process a little. You'll con-
nect the end with the beginning and add some continuity to this process. To do so,
you need a Cl server.
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This chapter covers

Cl server basics
Choosing the right CI server

Setting up CruiseControl.NET, TeamCity, and
TFS Team Build

Discussing build triggers

Checking some extended capabilities of
Cl servers

In chapters 2 and 3, you gathered everything you need to perform full integration
in a single repository. You now know how to build everything automatically. You're
fully prepared for continuous integration (Cl). You have all the bits and pieces to
set up a fully automated process that eventually will build, test, deploy, and analyze
an application to help ensure it functions correctly, follows best practices, and is
deployable by the customer. It’ll be a process that runs with each source code
change and provides immediate feedback to the development team. To accomplish
this, you need a Cl server.

In this chapter, we’ll give you an overview of what’s on the market today. We'll
look at the Microsoft flagship in this area: Team Foundation Server (TFS) 2010.
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We'll also pay close attention to two leaders in the alternative .NET tooling list: Cruise-
Control.NET and JetBrains TeamCity. But first, let’s consider how far we are from a
full-blown Cl process.

A quick review of the Cl process

Thus far, we've presented a sample application—a financial calculator—that you’ll

put under Cl. It’s been stored in the source code repository. You can get everything
you need to build your software from the repository and then, with a single command,
build it. Both actions are on a one-off basis. But you have to add continuity to the pro-
cess and make the actions occur in a constant loop. They need to run continuously,
preferably after every commit to the source control repository.

Right now, your process is a little flat. When something new happens, you start
your build, it does all the things it was designed to do, and then it stops. The status
quo is back in force until a software developer makes the next move (see figure 4.1).

The goal of this chapter is to introduce another player: a production-ready Cl
server that will work for you. The software developer works as shown in figure 4.1, but
the new player gets more responsibility. Even if the software developer forgets to pull
the “lever” to make a build and to check if everything is correct, the Cl server never
forgets, as shown in figure 4.2.

There are various ways to accomplish this manual build. First, you can try to build
the system manually: you act as a Cl server; you are the build master. You can perform
a build once a day or after every check-in (for example, by using a physical item/
token to show who has control, as we’ll discuss later in the chapter). Think of hand-
crafting a shell script similar to the example provided in chapter 1. You can try to write

Source control

Build tool system

I
Software developer

| Lever |

Complete |
| Push

I::I | -

|
|
| T
|
|

Figure 4.1 Until now, you've been able to push the lever and get the build
done. If the application builds correctly, you can push your code into the source
control system on a one-off basis. You get to do it all over again when you
implement the next feature.
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Figure 4.2 The CI server in action. It checks whether anything new is on the source
control server. If so, it pulls the code and uses the lever to start the build. The whole
process is enclosed in an infinite loop. Whenever the software developer pushes anything
into the source control repository, sooner or later it's integrated.

your own task-loop software to mimic the Cl server and extend it to a full-blown tool.
Or you can use one of the ready-to-use tools on the market. In this chapter, we’'ll try to
find the best way.

Choosing the right Cl server isn’t an easy task. You have to deal with both the hard-
ware and software aspects. On the hardware side, you have to determine whether you
have a separate physical machine on which to build your Cl server. Is it a full-blown
server with 99.9% uptime or only an old machine standing in the corner of your devel-
opers’ room? If you don’t have a physical machine, can you get a virtualized server
running somewhere that every team member can access? If you’re setting up a non-
productive Cl process, just to check things out, it’s all right to install it on your devel-
opment machine, but that most likely isn’'t a production setup.

It’s strongly suggested that you dedicate a separate machine to act as the Cl server.
Why? Because a correctly created Cl process should have as few dependencies as possi-
ble. This means your machine should be as vanilla as possible. For a .NET setup, it’s
best to have only the operating system, the .NET framework, and probably the source
control client. Some Cl servers also need |1S or SharePoint Services to extend their
functionality. We recommend that you not install any additional applications on the
build server unless they’re taking part in the build process.

Another reason to use a dedicated continuous build machine is that you can keep
it clear of any configuration changes you normally do on a development machine or
on a machine that’s used for something else. This way, you’re free from any assump-
tions about the installed software or machine configuration. You can be sure your
vanilla machine stays vanilla—no toppings, no icing, nothing spoiling the vanilla taste.
In other words, a machine brought to a known state every time the builds occur.
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As for hardware, as usual, more is better. Your build should be as fast as possible.
Every team member, after putting a new feature in the source control system, should
wait for the Cl build to finish and check it to be sure everything worked as expected.
You don’t want to keep developers from their work for too long. In the long run, a fast
CPU and a fast hard drive are cheaper than your developers’ time.

When you have a dedicated integration machine ready to host your Cl server, you
can figure out which server is right for you.

Examining the CI server possibilities

Before Cl, a build master or release engineer had a build machine and integrated
your software there. They received the code from the team and created working soft-
ware, ready for shipment. They did the same set of repetitive steps over and over
again. The work was boring, it was error prone, and it took a lot of time. The release
build was made infrequently. Often, it led to integration problems.

Then someone came up with the idea of a manual integration build. With a build
script in place, you can require developers to personally integrate new features or user
stories into working software.

But someone else thought about changing the adjective to create automated inte-
gration builds. One thought led to another, and the Cl server emerged. Let’s try to
walk this path—maybe it’ll lead to the correct decision about how to establish your
own Cl server.

Manual integration build or your own Cl server?
How about your own build server? Look at figure 4.3, which shows an ordinary build
run as a simple directed graph.

Think about what it takes for the build process to run continuously. Perhaps
you can squeeze or bend it a little, connecting the end with the beginning as shown
in figure 4.4. With our warm apologies to all the math purists out there, you get a
task loop.

The main reason to apply manual integration to builds is to prevent broken builds.
The manual build technique is losing importance with the newest Cl servers. All devel-
opers have to manually run the build and integrate the software before they check the
software in to the repository. This task should be done in an environment as close to
the customer’s as possible. Running a manual integration build often involves using a
physical marker (often a toy) to mark the developer who is currently holding up the

Figure 4.3 An ordinary build run. You clean the construction site, compile, test,
and deploy. What can make this graph bend and become a task loop?
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build or the person who checked in code
that doesn’t compile or fails tests, thus creat-
ing a broken build. Basically, it relies on
starting the same build script in the integra-
tion environment that the software develop-
ers start on their machines to check if
everything is still working. ‘
If you apply this process, you can be sure
that no code that can break the build gets
into the repository. This technique can com-
plement a normal Cl server. Some modern
Cl servers can perform this kind of task out
of the box. For example, TeamCity lets no
code touch the source control repository
without a prior integration build. But if you

Figure 4.4 A directed graph that bends and
closes in a task loop. It's almost a homemade
Cl server diagram.

choose a server that doesn’t have this fea-

ture, a manual integration build must be made by humans. And humans tend to
neglect, forget, and make mistakes.

This approach has one fault: if nothing changes, you're building the same soft-
ware over and over again. It’s a pure waste of energy. How about adding one substan-
tial element, something that’ll periodically poll the changes from the repository? If
nothing interesting has changed, the process waits. If not, it performs the build (see
figure 4.5).

Scripting this scenario or writing a small program to do it shouldn’t be too hard.
You did it in chapter 1 using a command-line script. But the question is, do you have
the time to do it? You won’t do that in this book; but if you want to play, go ahead and
write your own Cl server. It’ll take you a long time to get to the stage where the pro-
duction-ready Cl servers are right now. They’ve evolved over the years into feature-
rich applications.
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4.2.2 C(Cl servers for .NET

If you decided not to write your own Cl server, you made the right decision. But now
you have to decide which server to use. You have a lot of options to choose from. Sev-
eral Cl servers are on the market, and if you want to choose wisely, you must consider
many aspects, such as the following:

+  How much money do you have to spend?

+ Do you want to pay the angle-bracket tax (write a lot of XML)?

+ Does it support the other tools you need?

+ How good are the documentation and support?

+ Does it do what you want it to do?

+ Does it do more than you need, not just now but into the future?
+ Isit easy to use?

+ lIsit cool and hip?

Before we go into details, let’s take a broader look at the tools available.

Programs and scripts that performed a task similar to a Cl server existed for a long
time. For example, they were used in the Linux community for kernel development
(see http://test.kernel.org/tko/). But the era of Cl servers started with CruiseControl
in 2000 or 2001. It’s a tool from ThoughtWorks, and it emerged about the same time
as the first article about Cl from Martin Fowler, who works at ThoughtWorks. Cruise-
Control is a Java-based tool for performing continuous builds. It’s widely adopted
mainly in the Java community. It has a pluggable architecture and supports a wide
range of source control systems. The build for CruiseControl is usually made using
Ant as the build tool.

The first Cl server aimed at the .NET community was CruiseControl.NET (CCNet).
It’'s a form of the old CruiseControl made by ThoughtWorks, and it’s been on the
market since 2003. It has everything the older brother has, and it’s written in .NET. It
works as a Windows service and has a web dashboard to present the current state.

It can remotely manage the process using a system tray program called CCTray. Just
like CruiseControl, CCNet is open source.

CCNet was for years the automated integration server of choice for .NET teams that
didn’t have enough resources for commercial products, especially for Microsoft Team
Foundation Server (TFS). As we mentioned in chapter 2, TFS is a suite of tools that
supports collaborative software development. One of its features is the ability to per-
form CI builds.

Somewhere in between the totally free model of CCNet and the rather expensive
model of TFS is another important player in the .NET Cl server market: TeamCity from
JetBrains, which was first released in 2006. The licensing scenario for TeamCity is a
hybrid between free and propriety. You can start small without paying a penny for the
Professional Edition license; but if you grow, and your needs expand, then you’ll have
to pay for the license. It’s written in Java, is easy to set up, and has a few features that
make it interesting to look at.
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These three tools aren’t all the Cl servers you can use in .NET. You can also con-
sider adopting Hudson, Bamboo, Electric Cloud, Anthill, or one of many others. A
detailed Cl feature matrix is available at ThoughtWorks’ wiki page (http://confluence.
public.thoughtworks.org/display/ CC/Cl + Feature+ Matrix). We'll look at these three
players from our point of view.

Earlier in this section, we listed some aspects to consider when choosing a Cl
server. Table 4.1 compares our three server choices on those aspects.

Table 4.1 Cl server matrix that compares the features of three Cl servers
Aspect CruiseControl.NET TFS 2010 TeamCity
Cost yes somewhat somewhat
XML no yes yes
Tools support yes somewhat yes
Documentation yes yes yes
Cl functionality yes yes yes
Additional features no yes yes
Easy to use no somewhat yes
Cool (subjective) somewhat somewhat yes

When we were planning this book, we initially discussed going with CCNet. Our original
goal was to provide you with all the information you needed to get up and running with
no or little cost. We soon found that TeamCity was gaining a lot of interest from .NET
developers, so we added it, knowing there would eventually be some cost to you. At that
time, TFS was costly, so we ruled it out. But when Microsoft announced that TFS 2010
would be available at no extra cost to everyone with an MSDN Professional subscription
or above, we knew it had to be included. We could have discussed other Cl servers, but
at some point, it would have been too many, and the book would have lost focus. We
feel that with the Cl servers we've selected, we meet our goal of no or little cost.
Now, let’s start digging in to each server, beginning with CCNet.

Continuous integration with CruiseControl. NET
CruiseControl.NET is a Cl server that is established in the .NET community. On the one
hand, it's widely adopted and used with success in the production environment; but
you have to pay a so called angle-bracket tax for using it. This is a loose term for the addi-
tional costs that are generated if you have to fight your way manually through the con-
figuration, which is held in XML format (hence an angle-bracket tax).

With CCNet, you get the software for free, but you must deal with the configuration
yourself. But on the other hand, if you're doing the configuration, nothing is hidden
from you behind a wizard or Ul.


http://confluence.public.thoughtworks.org/display/CC/CI+Feature+Matrix
http://confluence.public.thoughtworks.org/display/CC/CI+Feature+Matrix
http://confluence.public.thoughtworks.org/display/CC/CI+Feature+Matrix
http://confluence.public.thoughtworks.org/display/CC/CI+Feature+Matrix
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You need a thorough understanding of what you’re doing in order to do the con-
figuration correctly. Let’s set up a CCNet server to continuously integrate your project.

Starting with CCNet

You can get the last version of CCNet from the ThoughtWorks website (http://ccnet.
thoughtworks.com). Get the setup installation file, and start it on your Cl machine.
The installation is easy. As shown in figure 4.6, you have to decide what components
you want to install.

If you have Internet Information Server (11S) installed on the same machine as
CCNet, you can install Web Dashboard on the same machine. It can be also installed
somewhere else. We strongly advise you to have an instance of the Web Dashboard
running somewhere. If you don’t have |IS installed on your server, we strongly recom-
mend that you install it now. Depending on the operating system your server is run-
ning, you'll have to add the Web Server (11S) role in Server Management in Windows
Server 2008 or use the Programs and Features console to turn on I1S. If you get a mes-
sage while installing Web Dashboard to choose an ASP.NET version, choose at least 2.0,
and everything will work fine.

Cl is all about the feedback. You should always know what’s going on. Did the build
fail? Why did it fail? You can obtain that information using the Web Dashboard, and
CCNet would be handicapped without it.

During the installation, you’re asked whether to install CCNet as a Windows service
(see figure 4.7.). CCNet can work standalone or as a Windows service. If you plan to use
CCNet as a production Cl server, it should run as a Windows service. Standalone mode
is helpful while you’re configuring and troubleshooting the server; we'll look at it later
in this chapter. Note that the CCNet Windows service won't be started automatically

£t CruiseControl HET 1.5.0.6230 Setup 1ol
Choose Component £
Choose which feawres of CrussControl MET 1. 5,0.6230 you Thuughmc'rk?

Open Source
want to install,

Chedk the components you want to ingtall and undhedk the components you don't want to
install, Click Mext o continwe.

Select components toinstal: | [v/] CruiseControl MET Server
[+ Web Dashboard
[¥] Examples

Figure 4.6 Selecting the CCNet components you need for your server.
CruiseControl.NET Server is the essential part of the installation. Web Dashboard is
a web page that provides build feedback. And Examples provides configuration
examples.
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Figure 4.7 You can install CCNet as a Windows service and configure I1S to be
ready to serve the Web Dashboard.

after the installation, and you’ll be able to start and stop it every time you want to
switch to standalone mode.

As shown in figure 4.7, the CCNet installer can prepare everything on 11S for the
Web Dashboard. This way, you'll only have to configure your CCNet instance to make
it work.

4.3.2 Configuring CCNet
You can access the CCNet configuration file via the Start menu or edit it directly using,
for example, Notepad, in % Program Files%\CruiseControl.NET\server\ccnet.config if
you installed CCNet in the default location. Immediately after installation, you have an
empty configuration file like this:
<cruisecontrol xmlns:cb="urn:ccnet.config.builder">
<!-- This is your CruiseControl.NET Server Configuration file.

Add your projects below! -->
<l-=
<project name="MyFirstProject" />
——>

</cruisecontrol>

CCNet lets you define multiple projects. In CCNet nomenclature, a project is a separate
unit of works that CCNet performs. Define a project for the financial calculator Frame-
work project as shown here.

Listing 4.1 Project configuration in CCNet

<project name="Framework">
<workingDirectory>c:\CI\Framework\</workingDirectory>
<artifactDirectory>c:\CI\Artifacts.Framework</artifactDirectory>
<webURL>http://localhost/ccnet</webURL>

<triggers> B Defines interval
<intervalTrigger initialSeconds="0" /> 4_‘ lrigger

</triggers>

<sourcecontrol type="svn">
<trunkUrl>https://HYMIE:81/svn/Franework/trunk</trunkUrl> Gets source
<executable>C:\Program Files\Svn\bin\svn.exe</executable> code from
<username>marcin</username> SVN

<password>password</password>
</sourcecontrol>
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<tasks>
<msbuild>
<executable>
C:\Windows\Microsoft .NET\Framework\

v4.0.20506\MSBuild.exe
</executable>

<projectFile>Framework.sln</projectFile> Declares Visual
<buildArgs> Studio project with
default target

/p:Configuration=Release /verbosity:minimal
</buildArgs>
<logger>

C:\[Program Files]\CruiseControl.NET\server\

ThoughtWorks.CruiseControl .MSBuild.dl1l</logger>
</msbuild>

</tasks>
</project>
After defining a name for your project, you must set some important variables, such as
the working directory where the integration will occur. It needs to be a directory solely
for Cl purposes, so you should prepare an empty one—for example, in c:\Cl. CCNet
produces various artifacts while integrating. For example, build logs should be stored
somewhere; you define this location using the artifactDirectory element. If you're
using Web Dashboard, define its webURL.

The minimal configuration that lets you perform Cl consists of three elements.
The first isan intervalTrigger B which specifies that the integration should occur
periodically. This means CCNet will poll the source control system for changes period-
ically and trigger the build only if something new is found in the repository. Using
CCNet, you have to remember that not every change committed to the repository trig-
gers a build. If two commits occur during the wait interval, both of them will be pulled
and integrated after the trigger fires.

The second element you must declare is a sourceControl Ctag. It defines the
place from which CCNet should pull the changes to feed the integration. In this exam-
ple, you're using the SVN server and repository from chapter 2. You need a SVN
command-line client on the machine where CCNet is running (you define the path to
the client in the executable tag). You can get a subversion command-line client at
CollabNet (www.collab.net/downloads/subversion/). If you have concerns about the
user and password to the SVN repository in the project definition, you should keep a
few things in mind. First, in the production environment, the file will reside on a sep-
arate machine: the build server. No one else will have access to it. Second, you should
have a special SVN user for the Cl server with only read rights to the repositories the
user is working on.

The last part you have to define is what CCNet should do. In the tasks element D,
you define a task for CCNet. The MSBuild task starts the solution file.

Before you start CCNet, you can verify your configuration using the Configuration
Validation tool that comes with CCNet; it’s available from the Start menu (look for
CCValidator). After loading your configuration file, it performs the validation as
shown in figure 4.8.
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Figure 4.8 The CCNet Configuration Validation can ease the angle-bracket tax you have to pay using
this Cl server. It lets you check the configuration before you start your server.

When you’re sure you've configured everything, you can start the server. You have two
options. As mentioned earlier, CCNet can work as a Windows service or as a standalone
application. You'll begin with the standalone version. It gives you immediate feedback on
screen and is much better to use in the initial phase than the non-Ul Windows service ver-
sion. After starting your CCNet standalone application, you'll see something like figure 4.9.
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Figure 4.9 CCNet in console mode is best for initial trial-and-error configuration or troubleshooting
your configuration. The CCNet console displays a lot of information about what’s going on, such as
how the integration is going and what the build is saying. It’s great for debugging your CI process.
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If you get everything right, your software should be integrated. You can of course con-
figure the interval trigger to run as often as you want. You can use another type of trig-
ger, too. Let’s look at the possibilities.

4.3.3 Triggering builds
If you provide the interval trigger without any parameters, you get the default 60 sec-
onds between the time the last integration ends and when the next cycle begins. By
default, the build fires only if something changes in the source repository. You can
change the default settings this way:

<intervalTrigger seconds="30" buildCondition="ForceBuild"/>

This causes CCNet to cycle this project every 30 seconds and build every time regard-
less of any changes in the repository.

Let’s consider a more complicated scenario. In chapter 1, you created a small
financial calculator; and in chapter 3, you introduced a build script to integrate it.
One section of the calculator is a shared library that contains the mathematical part.
It’s used in Ul projects: Windows and web clients. The shared project is placed in a
separate Visual Studio solution and can be referenced from various other projects.
What if you want to build projects that are referencing this shared library, and some-
thing changes inside it? You can use another type of trigger: a project trigger, as shown
in the following listing.

Listing 4.2 Triggering one build with another project build

<project name="WindowsCalculator">
<workingDirectory>c:\CI\WindowsCalculator\</workingDirectory>
<artifactDirectory>c:\CI\WindowsCalculator.Artifacts</artifactDirectory>
<webURL>http://localhost/ccnet</webURL>
<triggers>
<intervalTrigger initialSeconds="0" />
<projectTrigger project="Framework">

Project dependency
trigger

<triggerStatus>Success</triggerStatus>
</projectTrigger>
</triggers>
<sourcecontrol type="svn">
<trunkUrl>https://HYMIE:81/svn/WinCalculator/trunk</trunkUrl>
<executable>C:\Program Files\Svn\bin\svn.exe</executable>
<username>marcin</username>
<password>password</password>
</sourcecontrol>
<tasks>
<msbuild>
<executable>
C:\Windows\Microsoft .NET\Framework\
v4.0.20506\MSBuild.exe</executable>
<projectFile>build.proj</projectFile>
<buildArgs>/p:Configuration=Release /verbosity:minimal</buildArgs>
<logger>
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C:\Program Files\CruiseControl.NET\server

\ThoughtWorks.CruiseControl .MSBuild.dll
</logger>
</msbuild>
</tasks>

</project>

You define the WindowsCalculator project in a fashion similar to the Framework proj-
ect, but you extend the trigger repository. You're performing an ordinary Cl build
every 30 seconds and also checking whether a dependent project has completed its
build B. If so, you fire the build for WindowsCalculator as well.

Think of distributing your projects onto more machines. CCNet lets you distrib-
ute projects indirectly. This means you don’t have one centralized server that is man-
aging build processes; you can couple several CCNet instances (we’ll discuss this
more in chapter 12). For example, if the Framework project is built on a separate
machine, you can provide the additional attribute serverUri to the project trigger
like this:

<projectTrigger serverUri="tcp://server:21234/CruiseManager.rem"
project="Core">
<triggerStatus>Success</triggerStatus>
<innerTrigger type="intervalTrigger" seconds="30"/>
</projectTrigger>

This way, one CCNet instance will ask another instance about the Framework build. In
addition, the innerTrigger element lets you define how often it happens. In this case,
it will poll the changes from other CCNet servers every 30 seconds rather than the
default 5 seconds, which may be too often for a distributed scenario.

What if you have a long-running build that you want to perform once a day, possi-
bly at night? For example, you may need to generate documentation from your source
code. This takes a lot of time, and it isn’t necessary to generate the documentation

whenever the source code changes. You can use the schedule trigger to accomplish this.

Let’s define it:
<scheduleTrigger time="03:00" buildCondition="ForceBuild" />

In this case, the build will fire every night at 3:00 a.m.
You can limit the trigger further. Let’s say you want this build to run once a week,
at night, on Sunday. Here you go:

<scheduleTrigger time="03:00" buildCondition="ForceBuild">
<weekDays>
<weekDay>Sunday</weekDay>
</weekDays>
</scheduleTrigger>

Using triggers, you can fairly easily manipulate the build chain. But this chain has an
end: when the build is finished, you have to pass the feedback along. You can do so
with publishers (we’ll talk more about it in the next chapter).

101



102

4.4

4.4.1

CHAPTER4  Choosing the right Cl server

As you can see, there’s a lot to configure with CCNet. You can learn about how your
Cl servers are working by manually configuring CCNet. You have to use the CCNet doc-
umentation extensively to do this such that CCNet works the way you want. And it’ll
take time to learn the configuration basics. If you want get the configuration done
more quickly, we have something suitable: another Cl server. It’s not open source, but
it’s still free. And you won’t have to write a single line of configuration XML to make it
work. Meet TeamCity.

Continuous integration with TeamCity

TeamCity is a Cl server that has been gaining popularity in the .NET community for
the last few years. It’s packed with handy futures that we’'ll discuss in a minute, and it
offers a free version that’s suitable for smaller teams.

The free version of TeamCity lets a group of 20 people work with 20 assorted proj-
ects. There are a few minor restrictions, such as a lack of more sophisticated login sce-
narios using Active Directory. If you need support for more developers or projects,
you must buy a license for about $1,500. Both versions allow you to set a distributed
build grid using build agents (specialized build machines). They let you divide your
builds over several machines. Basically, you install the agent software on various
machines, and TeamCity automatically starts the build on one of the build machines.

TeamCity has a neat feature that lets you forget the manual build technique we dis-
cussed earlier in this chapter. It verifies code compiles and passes unit tests before
committing your source code into the repository. See figure 4.10 to better understand
the difference.

You basically send your changes first to TeamCity and not to your source control
system. TeamCity performs the build, tests whether everything is fine, and then com-
mits the changes to the source control system only if everything works fine.

We hope we have your attention and that you'’re eager to try it for yourself. Let’s
get started with TeamCity!

Running Team City

You can download the TeamCity setup file from the JetBrains website (www.jet-
brains.com/teamcity/). It’s a large file that contains everything you need to build a Cl
process. It asks you to install the core features and build agent (see figure 4.11).

Both the Build Agent and Core Server are installed as separate Windows services
and automatically hooked together. TeamCity comes bundled with its own web
server; all TeamCity configuration and management happen on a web page that’s
hosted on this server. As shown in figure 4.12, you have to choose a port where Team-
City will be available.

You must choose an account under which to run TeamCity (see figure 4.13). Your
choice depends on what you expect to do with the server. Will your build need more
rights than a normal system account? It may be possible if you plan to use network
shares or have other restrictions on the files on the server. If you aren’t sure, run


http://www.jetbrains.com/teamcity
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Software developer

and his shiny
machine
—
Fail
! s
‘ Surcess
|
___________ I —_—— — ——— — —_——— ——— —
TeamCity ]I_
Cl server \

Pre-test commit

Source contral
SYSTEM

Time

L

Figure 4.10 TeamCity’s pre-test commit feature lets you check your build for correctness before
you commit it to the source control repository.

 JetBrains TeamCity Setup

Choose Components
Choase which features of JetBraing TeamCity you want to install,

HEE|

Ched: the components you want bo nstal and undhed: the components yeu don't want o
install, Chck Next to condinue.

Select components 1o nstall: = gent
Core
¥] Windows Service
=1 [+] Server
Core
] windaws Senaoe

Figure 4.11 To run builds with TeamCity, you need to install at least one Build
Agent. You can install more Build Agents on multiple computers to create a
build grid.
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¢ JetBrains TeamCity SetupConfigure TeamCity server pork.

Installation Complete
Setup was completed successfully,

TeamCity server port: si11

Figure 4.12 TeamCity comes with a bundled web server. If you have |1S or any
other application running on a standard HTTP port, you'll have to change the port
for TeamCity.

TE Agent service oplisns M= E
Select Service Account

= Run under SYSTEM account

" Run under user account

Figure 4.13 If you plan to make TeamCity available outside your intranet
environment, don’t make hasty decisions here. Run it with the user who has the
fewest rights needed for normal usage. If you're a local administrator on the
machine, choose the SYSTEM account (you can change it later in the Services
Management Console).

TeamCity under the system account—doing so is safer, because your user account is
probably an administrator on the machine.

Start both the Build Agent and server services. When the installer is finished,
you’re presented with a license agreement and asked to create the first user account
with administrator privileges. TeamCity is then available for normal work. After initial
login, you’re asked to create your first project (see figure 4.14).

To make the project run under TeamCity, you must connect TeamCity to the
source control configuration, define a runner, and make sure your agent is properly
connected. Let’s do that next.

4.4.2 Configuring a project
After you've installed TeamCity, you need to configure your first project. You'll go
through these steps for each project, but some settings may change from one project
to another. Let’s walk through setting up the Framework shard library from your
financial calculator:
1 TeamCity needs to know how you'’ll refer to the project (see figure 4.15). This
doesn’t have to be the same name as the Visual Studio project. In fact, you prob-
ably want to make the name something more understandable, because it’ll be
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Figure 4.14 When TeamCity is ready to work, the first step is to create a new project.

* Create Mew Project

s st Further steps

e irad §latan
e rptian: &r ¥ i fusad B craate & progct e and hea
priged [ eonfigure its VOS5 sattings and

Figure 4.15 TeamCity doesn’t impose an angle-bracket tax for most tasks. The entire configuration
process runs in a comfortable Ul. You're starting with a new project.

used in the feedback mechanism we’ll discuss in chapter 5. Enter the name and
description for the project, and click Create.

2 You need to configure your TeamCity project (see figure 4.16). Give the build
configuration a meaningful name and description. Look at the build-number
format (the example takes the revision number and assigns it to the build).

The build process doesn’t leave any artifacts now, so leave the artifacts paths
empty (you’ll learn about artifacts in the next chapter). Next, you can decide
when to fail a build based on the build exit code, test output, build runner
errors, exceeding the maximum build time, lack of system resources, or an
unexpected crash. You can decide whether TeamCity will try to detect hanging
builds (builds that are running but aren’t doing anything). By enabling the sta-
tus widget, you give external sites the ability to retrieve the build status. The last
thing you can decide is the maximum number of simultaneous builds of this
type to run.

Notice the Configuration Steps at the right in figure 4.16; they help you keep
track of everything you need to do.
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Figure 4.16 General project settings. Pay close attention to the build-number formatter and the fail
conditions. Builds are formatted with the revision number. In this case, you decide to fail if the build
exceeds 10 minutes.

3

When you’ve configured the project’s build options, you must configure the
connection to the version control system (VCS)—in other words, your source
code repository (see figure 4.17). The source root configuration varies depend-
ing on the source control system you’re using. Because you’re using SVN, you
must provide at least the SVN URL, username, and password. You have to decide
whether to use the default configuration directory (you don’t have to change
this if you aren’t doing anything extraordinary). You can choose to pull the
source with all externals (you learned about this in chapter 2). You can leave all
the rest of the settings at their defaults.

The newly created source control root will be added to the project con-
figuration.
You can also decide what checkout mode you want to use (see figure 4.18).
You can do this on the TeamCity server, on the build agent, or not at all if your
build script will pull the changes for itself. SVN lets you check out the files on
the agent, so do it; this will reduce the load on the main TeamCity server. You
can decide where to check out the files or leave it blank for TeamCity to
decide. The build folder can be automatically purged before every build
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Administration » Edit Project > Mew VWS Root

SVN Connection Seftings

VCS Root Name
Enter a unigue name to dstinguish ths VIS root from other roots, If not specfied, a name
wil be generated automabicaly.

Type of VL5

Type of VCS: Iﬁuhwmn j

URL: * [tipcinocathost B gy Framewoitunk
User naine: Imaroin

Password: |unuu-

Default config

¥ Use default config directory
directory:

Configuration directory:  [C\UsersimarcinlAzpData|Roamng|Subversion

Externals support: T Full suppart (Joad changes and checkaut)
' Checkowt, but ignore changes
!"E ]gmrq axternals
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Figure 4.17 Creating a new source control root. You can reuse this configuration in other projects.

Checkout Settings

vis checkout mode: [ Automatically on agent (# supported by VCS rools) x|

Checkout directory: © |

Lemve Blnk ta use defauk chacoout drectory on an agent.
Clean all files before -]
basild:
VCS Labeling
V(S labelfing mode: i) ¥ Do not label
" Successful only
© Atways

Labeling pattern: ]ihphm.bﬂdnumb-nﬁi.
sz 3esystem. build.numberds for bulld nurmber substitution

Choose VICS roots to

[T Shared Trunk
labek

Figure 4.18 Additional source control configuration. Check out on the build agent, choose the

default working directory with cleanup, and don’t use labeling.
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(choose to clean the directory if you aren’t doing anything special). Note that
you can automatically label every build you make. To do that, you have to dive
into additional SVN configuration; in this case, you’ll pull the build lever with-
out labeling.

5 The next step is the build runner configuration. The build runner is a tool that
performs your build. TeamCity comes with a bunch of runners. In this .NET sce-
nario, the MSBuild, NAnt, and Visual Studio Solution runners are handy. Yes,
TeamCity can run the solution projects directly and not only through an
MSBuild script like CCNet. You'll use this feature for the Shared project, as
shown in figure 4.19.

s To make TeamCity automatically trigger the build every time something new is
detected in the source control repository, you have to add a new build trigger.
Choose Add New Trigger, and then select VCS Trigger from the drop-down list.
You see the screen shown in figure 4.20. You can choose the quiet period (a time
after every build during which no builds are triggered—it’s useful in an envi-
ronment with a lot of check-ins and a weak build machine). You can also add
triggering rules (for example, if you want to start the build only if specific files
are changed).

Build Runner
Build runnar: [Visual Studio (sin} =
Micrasalt Visua Stude solutien (5] unner
Zohution file path: ]Fra‘nnwurk.-:l_n ]
specfied path showuld be relative to the checkout drectory
Working directory: * [ ]
Visual Studio; [Microsaft Visual Studio 2010 x|
Targets: |Rabsuild [=]
Enter targats separated by spele or sermecolon. Bulld, Rebailld, Clean, Publsh targets are
Configuration: |Rrelease []
Enter salution configuration to buld. Debug or Releasa are supparted in defauk solution
M. Leave bank bo use delfaul

Platiorm: | =

Figure 4.19 Visual Studio Solution runner configuration. It starts the Rebuild target in the Release
configuration.
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Quiet Period Settings

i

Quiet period mode: # Do not use

7 Use default value (60 seconds)
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Build Trigger Rulas

Trigger rules: ™ L3 Edit Trigger Rules:
= | Hige

& Add new rule

Save Cancel

Figure 4.20 Configuring triggers in TeamCity. You can have triggers that fire
periodically, or fire based on a dependency.

If you've configured everything correctly, your first continuous build with TeamCity is
ready. It should be visible on theuu project overview page (figure 4.21).

We’'ll pay closer attention to the project feedback page in chapter 5. But now, let’s
look at a feature we mentioned earlier. It’'s something that eliminates many broken

Wistrarm, Barcn Kassliseowics Logoet
S res | e ) ]| Bl e ) | | gmncirnion | o comie T | -

Projects O Corhgere Vil Piejects

Collagse & | Exgand Al @ buikd(E) runsing,

Ll W SuUdhRER - ¥ I s 1) - 27 SER 0P LiIL

Figure 4.21 Project overview page with one configured project
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builds, because it compiles and tests the code before allowing the code to be checked
in to the source control repository.

Pre-tested commit

Pre-tested commit is a TeamCity feature that lets you make a dry integration run
before you check your software into the source code repository. What’s important
is that the dry run is performed on the integration server, so it’s a true integration
test that happens before you commit the code rather than after, as with CCNet. To
use this feature, you must install the TeamCity add-in for Visual Studio. You can
find it under the My Settings & Tools option on your local TeamCity web page (see
figure 4.22).

After a successful install, the TeamCity add-in integrates itself with Visual Studio.
Open your Shared project, and look at the new Visual Studio menu item shown in fig-
ure 4.23.

To use the pre-tested commit feature, run it from the TeamCity menu in Visual
Studio. Select TeamCity > Login, and a login dialog box opens. Enter the URL of your
TeamCity server and your TeamCity username and password and click OK.

You’ve now hooked Visual Studio to the TeamCity server. You must also config-
ure the add-in to work with Subversion (see figure 4.24). You need to do this
because the TeamCity add-in handles checking in code for you if the compile and
tests are successful. Enable Subversion support, and point the plug-in to the SVN

R—

My Sellings & Tools

Genernl  Growps Role=  Nakfiostion Rels
General ‘Watched Builds and Hotifications TeamGity Tools
Ersa i Haotifher Edit W el [0S pluge T
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Full padai: Blaing i Hoiw il ik B
Ertad ado sd! i@ eyasleramer ral I Matar Edit
Fesaveand: *

%

et passwrd Rabbvar Modilier

TR
Varsion Control Username Sattings T ! i i Ecioss Fugn.

Betault far B of the ClearCase root Winthuers | ray Hutisr A
: e SyTdCaten Feaw

Cufaukt for &l of the Team rnlllllljl-l.ull i » LIII S‘E'thw

Bar WG o0

Cefauk far ol af the Yeaml SourmeSale o Heghight ey chirges
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Figure 4.22 Under My Settings & Tools, you can find handy TeamCity additions: a plug-in for Visual
Studio and Windows tray notification.
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command-line client that you need to

Data Teol Test | TeamCity | Window Helg
install locally on the machine (the Collab- T ES

Net client we mentioned earlier is per- e J‘El_ A s

fect). Enter the SVN credentials, and ® k.8 Y Lot

decide to detect the working copy auto- WY Moycehenes

matically. Note that in the previous section, ) {2 Locil changes

you connected the TeamCity server to e -8 St

source control, not the TeamCity add-in. @ | Dowmlosd update
When everything is set up to perform a PPy double comsour =

test build, introduce an error somewhere

in your code so you can see what happens Figure 4.23 The TeamCity Visual Studio add-in

adds a new toolbar and menu item to Visual

when a build fails. In Visual Studio, select )
Studio.

TeamCity > Local Changes. The add-in

compares your local files to those in SVN

and shows you which ones have changed (see figure 4.25). These are the files you
need to check in and specifically the ones you need to test.
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Path to Subversion
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Subversion Legin:  marcin

Subversion Password: LT LT
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Folder [ Browse. |

[ OK | | Cancel

Figure 4.24 Enabling Subversion support is essential for pre-tested commit.
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Local Changes _?:'T:

B T =2mEEElEs T
RIEDE2E0(E%E G- Figure 4.25
=[] Default - Subversion sDefaut The TeamCity add-in for Visual Studio

=gid| ] Zi_'F‘ﬂ'Ftu"i"&Ed compares the files already in the source code
= L3 Corelma repository with your local copies. If it detects
o Finance. c= {modifiec
e changes, you can choose them for a dry
integration run.

Choose the changes you want to pre-test, and click the Remote Run icon . The pa
window shown in figure 4.26 opens. Choose whether you want to automatically com-
mit the changes if the dry integration run succeeds, and then click Run to build and
test the code.

After the pre-test is complete, you're presented with the results (see figure 4.27).
Because you purposely had an error in the code, the build and tests failed. But
because you told the add-in to check in code only if successful, the bad code wasn’t
checked in to the source control repository, and other developers on your team and
the Cl process won't get a broken build due to your error.

TeamCity is a good Cl server, no doubt about it. It has a lot of handy features and
comes in a free version suitable for small teams. It’s definitely worth evaluating as a Cl
server of choice. Another server you shouldn’t omit when evaluating Cl solutions for
the .NET world is Microsoft Team Foundation Server.

T& Aun Personal Build with 1 change =2 B| &/

Sarver Bulda

=

s T BB
|#] e Shared
| s Shared

| Predssied Commi Comml if: [I:dd'uaumdu '] Fun [ Cancel

Figure 4.26 You use this pre-tested commit window in Visual Studio to build and test the code
before it's checked in to source control.
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Figure 4.27 The My Changes window shows the results of the last operations. Your pre-tested run
failed because the software didn’t compile. This way, the broken code stays on your machine to be fixed
and never reaches the source control system.

Continuous integration with Team Foundation
Server 2010

Microsoft TFS has been around for some time, but prior to the 2010 release it was
cost-prohibitive to many teams. TFS is much more than a Cl server. It comes with an
integrated source control server, which we discussed in chapter 2. It has extensive
work-item tracing tools, and it integrates with SQL Server to provide rich reporting.
The feature that’s most important for setting up a Cl scenario is TFS Team Build. It
lets you create a full-blown Cl server of your own. It’s a grown-up solution for collab-
orative software development (see figure 4.28).

We're interested in the Cl side of TFS 2010. Setting up a Cl process with it is
straightforward. We're assuming you have the Financial Calculator team project cre-
ated in TFS source control and that you’re connected to it as we described in chap-
ter 2. Now, let’s define the build.

TFS and build controllers

TFS 2010 uses a build controller to manage software building tasks. You can install
everything onto a single server or split the build process across multiple servers.
Build agents are services that can be installed on the same or on separate machines to
distribute building tasks. A build-agent poolis a set of one or more build agents. Fig-
ure 4.29 shows a possible TFS build layout.

TFS assigns a build to a build controller. The builds are queued on a given con-
troller and then taken out of the queue one by one or according to a priority and
sent to a build agent. A build controller checks in its build-agent pool for a suitable
agent to perform the build. After the build is done, the build agent stores the build
artifacts and performs notifications.
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Figure 4.28 TFS Team Build in the TFS landscape. As you can see, the
build server is only part of the architecture.
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TFS 2010 build layout. A
build controller manages a
set of build agents, choosing
the appropriate one to
perform the build.
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4.5.2 Configuring TFS build agents
But first, you need to configure the build agent. You do this on the server side using the
Team Foundation Administration Console, which you can run from the Start menu.
Choose Build Configuration from the tree beneath your server name, and select Con-
figure Installed Feature. Start the configuration wizard, and follow these instructions:
1 Step through the Welcome screen.
2 On the Project Collection screen, browse for the collection you want to config-
ure, and choose Loan Calculator, as shown in figure 4.30.
3 On the Build Services screen you can leave the default number of 1 build agent
to run on the build machine.
4+ On the Settings screen, leave the System Account as a user to run the TFS build,
and don’t change the port (if it’s free on your machine).
5 Review the changes that will be made for you, perform the configuration check,
and observe the configuration process as it’'s working. If everything goes well,
you’re informed about the success on the last wizard screen.

You’re finished on the server. Now, switch back to the client and configure the build.

Team Foandatson Bsild Service Configuratien

&% Build Service Configuration Wizard

Welma Select a Team Project Colection
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G A propict ool ion After compliing This wizhed.
on Figune B ths Tiedn Poundaion Bulkl Service wil be pal ol & i sl ervinonimen] mansged by Lal, you sl nol
pleie Epialy @ T DRt folectan.
21
brfigunng buld services for?
Select a Team Foundotion Server:
2 | Browse,.. I Jear
e B
Team Project Collections: collection” - Build Services:
_;5 DheFautt nlecton b agent{s) nonmng on § madhinels).
.o oot |
w | Comneqt I Cancel
Y isual stud > mevos | mew Review | | Conuel

Figure 4.30 While configuring a TFS build agent, you have to choose the project collection that the
build machine will serve.
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4.5.3 TFSbuild configuration
Before you can add a build to the build queue, you must define it. You can have as
many build definitions as you need. Let’s define a Cl build for the existing Team proj-

ect you created in the last chapter (see figure 4.31).

Choosing the right Cl server

You’re by no means limited to a Cl kind of build process in TFS 2010. For example,
you can have Cl builds, scheduled builds, or others. If you create multiple types of
builds, we advise using some kind of a prefix like Gifor continuous build, s/ for sched-

uled, and so on.

After you give the build a name, you can decide what kind of trigger will be
used to start the build. See figure 4.32 for the two first steps of the Build Defini-

tion Wizard.
You can use five possible build triggers:

+ Manual —This is in fact not a trigger. It tells TFS not to do anything until the

build is submitted manually to the queue.

«  Continuous integration —This trigger follows the Cl principle strictly to build

after every check-in.

« Rolling build —Rolling builds are suitable if your build is taking longer than the
average check-in rate. In other words, if the developers on your team check in
more quickly than the build process, you should choose this type of trigger. It
accumulates the check-ins and triggers the build after the currently running
build finishes. You can also set a rough equivalent of a quiet period, as you saw
earlier when working with TeamCity. You can prevent the build from executing
for a given amount of time, during which check-ins are accumulated. It isn’t the

same, but it can do the trick.
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a3} Caleulator Sample Application
- Woark lterm Templates
1] Wark Rems
Fl ‘_:7 Budds
5 Al
& Teamn 4
& Sourc

View Builds
Queue New Build...
=¥ Mew Build Definition...
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Figure 4.31

Adding a new build definition to a
Team project in Visual Studio 2010
Team Explorer
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Figure 4.32 Visual Studio 2010 guides you through the creation of a build definition. Assign a name
using a convention of some sort that will help you manage a large number of build definitions if you plan

to have them. Also choose a trigger type.

+ QGated check-in —A gated check-in build is a mechanism that prevents bad code
from getting into the source code repository. It compiles the code and runs unit
tests before check-in. Everything must pass, or the check-in isn’t allowed. The
gated check-in is similar to the TeamCity pre-tested commit.

« Schedule —The scheduled trigger lets you organize your builds; for example, you
can do a nightly or weekly build.

In this case, choose a strict Cl build. On the Workspace tab, you can define the work-
ing folder that the build agent will use and the source control folders it will pull from.
Use the defaults unless you have a more complicated source control layout.

On the Build Defaults tab, you choose the Build Controller to be used for this
build and the output drop folder where the build agent will copy the build result and
the log file. This must be a network share, and you must have enough rights to use it.

A little explanation is needed for the Process tab shown in figure 4.33. The build
definition in TFS 2010 is created using XAML and Windows Workflow Foundation. We
won'’t dive into the details in this book; in this case, you'll use the default build tem-
plate. But if you want to make extensive use of TFS 2010, this is a good opportunity to
learn about XAML and Windows Workflow.
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Figure 4.33 When you define a build in TFS, you can use XAML templates. For an ordinary Cl process,
you can use the default template; but if you want to customize this and that, it’s time to get some

Workflow Foundation information (you can start at http://msdn.microsoft.com/en-us/vstudio/

aa718795.aspx).

If you stick with the default template, you have to choose the item to be built from the
source control repository. It can be a solution file if you wish, or it can be an MSBuild
script. Choose Items to Build from the build process parameters (with a small yellow
exclamation mark), and click Add on the Solutions/Projects tab. Navigate to the

WindowsCalculator.slIn file, and choose it. It will be used for the Cl build.

The last tab controls the build retention. You define how long build information

should be kept for a given build’s output.

From now on, your Cl build definition runs on the TFS server. Every time you check
in something, the build will trigger. To watch the build queue, double-click the build
definition in Team Explorer to open the Build Explorer, and choose the Queued tab
(see figure 4.34).

You’ve now defined a Cl build process, and it’s running on TFS. The build process
runs on a build agent and everything is ready for the developers to start work. It’s
time to move to the next step, defining feedback mechanisms, which we’ll look at in

chapter 5.
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Figure 4.34 You can watch the build queue in Build Explorer. The first build is waiting in the queue.

Summary

In this chapter, we've talked about using CruiseControl.NET, TeamCity, and TFS 2010
as your Cl server. There are others to choose from that we haven't discussed. The mar-
ket is now in such a state that there’s no single obvious tool to use. Some of them are
great for small teams and others for enterprise-level development. Some are free; oth-
ers you must pay for. Some are easy to use, and others put an angle-bracket tax on you.
Some are packed with features that solve problems you’re not even aware of.

We’'ll go with a mix of CCNet, TeamCity, and TFS 2010 in the book. We think
they’re a good ground to lay a foundation under your Cl process. CCNet is feature
poor, but it’s completely open source so you can easily poke around to extend it or to
see what’s going on inside. It’s a good choice for a small team if you like to check
things for yourself. TeamCity is free for smaller teams, and it keeps up with the fea-
tures offered by the Microsoft flagship, TFS.

We know we’re throwing a lot of options at you to consider, but you must remem-
ber a few important things when considering these Cl options. Your Cl server
shouldn’t be a build server. It should provide feedback. It should build quickly and
should efficiently give you information whenever the code quality is degrading,
there’s a problem with your codebase, or your tests are failing. In the next chapter,
we’'ll discuss feedback mechanisms.
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This chapter covers

Getting Cl feedback from the server
Getting notifications about the build status
Using CCNet, TeamCity, and TFS
Extending build notifications

Picture this. You’re about to go on a long-awaited vacation. For months you've

planned the best routes for a cross-country trip in your convertible. You've had
your car’s engine tuned and the oil changed, and you bought new tires for the

trip. You should have a smooth drive and a carefree trip. You go to the web for
directions, get a map with a detailed route, and study it carefully. One beautiful
sunny morning you pack your things, jump in the car, and ... blindfold yourself.
Drive carefully!

Do you know what we just described? Your Cl process without a feedback mech-
anism. You seem well prepared. You have your tools ready. You know where you're
heading. You seem to know the route, but you don’t see the road ahead. You can’t
see if you drive off the road, and you don’t know if you’ve made a wrong turn. It will
be difficult to get to your destination. You’re more likely to end up in a ditch or
wrapped around a tree.

120



5.1

Knowing the state of your Cl process

It’s that important to build appropriate controlling mechanisms into your Cl pro-
cess. With continuous feedback, you’'ll get back the results of every build as soon as it’s
finished. A well-designed feedback mechanism should do the following:

+ Give information about any decrease in code quality
+  Be quick

+ Provide information in different formats

+ Point to the specific place that causes deterioration
+  Be accessible to any team member, anytime

You'll probably pack your Cl process with tasks that’ll examine your code in search of
problems. You'll have tests and analysis tasks. They should all be able to produce clear
output reports. The reports should be integrated with each other and be available to
you on demand.

The process of producing feedback documents and presenting them should be
swift. You should be informed about the outcome of the process immediately, so you
can react at once.

It’s sometimes good to diversify the communication routes from your Cl process to
the developer. Some people prefer to use tray icons, some want to have the integra-
tion feedback within the development environment, and others like to use toys with
visual effects. Sometimes it’s advisable to diversify the feedback even more; what if you
want to be informed about a failing build when you aren’t online?

If the build fails, the feedback should be clear about where it failed and why. Infor-
mation about a problem with the build is useless if you can’t see where the problem is
so you can react and clean it up.

In this chapter, we’ll look at various feedback mechanisms provided by the three Cl
servers—CCNet, TeamCity, and Team Foundation Server (TFS)—that we’ve been look-
ing at in this book. The feedback will be provided by web pages, email, and a couple of
surprises that we’ll save for later in the chapter. We'll show you how to provide imme-
diate feedback mechanisms with tray icons or instant-messaging notifications, and
you’ll send an email notification. We'll look at detailed build reports to find out why a
build failed. You’ll make the feedback more visual and send it to developers who are
offline. First, let’s get the build status.

Knowing the state of your Cl process
Generally, the build process (if it's working) can be in one of three distinct states:

+  Working —The build is currently doing something. It shouldn’t take more
than 10 minutes for it to finish its task and transform the state to success
or failure.

 Yet another successful build —This is the desired state of the integration build. The
last integration run was successful. Everything is all right, and everyone can
work uninterrupted.
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+  Failed —The last build was interrupted due to a problem. Immediate action is
needed to fix something and run another build.

You should ensure that every team member has immediate access to the current build
state so that when the build breaks, it can be fixed immediately. One of your goals
should be to have as few broken builds as possible, and those that make their way to
the Cl server should be as loud as possible. The information about broken builds
should jump out at the developer. When a team consists of a few developers working
together on a few projects, the information should be given to every team member. A
broken build should mean

+  No one pulls anything from source control. The source is broken, and no one
should be interested in broken code.

.« Someone should jump in to fix the problem—preferably the person who
caused it, but volunteers are welcome.

+  All the commits to the repository are withheld until the build is fixed. If you
push good code into a spoiled repository, your code may get the smell, too.

In addition to knowing that the build is broken, your team should have easy access to
the information about what caused the problem. It’ll help them identify the issue and
target the effort to fix is as soon as possible.

Software developers should have immediate access to information about what state
the process is in. Various tools provide this information; let’s examine them.

Continuous feedback with CruiseControl. NET
CruiseControl.NET, as you may have guessed, is the most difficult of our three Cl serv-

ers to configure. Build feedback is no exception. The most detailed feedback comes
from the CCNet Web Dashboard.

The CCNet Web Dashboard

If you followed our discussion in chapter 4, you should have the CCNet Web Dash-
board installed. You can reach it by entering its URL into your web browser. Typically,
the URL is something like http://MyServer/ccnet.

The CCNet Web Dashboard (see figure 5.1) is a website that contains information
about the state of your Cl process. You can install it separately and use it to administer
a set of CCNet servers. Web Dashboard works only if the CCNet service or standalone
version is running (otherwise, it displays a message about a refused connection). It
lists all the projects running on various CCNet servers that are configured to be dis-
played in a given Web Dashboard installation. The project definitions come from the
CCNet configuration file that you learned about in chapter 4.

Next to information about the project’s Cl state—such as last build state and date,
build label, status, and activity indication—are buttons that let you force the build on
the server or stop the currently executing integration.
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Figure 5.1 The CruiseControl.NET Web Dashboard lets you administer a set of projects. The projects
can be hosted on different CCNet servers.

CCNet Web Dashboard information is organized as shown in figure 5.2. At the top is
a server farm with all the configured servers connected to the Web Dashboard. You
can switch to the server view, which contains information about a given server. If you
dig further, you get information about the project; and the most narrow view is of a
single build.

Every view is fully configurable and can be extended using plug-ins. You per-
form the configuration using the dashboard.config file (the default installation places
it in the % ProgramFiles%\CruiseControl.
NET\webdashboard directory). This is
another place where you have to pay the
angle-bracket tax: everything is configu-
rable, but you must fight your way through
the XML. ThoughtWorks is moving toward
web-enabled configuration for CCNet, but
the plug-ins aren’t ready yet. Until they
are, you'll have to look at the plug-ins sec-
tion of the CCNet documentation (http://
confluence.public.thoughtworks.org/display/

Serviar

Project

. Fi .2Th Net Web Dash i
CCNET/Web+ Dashboard). The following ‘gure 5.2 The GClet Web Dashboard is
. . . . divided into four views. At the top resides the
listing shows the configuration we're using server farm with all the configured servers, and

in this book. at the bottom is specific build information.


http://confluence.public.thoughtworks.org/display/CCNET/Web+Dashboard
http://confluence.public.thoughtworks.org/display/CCNET/Web+Dashboard
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Listing 5.1 A sample CCNet configuration file

<?xml version="1.0" encoding="utf-8"?>

<dashboard>
<remoteServices>
<servers>
<server name="local"
url="tcp://localhost:21234/CruiseManager.rem"
allowForceBuild="true" allowStartStopBuild="true"
backwardsCompatible="false" /> B Defines
<server name="dotnet3" servers
url="tcp://dotnet3:21234/CruiseManager.ren"
allowForceBuild="true" allowStartStopBuild="true"
backwardsCompatible="true" />
</servers>
</remoteServices>
<plugins>
<farmPlugins>
<farmReportFarmPlugin /> 9 Farm-level
<cctrayDownloadPlugin /> plug-ins
</farmPlugins>
<serverPlugins>
<serverReportServerPlugin /> D Server-level
<serverLogServerPlugin /> 4 plug-ins
</serverPlugins>
<projectPlugins>
<projectReportProjectPlugin />
<viewProjectStatusPlugin /> )
<latestBuildReportProjectPlugin /> F Prolept'level
<viewAllBuildsProjectPlugin /> pluQ-lns
<viewConfigurationProjectPlugin>
</viewConfigurationProjectPlugin>
</projectPlugins>
<buildPlugins>
<pbuildReportBuildPlugin>
<xslFileNames>

<xslFile>xsl\header.xsl</xslFile>
<xslFile>xsl\modifications.xsl</xslFile>
</xslFileNames>
</buildReportBuildPlugin>
<buildLogBuildPlugin />
<xslReportBuildPlugin .
description="FxCop Report" F Bu"d-_level
actionName="FxCopBuildReport" g pluQ'Ins
xslFileName="xsl\FxCopReport.xsl" />
<xslReportBuildPlugin
description="NUnit Details"
actionName="NUnitDetailsBuildReport"
xslFileName="xsl\tests.xsl" />
<xslReportBuildPlugin
description="NUnit Timings"
actionName="NUnitTimingsBuildReport"
xslFileName="xsl\timing.xsl" />
<xslReportBuildPlugin

description="FxCop Report" v
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actionName="FxCopBuildReport" JAN
xslFileName="xsl\FxCopReport.xsl" />
<xslReportBuildPlugin
description="NCover Report"
actionName="NCoverBuildReport"
xslFileName="xsl\NCover.xsl" />
<xslReportBuildPlugin
description="Fitnesse Report" F Bu"djlevel
actionName="FitnesseBuildReport" pluQ'lns
xslFileName="xsl\fitnesse.xsl"/>
<xslReportBuildPlugin
description="MSBuild Report"
actionName="MSBuildBuildReport"
xslFileName="xsl\msbuild.xsl"/>
</buildPlugins>
</plugins>
</dashboard>

This configuration file defines two servers D: 1ocalhost and dotnet3. The Web Dash-

board communicates with them using a remoting endpoint. You can define as many
servers as you like. You separately configure all the view levels for the server farm C,
for the servers themselves D, for the projects E, and for the builds F. This example
sets up several build reports to be included in the Web Dashboard feedback. If you
look closely, you'll see several tools like NUnit, FitNesse, FxCop, and others that we
haven’t discussed yet. Don’t worry about what these tools are and what they do; we’'ll
discuss them in upcoming chapters. Figure 5.3 shows the build-level view at the CCNet

Web Dashboard as configured from listing 5.1.
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Figure 5.3 All the detail levels of CCNet views in action
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When you first install CCNet, none of the build reports from other applications are
included. You need to activate them through the Administrator Dashboard. Before the
first time you use the Web Dashboard, you have to edit the dashboard.config file (you’ll
find it in % ProgramFiles%\CruiseControl.NET\webdashboard) and change the initial

password in the <administrationPlugin> tag. When you're finished, click the link in

the Web Dashboard’s main page, enter the Administrator password, and then enable

the tool reports you want to include in the Web Dashboard report.

As you can see, you can have full control over the CCNet Web Dashboard. You can
write your own plug-ins or obtain plug-ins from the internet. But to have so much con-
trol, you have to pay a small administration cost. The Web Dashboard gives you
detailed information, and you can use CCTray to get a quick snapshot of what’s hap-

pening on your build server.

Getting feedback with CCTray

CCTray is an application that’s installed on each developer’s workstation. You can

download it from the home page of your CCNet Web Dashboard or directly from the
ThoughtWorks website at http://ccnet.thoughtworks.com/. It sits in the Windows

Notification area, commonly called the 7ask Tray. It manifests itself with this icon: cc . .
To configure CCTray, open it (double-click the icon) and choose File > Settings (see

figure 5.4).

You need to configure the noise level here as well. You don’t want to be interrupted
by messages about projects in which you have no interest. Try to keep the noise level as
small as possible. Allow only information that’s necessary to help you react when the
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Figure 5.4 When you double-click CCTray, you access CruiseControl.NET and the CCTray configuration

settings.
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code quality degrades. Choose only the projects you need to see (see figure 5.5). On a
fresh installation, you need to add a new CCNet server. To do so, go to settings (File >
Settings) and click the Build Projects tab. Click the Add button. In the Project window,
click Add Server. The easiest way to connect the CCNet server is over a dashboard: type
the CCNet dashboard URL in the window. Keep in mind that if you're connecting to
the CCNet server from another machine, you must add a firewall exception (port 80
on a standard |1S installation).

CCTray uses a red/green indicator, similar to what you find in unit test tools. A
green tray icon indicates that everything is running fine. A red CCTray icon means ce
you have to act. First, you must know where the problem is. The best way to get this
information is via Web Dashboard. You can reach the CCNet Web Dashboard directly
from CCTray: right-click one of the configured projects, and choose Display Web Page,
as shown in figure 5.6.
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Figure 5.5 Configuring CCTray. One CCTray benefit is the ability to work with more than one
CruiseControl.NET server.
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Figure 5.6 Using CCTray with information about a broken build to display the CCNet Web Dashboard

As you can see, CCTray offers lots of power and information without ever connecting
to the CCNet Web Dashboard. But these aren’t the only ways of providing feedback
with CCNet. Another way is to sending email.

Alternative feedback mechanisms with CCNet
If you're using CruiseControl.NET, you can configure publishers. These publishers run
after the build, gather integration information, and prepare it to be presented to the
user. You define the publishers in the CCNet configuration file (found in % Program-
Files%\CruiseControl.NET\server\ccnet.config—for more information, see chapter 4)
just after the tasks. They run whether the build was successful or not.

By default, CCNet runs an XML Log Publisher to integrate the build output with
Web Dashboard (described later in this chapter). You can override the publisher’s
configuration and use an email publisher, as shown next.

Listing 5.2 Email publisher in CCNet

<publishers> B XML Log
<xmllogger /> <]_[ Publisher
<email from=user@mailserver.pl
mailhost="smtp.mailserver.pl"
mailport="25" Defines email
includeDetails="TRUE" server

mailhostUsername="user"
mailhostPassword="password"
useSSL="FALSE">
<users>
<user name="Marcin" group="everyone"
address="marcin@kawalerowicz.net"/>
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<user name="craig" group="everyone"
address="craig@craigberntson.com"/>
</users>
<groups>
<group name="everyone">
<notifications>
<notificationType>Failed</notificationType>
<notificationType>Fixed</notificationType>
</notifications>
</group>
</groups>
<subjectSettings>
<subject buildResult="Broken" value="${CCNetProject}
broke at ${CCNetBuildDate}
${CCNetBuildTime } , last checkin(s)
by ${CCNetFailureUsers}" />
<subject buildResult="StillBroken"
value="Build is still broken for ${CCNetProject}" />
<subject buildResult="Fixed"
value="Build fixed for ${CCNetProject}" />
</subjectSettings>
</email>

</publishers>

If you'll be using the Web Dashboard, you have to integrate the build output with it.
Because you’re explicitly defining the publishers, you must provide the default XML
Log Publisher before any other publisher in your list D. Then you define the email
publisher C, providing all the necessary information about the mail server you want
to use. After that, you define the users who will be getting the emails and decide what
group they belong to. Depending on the group, you can narrow the information they
receive. You can create a group that gets every email, or you can make a group, as in
this example, that only receives information about failing and fixed builds. You can
even customize the messages’ subject lines.

Many predefined publishers are available for you to use. You can clean up your
construction site before the next integration, generate an RSS feed to be integrated
into the Web Dashboard, send a message to another CCNet instance to start a depen-
dent project, and much more.

Now that you've seen how to get feedback from CCNet, let’s discuss how to get the
same information from TeamCity.

Continuous feedback with TeamCity

TeamCity, like CCNet, provides detailed build information via a website and a tray
application; it also gives you alternate ways to provide feedback. Configuring the
different methods is decidedly easier than in CCNet. Let’s start with TeamCity’s
web features.
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Figure 5.7 The Projects page in TeamCity shows all configured projects.

Team City web feedback
TeamCity build feedback is merged together with project administration. You do both
with a single website that you learned about in chapter 4. All configured projects are
visible on the Projects tab (figure 5.7).

As you can see in figure 5.8, TeamCity allows you
to create projects with various configurations. For
example, you can have a project that builds once as
a Cl process after every source code change and
once as a build runner.

TeamCity provides detailed information about
the build. This information is divided into tabs.

By default, only a few are available: general and

Project

Canfiguratian

Figure 5.8 TeamCity project layout.

detailed build information, change details, and so One project can have a set of
on. If you want to integrate additional information configurations. Every configuration
with the build page, you can configure additional is built according to build triggering.

Every configuration can have
tabs. If you do so on the server level, the tabs are multiple triggers.

available for all projects. The tabs configured on
the project level are visible only in a given project.

For the purpose of presentation, let’s create a (very) hypothetical demand. Let’s
say you want your build script to generate a file containing all the build parameters
listed. To do this, you can use the echo command and redirect the output to a file.

The following listing shows the MSBuild script that uses this echo command to create a
file called msbuildvariables.txt that contains some configuration values ($ (Configu-
ration) and $ (Platform) in this case).

Listing 5.3 Sample TeamCity build script

<Project DefaultTargets="Build"
xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<Configuration

Condition=" '$ (Configuration)' == "' ">
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Debug
</Configuration>
<Platform Condition=" '$(Platform)' == "" ">"Any CPU"</Platform>
</PropertyGroup>
<Target Name="Build">
<MSBuild Targets="Clean;Rebuild"
Projects="WinCalculator.sln" ContinueOnError="false" />
<Exec Command="echo Variables used to in build script: Creates
Configuration= §$(Configuration) Platform= $(Platform)> flle Wlth
msbuildvariables.txt"> variables
</Exec> list
</Target>
</Project>

Add a new tab to the project information page for this file on the server level (see fig-
ure 5.9). The new tab will be visible to all of your projects hosted in TeamCity (pro-
vided the build process creates an artifact called msbuildvariables.txt).

If TeamCity runs the script from listing 5.3, a file named msbuildvariables.txt is
created in the current working directory. This file will be deleted after the build
is finished. That’s of course not what you want—you want to see the list of MSBuild
variables on a tab in TeamCity. You need to tell TeamCity that the text file you're
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Gameral | Report Tabs | Server Logs  Issue Tracker amazonECZ BiallMotifier  Jabber Motifier

Tab Title Basze Path Start Page
Code Coverape COVErage.mp rcke.hikmi it
Javalno jeadac.Ho ricka, ik il

@ Creale new report tab

Edit Raport Tab Satt
rab Title: * [M=Build Varisbles
Base path: * I'-
Refative path from the root of buld's artifacts to an archive or director
contairing e penerated report
Start page: hshﬁdﬂrlahles.txﬂ
Relative path of the start page within the report andhive or directory

Save I Canoel

Figure 5.9 Adding a new tab to the build results at the server level. Every time TeamCity finds the file
msbuildvariables.txt in the current build directory, it will add a tab containing the file’s content.

dekete
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Figure 5.10 Setting an artifact file in the General settings of a project’s configuration in TeamCity
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Figure 5.11 A custom tab on the TeamCity build-report page, containing an artifact text file
with a list of MSBuild variables

generating is an artifact. Artifacts are files that should be stored for future refer-
ence. You can set the artifact files in the General settings of your build configura-
tion (see figure 5.10).

If you set this file as an artifact and configure the tab for the server, as in figure 5.7,
you'll get a build tab as shown in figure 5.11.

Integrating custom reports on the build page is very important to give you the big
picture of the build. TeamCity does a nice job of letting you extend the build-report
pages. Now we need to look at the TeamCity Windows Tray Notifier.

5.83.2 The TeamCity Windows Tray Notifier
If you want to use the TeamCity Windows Tray Notifier, log on to your TeamCity server
and switch to My Settings & Tools (at the top of the page, beneath the Welcome infor-
mation). You'll see the TeamCity Tools pane, as shown in figure 5.12.

Download the Windows Tray Notifier and install it on your development machine.
The installer will prompt you for the URL to your TeamCity server. When you're fin-
ished, you'll see the new icon Z{im your Windows Tray. The
question mark indicates
that you need to configure the notification rule.

TeamCity provides a centralized notification-management site for all feedback
mechanisms. To turn it on, click My Setting and Tools, and switch to the Notification
Rules tab. You can also select it directly from the Tray Notifier. Configure the Windows
Tray Notifier to suit your needs, using the page shown in figure 5.13.

Deciding what kind of notifications to let through is crucial for your reaction time.
Remember that letting too much information through the Tray Notifier will most
likely blunt your attention span. You should let through only as much information as
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Figure 5.12 The notification possibilities in TeamCity are generous. It provides email, IDE plug-ins,

instant messaging, and tray notifications.
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Blame the build breaker

It’s usually not a good idea to watch only changes caused by your actions. Project
health is usually a group effort, and a broken build on the Cl server should concern
everybody. Some teams are going with crazy ideas like having the last person to
cause a broken build wear a funny hat or pay into a piggy bank for a future team
activity!

needed for you to react. You’re obviously not interested in projects you aren’t working
with. It’s a good idea to let only the first failure notification through.

After you configure the TeamCity Windows Tray Notifier, you can use it to get
information about the projects running under TeamCity (see figure 5.14).

This doesn’t end our look at notification with TeamCity. Let’s see how to send
email notifications.

Alternative notifications with Team City

If you've chosen TeamCity as your Cl server, email notification is easy to turn on. Log
in to your TeamCity site, go to My Settings & Tools, switch to the Notification Rules
tab, and add a new email notification. Voila! Email notification for your account is
activated (see figure 5.15).

In TeamCity, you can easily configure other types of information passing. If you
use the Jabber-based communicator, you can make TeamCity send you notification
on Jabber. Figure 5.16 shows a Jabber success message from TeamCity. To get an
instant notification over the Jabber network, you have to assign a Jabber account to
the server. To do this, go to Administration, choose Server Configuration, and switch
to the Jabber Notified tab. TeamCity will send the messages from this account. You

': TeamCity Quick Wiew (hitpzflacalhost8111)

CiDotNet

& CiDotNet CI

1 £ Running
Shared

W) Shared

#10 v Success

Figure 5.14 TeamCity Windows Tray Notifier in action. One project is
currently running while another rests happily in a success state.
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Figure 5.15 TeamCity with configured email notification. You can configure additional notifications just
as easily.
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Figure 5.16 Jabber notification from TeamCity in the Miranda IM communicator.
The TeamCity server uses its Jabber account (teamci) to send you a notification
message.

can provide your account name in the My Setting & Tools section under Notifica-
tion Rules.

As you can see, TeamCity directly supports several alternative notification methods,
and they’re easier to configure than with CCNet. Next, let’s see how to configure TFS
to provide build feedback.

Continuous feedback with Team Foundation Server
As you saw earlier in the chapter, configuring feedback can be easy, as with TeamCity,
or more complicated, as with CCNet. TFS is in the easy-to-configure camp—it’s even
easier than TeamCity.

TFS Basic has a limitation: it doesn’t support alternative feedback methods. If
you're using the full TFS, you’re in luck: it does support them. Let’s start our discus-
sion of TFS feedback by looking at tray notification.
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TFS tray notification
TFS 2010 uses Build Notification, which is installed along with Visual Studio 2010. You
can start it from the Start menu. It resides in the Team Foundation Server Tools sub-
folder. After initial execution, it starts automatically when Windows starts, and displays
this icon: . Pguble-click the icon, and configure Build Notification as shown in fig-
ure 5.17.

From now on, TFS Build Notification will display changes to the chosen build defi-
nitions (see figure 5.18).

rm Build Status ? B

]
| Compileted Build Status | [ options

Budd Name  Build umestamp  Team Project

& Build Notifications Cptions | 2 o]

Select the build definitions to
Type here to filter the list of buwild definitions | o

[ 172 2610 200\ MyCollection [Unreachable)
[£] tfsl\DefauitCollection

Show notifications for builds triggered or queued by:
) Me - marcin

@ Anyone (incheding me)

Shaw natifications when builds ane
[ Queued
] Stared
[#] Finished

Figure 5.17 Choosing which build definitions to watch in TFS Build Notification
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o CiDckhet..., 11)25/2009 ... MyFirstProject
Figure 5.18
TFS Build Notification
L ) showing build results

Tray notification is a convenient way to get information about the state of the integra-

tion. Let’s see how to handle web notification with TFS.

Getting build details from the TFS website

The easiest way to get to the build-details page in TFS is through the Build Notification

feature. Double-click the build you’re interested in, and you’ll get the build report
shown in figure 5.19.

That’s it! TFS provides full build information for your project without any addi-
tional configuration. But what about email notification? It’s also supported by TFS.

Alternative feedback mechanisms with TFS

Unfortunately, TFS 2010 in its Basic configuration, which works with SQL Server
Express, has no reporting services installed. If you’re using this configuration, you
can’t extend the notification functionality. But if you're using any of the more
advanced configurations, you’re good to go.

TFS 2010 is extensible with regard to notification. It uses a notification data-
base to manage notification subscriptions. You can subscribe to a set of events
using, for example, email or a web service. If the event is raised, the subscriber is
notified. You manage subscriptions using the provided APl or a command-line tool
called BisSubscribe. Let’s use the second option to create an email notifier for your
build configuration.
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Figure 5.19 The TFS build report is produced automatically for you. No additional configuration is
necessary.

BisSubscribe.exe is installed along with TFS 2010. You can find it in % Program
Files% \Microsoft Team Foundation Server 2010\ Tools. To subscribe to an event that

notifies you about build completion, issue the following command:

BisSubscribe.exe

/eventType BuildCompletionEvent

/address marcin@kawalerowicz.net
/deliveryType EmailHtml

/collection http://tfsl1:8080/tfs/CiDotNet

This command says that when the build of the CiDotNet collection is completed, TFS
should send an HTML-formatted email to the recipient.

The downside of email notification is that it requires you to be online to receive
the information. What if you want to be woken up during the night to be notified
about a failing build? Why not text the information to your cell phone? And how
about making the notification fun? Let’s extend the notification abilities with some
other interesting options.


mailto:marcin@kawalerowicz.net
http://tfs1:8080/tfs/CiDotNet

5.5

5.5.1

Extending build notifications 139

Extending build notifications
A build notification tells you the results of a build. Did it succeed? Did it fail? And if it
failed, why? And which module caused the failure? Cl servers have a rich notification
repertoire. Windows tray icons, emails, instant messaging, and IDE plug-ins are just
some of the possibilities. It’s a proof for the thesis that build notification is one of the
most important parts of Cl.

It’s so important that some Cl practitioners sacrifice an additional monitor or
even a whole machine to provide constant monitoring for the team. It’s usually
an old computer with an old monitor that stands in a visible place in the develop-
ers’ room or some place where everybody can see it. The sole purpose of this
machine is to provide the team with up-to-date information about the build pro-
cesses. The dashboard page may refresh every few minutes, or special custom soft-
ware may monitor the Cl server. If your team can benefit from something like this,
set it up. Or get geeky and use the following LED message board to provide a broken-
build notification.

Providing feedback via an LED message board

An LED message board is a gadget that comes from a big family of crazy USB toys from
the China Seas area. The one this example uses is a matrix of 7 x 21 LED lights sealed
in a small black plastic casing (sometimes called a human interface device [HID]). If you
aren’t a USB geek, the only thing you have to know is that the HID driver makes it easy
to interact programmatically with a HID-enabled device. If you want to buy one, you
can search for “USB LED message board” from Dream Cheeky.

Let’s write a simple program that checks the state of the builds on a TFS server. If it
finds a broken build, it’ll display a blinking red circle on the LED message board. This
should be hard to miss if the board is in the developers’ room.

First, let’s find out whether the last build in a given build definition was broken.
The following listing shows the details.

Listing 5.4 Sniffing around the last broken build in TFS 2010

NetworkCredential Credentials =

new NetworkCredential ("marcin", "password"); B Connects

TeamFoundationServer tfs = to team
new TeamFoundationServer ("http://tfs1:8080/tfs/CiDotNet", collection
Credentials);

IBuildServer buildServer =

(IBuildServer)tfs.GetService (typeof (IBuildServer));

buildServer.CreateBuildDetailSpec("CiDotNet.Chd.Tfs", team proiect and

"Ci.CiDotNet.Ch4.Tfs"); bu||d deﬁnition
buildDetailSpec.MaxBuildsPerDefinition = 1;

IBuildDetailSpec buildDetailSpec = F Searches for

buildDetailSpec.QueryOrder =
BuildQueryOrder.FinishTimeDescending;
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IBuildQueryResult results = GelS|aSl
buildServer.QueryBuilds (buildDetailSpec); bu“d

if (results.Failures.Length == 0

&& results.Builds.Length == 1)

{
IBuildDetail buildDetail = results.Builds[0];
if (buildDetail.Status == BuildStatus.Failed)
( E Turnson

MyLedNotify () ; 4_1 red ||ghl

}

This example uses the Microsoft.TeamFoundation API to sniff for the latest build out-

put. You use the Microsoft.TeamFoundation, Microsoft.TeamFoundation.Client,

and Microsoft.TeamFoundation.Build.Client namespaces to first connect to the

TFS server and team collection using network credentials b. Then you get the build
server from the TFS instance and query it for a given team project and build definition
C. You take only the last build result D and check its state. If it fails, you turn on the
big red dot E, as shown in the next listing.

Listing 5.5 Using an LED message board to notify you about a broken build

HidDevice[] HidDeviceList;
HidDevice MessageBoard;

B Searches

HidDeviceList = HidDevices.Enumerate (0x1d34, 0x0013); | for device

if (HidDeviceList.Length > 0)
{

MessageBoard = HidDeviceList[0]; C Connects to LED
MessageBoard.Open () ; <]_1 message board

Thread.Sleep (1000);

byte[] Packet0 = new byte[] { 0x00, 0x00, 0x00,
0xff, Oxfe, Oxff, 0xff, Oxfd, 0x7f };
byte[] Packetl = new byte[] { 0x00, 0x00, 0x02,
0££, 0xfb, 0bf, 0xff, 0xf7, 0xdf J; D Specifies light
byte[] Packet2 = new byte[] { 0x00, 0x00, 0x04, Pa"el’n
0xff, 0xfb, Oxbf, 0xff, 0xfd, 0x7f };
byte[] Packet3 = new byte[] { 0x00, 0x00, 0x06,
0xff, Oxfe, 0xff, 0x00, 0x00, 0x00 };

for (int i = 0; 1 < 10; i++)
{

MessageBoard.Write (Packet0); .

nds ligh
MessageBoard.Write (Packetl); E jefds R 9 t
MessageBoard.Write (Packet2); tOedIg:IlII:en

MessageBoard.Write (Packet3);
Thread.Sleep (50);
}

MessageBoard.Close () ;
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NOTE The HID interface isn’t a topic of this book. Suffice to say that this
example uses a generic .NET HID device library from Mike O'Brien (http://
labs.mikeobrien.net/Document.aspx?id= hidlibrary). The library provides a way
to connect and use any HID-enabled device. All you have to do is to get a man-
ual for the interface used in this device. The manufacturer of our LED mes-
sage board is kind enough to provide one when asked.

To connect a HID device, you have to find it b using a unique identifier provided by
the manufacturer. After you find the device, you must connect to it C and wait a while
for the hardware to snap in. Next, you define the big red dot using a report formatted
according to the manufacturer’s interface description D. For now, you'll have to
believe us that the lights form a big red dot on the LED message board. You then send
the light definition to the device E, after which the device will look like the one
shown in figure 5.20. The packets sent to the LED message board light up the device
for only a few milliseconds, so you have to refresh the signal to light it up periodically.
It doesn’t cost much to provide a new way to notify your team about a problem.
Buying a flashing roof light from an emergency vehicle and installing it in the devel-
opers’ room is an even better idea (of course, including the siren!). But because the
Taiwanese LED device is a lot cheaper (around $10 to $20), you can start with it. It’s
that important to react immediately to a broken build.

Figure 5.20 LED message board blinking with a red eye to tell you about a failed build
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What if the blinking lights, emails, and sirens aren’t doing the job? How about some-
thing more intrusive? Send an SMS message to every team member.

Providing feedback via SMS notifications
It’s a little scary idea to send someone an SMS message with a build notification. But
what if you’re on vacation climbing Mount Kilimanjaro, and you want to know if your
team is dealing with the broken build fast enough? No problem. You can take the easy
route and send yourself an SMS message using Skype and an online computer in your
office. Here’s how.

Skype provides a COM library to automate some of its tasks. One of the methods
provided by this APl is SendSms, which you'll use here. This method requires you to
have Skype installed and some money in your Skype account, because unfortunately
SMS isn’t free.

NOTE  You can download the Skype library from https://developer.skype.
com/. Check the Tools and SDK area.

To do the build-state sniffing, you can use a variation of the program shown earlier in
listing 5.4. The hitch is to detect only the change in the state of the build from success-
ful to broken, and then send one SMS message. After such an event, it's a matter of
implementing the following code to send the SMS message:
Skype Skype = new Skype();
if (Skype.Client.IsRunning)
{

Skype.Client.Start ();
}
Skype.SendSms (PhoneNumber, Message);

From now on, you can sleep well, knowing that an SMS message will alert you if some-
thing goes wrong with your build. Isn’t that comforting?

Summary

Access to immediate and accurate information about the state of your build process is
vital to your ClI quality. The faster you get the information about a change in the qual-
ity of your source code, the more quickly you can react to fix the problem. The faster

you fix the problem, the better your team will work. You’ll know where you journey is
taking you and whether your project is starting to veer off the road.

In this chapter, you learned that you should employ a variety of methods to notify
your team about the current build status. The most common technique is a website
that reports detailed integration information.

Using a tray notifier is good for providing quick updates to a developer’s worksta-
tion. At a glance, each team member can know whether a build is broken or things are
running smoothly.


https://developer.skype.com/
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Sometimes it’s useful to send information about the build status to offline team
members. SMS notification may be advisable for mission-critical applications that
should build correctly all the time.

You may also want to explore different notification methods such as lights, mes-
sage boards, RSS feeds, or even messages to team members’ instant messaging and
Skype accounts.

Now that you’ve seen how to get feedback to your team, it’s time to turn our atten-
tion to the last piece of a basic Cl process: unit testing. That’s where we’re heading in
the next chapter.
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integra@ed c

This chapter covers

Unit testing in a Cl environment
Continuously examining test coverage

Test mocking

We'll risk the opinion that without automated testing, Cl would be obsolete,
because Cl’s main strength is that it shows how the changes you introduce into the
code affect the software. The Cl process should be designed to show you immedi-
ately when a change degrades the code quality. What better way to check for that
kind of occurrence than to perform automated testing along with every source
code change?

Automated software testing is a broad term. In this chapter, we’'ll focus on one par-
ticular type of automated testing: unit testing. Unit testing lies somewhere toward
the bottom of the common automated-test chain. We'll get to the rest of the
chain—integration, system, and acceptance testing—in chapter 7. But in this chap-
ter, we'll define what unit tests are and what purpose they serve in the Cl process.
We'll take two popular testing frameworks, NUnit and Microsoft Unit Testing
Framework (MSTest), and incorporate them into the Cl process. Then you'll learn
how to mock things out to speed up your tests.

144
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Unit testing from a bird’s-eye view

Before we jump in to create some unit tests, let’s define the term and look at the
aspects that are important from the Cl perspective. There’s a common misunderstand-
ing about unit tests. They're often associated with automated tests in general, but this
assumption is incorrect. Unit tests are part of automated tests. Figure 6.1 shows the dif-
ference. As you can see, there’s a lot more to automated testing than just unit tests.
(As we mentioned earlier, you'll have to wait until chapter 7 to see the rest.) For now,
you'll search for the smallest testable part of the application you’re building: a unit.
Depending on your point of view, it may be a class or a separate method. Unit tests
verify this smallest testable part of your application.

A well-designed unit test works with a fully isolated piece of code. It should test the
smallest part of your software without dependencies on other classes or external
resources. Sometimes unit tests are written by the software developer even before the
actual code. They’re perfect material for application verification in the Cl process.
Let’s look at how to use them.

When you’re designing unit tests for the Cl process, you have to keep some simple
rules in mind. The most important in the Cl context are as follows:

+ Make your unit tests fast and unambiguous.
+ Have your unit tests rely on as few dependencies as possible.
+ Let errors drive your unit tests.

Automated
tests
Unit tests
Integration
toests
Regression S;f;t;;“
tests
Acceptance
tests
Other types
of tests

Figure 6.1

Unit tests are a small but important
part of the automated-testing
landscape.
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Unit test should be fast. One unit test should run in a fraction of a second with no
delays and no time-expensive operations. Each small piece of code should be tested in
complete isolation, meaning the test shouldn’t have any access to external resources.
It shouldn’t write to the hard drive, nor should it require network connections. If you
have code that does that, you’ll have to mock it as part of the test. (We’'ll discuss mocks
later in this chapter.)

To illustrate the suspicious-looking rule “Let errors drive your unit tests,” we’'ll
revise a Samuel Beckett saying, “Ever tried. Ever failed. No matter. Fail again. Fail bet-
ter,” and say “Ever tried. Ever failed. No matter. Try again. Fail no more.” We strongly
believe that when it comes to unit tests, you shouldn’t fail more than once. This means
there’s no excuse for not writing a test for every bug. You should be doing error/defect-
driven development. Every time someone finds a bug in your code, you write a test for it,
fix it, and let the test work from then on. It’ll function as a regression test in the
future. You'll be sure that particular bug is fixed for good, and your build will never
again fail because of that bug.

Let’s jump right in, take the financial library you've worked with in earlier chap-
ters, and create a simple unit test for it using NUnit and MSTest. You'll integrate the
tests with the Cl servers. To demonstrate the mocking of functionality in unit tests,
you’ll extend the financial calculator to perform some |/O operations that you can
mock. But before we get into mocking, you need some code to test, and you need to
write some tests for the code.

6.2 First encounters with unit testing
In chapter 1, we introduced a small application that’ll stay with you through your jour-
ney with Cl. It’s your friend the leasing/credit calculator. It can calculate the credit
rate according to several input variables such as contract duration and interest. But
before we dive into some mathematical details of finance, let’s change the calculator a
little by flattening the structure. For better clarity, you'll keep all the projects in your
solution at one level. If you like the structure with external SVN references, feel free to
keep the project that way; but here you’ll modify it. From now on, you’ll have one
solution named CiDotNet with some projects inside, including the calculation core in
a project named CiDotNet.Calc (it contains basically what the Framework external
SVN reference repository had). The Windows calculator is in the project CiDot-
Net.WinCalc, the web calculator is in CiDotNet.WebCalc, and the Silverlight calcula-
tor is in CiDotNet.SilverlightCalc. The sources provided with this book include a
ready-to-use project.

Let’s start with the calculation core and its mathematical details. This informa-
tion isn’t necessary from the Cl point of view, but it’s important to fully understand
the unit tests that will follow. If you're a unit testing specialist, please feel free to
skip the next section.
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6.2.1 The search for perfect unit test material
It’s time to add code to the project so you have something to unit test. Open the

class library project CiDotNet.Calc and add a new class named FinanceHelper, as
shown next.

Listing 6.1 A simple finance mathematical library

using System;

namespace Core.Math
{
public class Finance

{
public enum Mode
{
BeginMode = 1, EndMode = 0
}

private static double CalculateSPPV(double compoundPeriods,

double periodicInterestRate)

return System.Math.Pow (1.0 + (periodicInterestRate / 100),
—compoundPeriods) ;

}

private double CalculateSPFV (double compoundPeriods,

double periodicInterestRate)

return System.Math.Pow(l + (periodicInterestRate / 100),
compoundPeriods) ;

}

private double CalculateUSPV (double compoundPeriods,

double periodicInterestRate)

double uspv = (1 - CalculateSPPV (compoundPeriods,
periodicInterestRate)) / (periodicInterestRate / 100);
return uspv;

}

private double CalculateUSFV (double compoundPeriods,

double periodicInterestRate)

double usfv = (CalculateSPFV (compoundPeriods,
periodicInterestRate) - 1) / (periodicInterestRate / 100);
return usfv;

}

private static double GetCompoundPeriods (int periods, int ppy)

{
return (double) ((ppy * periods) / 12);
}

private static double GetPeriodicInterestRate(

double interestRate, int ppy)
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return (interestRate / ((double)ppy));
}

public static double CalculateRate (int periods, int ppy,
double interest, double presentValue,
double finalValue, Mode mode)

int m = (int)mode;
double compoundPeriods = GetCompoundPeriods (periods, ppy);
double periodicInterestRate =
GetPeriodicInterestRate (interest, ppy);
return -((finalvValue * CalculateSPPV (compoundPeriods,
periodicInterestRate) - presentValue)
/ ((1.0 + ((periodicInterestRate * m) / 100))
* CalculateUSPV (compoundPeriods, periodicInterestRate)));

}

Calculates
monthly
payment

This code seems to include lots of cryptic methods and values, but it’s much easier to

understand than you can tell at first glance. Single Payment Present Value (SPPV) is
the present value of money received in the future at a given interest rate. Single Pay-
ment Future Value (SPFV) is the future value of money paid in the future at a given

interest rate. Uniform Series Present Value (USPV) is the payment required each
period to achieve the future value. And Uniform Series Future Value (USFV) is the

future value of a uniform payment.

All of these values are used in the last and most important calculation: the monthly

payment, with the public method CalculateRate(). It takes as parameters all the nec-

essary data to make the calculation, as shown in table 6.1.

Table 6.1 Parameters to the CalculateRate () method

Parameter Description
periods Number of periods you want to carry the burden of the loan
PPy Periods per year—for example, 12 for monthly payments
interest How much the bank charges you (the interest rate)
presentValue How much money you need right now
finalvValue How much money you need at the end of the loan
mode Whether the bank calculates interest income at the beginning of the

calculation period or at the end

The CalculateRate () method uses the periodic interest rate (annual interest

divided over the number of periods in a year) and compound period rate (payments
in a month). You may consider the decimal data type for use with money-related cal-

culations. You may even want to use your own Money type. We won'’t deal with these

issues, to make the case simpler. After all, we’re chasing the perfect Cl process and
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not financial issues. This small financial library is a perfect fit for the first test case.
You'll test it with NUnit.

Testing with NUnit

NUnit (www.nunit.com) is a legend in the unit testing world of .NET. It’s one of the
oldest automated testing frameworks for .NET and was originally a clone of the Java
test library JUnit. NUnit has the responsibility of running unit tests and providing feed-
back about which tests pass and which ones fail. You’ll see that NUnit is easy to use.
The easiest way to install it is to download the zip file and extract the core of the test-
ing framework from NUnit-Version\bin\net-2.0\framework into your tools directory.

Next, you have to decide where to put the code you write for the unit test. There
are two possible locations for your unit test code: together with the code you're about
to test, or in another project. Both approaches have their plusses and minuses. Put-
ting all the code together lets you test the private members, but creates a dependency
on the unit testing framework. We prefer using separate library classes for the sake of
cleanly separating test and production code. This way, you can easily drop the test
DLLs while building the release on the Cl server. For this example, you'll go this way.

It’s a good idea to use a pattern for the test projects’ names. We like to name them
after the project they’re testing and then add the suffix . 7est. For the example, this
yields the name CiDotNet.Calc.Test.

Further, the test should correspond with the structure of the production code. The
same folder structure and of course one test fixture per class is a good way to go. We
encourage you to give this some thought; there’s no one best pattern for the unit test
infrastructure; something else may work better for you. But keep in mind that your
test suite will eventually grow to hundreds or thousands of test cases.

Now you need to create the actual unit test. Add a new class library project to your
solution, and name it CiDotNet.Calc.Test. Add a reference to the CiDotNet.Calc proj-
ect and then to the nunit.framework.dll. The Finance.cs class lies in the Math subdi-
rectory of the production project, so create a FinanceTestFixture.cs file in the Math
directory of the test project. Add the following code to this new class.

Listing 6.2 A simple unit test for the rate calculation

using NUnit.Framework;
using CiDotNet.Calc.Math;

namespace CiDotNet.Calc.Test.Math
{
[TestFixture]
public class FinanceTestFixture
{
[Test]
public void CalculateRate ()
{
int Duration = 12;
int Ppy = 12;
double PeriodicInterestRate = 7.5;
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double presentValue = 30000;

double finalValue = 0;

CiDotNet.Calc.Math.Finance.Mode mode =
CiDotNet.Calc.Math.Finance.Mode.BeginMode;

double ExpectedRate = 2586.556528260553;

double ActualRate = Finance.CalculateRate (Duration, Ppy,
PeriodicInterestRate, presentValue, finalValue, mode)

Assert.AreEqual (ExpectedRate, ActualRate);

}

NUnit uses reflection to dig the test methods from the test library. It uses attributes to
find what it needs. First, you need to decorate the test class with the [TestFixture]
attribute, which tells NUnit that it’s found a class containing tests. All the test meth-
ods must be public voids and have the [Test] attribute. In the test code, you can do
everything that’s possible in .NET. In the CalculateRate () method, you name the
calculation parameters in local variables and fill them with values. You then define

the ExpectedRate variable and assign it the value that you expect to be returned

from the calculation. The ActualRate variable will be set with the actual calculation
value from the Finance library.

A test needs something that tells it whether it was a success or a failure. This is
called an assertion. The Assert.AreEqual method is part of the NUnit framework. It
compares the ExpectedRate to the ActualRate. If they're equal, the test passes. If not,
the test fails.

You can execute the test a few ways. One of them is to use the GUI test runner that
comes with NUnit, nunit-x86.exe. This is a program that lets you interactively run
your tests and gives immediate feedback on the results. You'll find it in the NUnit-
Version\bin\net-2.0 folder in the NUnit zip archive. Because the ClI unit test process
needs to run with no user interaction, you won'’t need it on the Cl server. But you'll
use it now to demonstrate NUnit’s testing capabilities. The source code included with
this book contains more unit tests for you to browse and learn from.

Launch the NUnit GUI test runner (see figure 6.2). Select File > Open Project,
search for CiDotNet.Calc.Test.dll, and open it. NUnit will load the DLL and prepare
everything for the tests.

The left pane shows the assembly and the test methods you’ve written. You can run
all the tests together or mark separate tests to execute them independently. To start
the test, click Run. The tests will run, and the results will be displayed in the NUnit
GUI (see figure 6.3).

Green means the tests passed and everything is all right. What you don’t want to
see is red, which means the tests failed; or yellow, which indicates that at least one test
wasn’t run.

Let’s make test results more colorful by creating one failing and one omitted test. In
doing so, you'll learn some other NUnit attributes. Copy the CalculateRate () test,
paste it into the same class, and change the name to IgnoreTest (). If you decorate it
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Figure 6.2 The CiDotNet.Calc.Test assembly is loaded into the NUnit GUI test runner and ready to

execute.
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Figure 6.3 If all the tests pass, you see a green bar in the right pane. The left pane shows a check mark

inside a green circle next to each passing test.

with the [Ignore] attribute (in addition to the [Test] attribute), NUnit skips execu-
tion and shows a yellow result when you run the test.

Copy the test again, change the name to FailOnPurpose (), and decorate it with
the [ExpectException] attribute. This informs the NUnit framework that you expect
the tested code to cause an exception. Run the test DLL in the GUI test runner, and
you'll get the colorful output shown in figure 6.4.

All the GUI tests are of course useless in the Cl environment. The Cl server isn’'t as
smart as you are and can’t use GUI tools. You need something that you'll be able to
start from a build script—something that will perform the tests and save the output in
a text file. To do this, you can use a command-line test runner. You'll hook it up to

CruiseControl.NET (CCNet).

Marrying NUnit with CruiseControl. NET
If you want to integrate the unit tests with your CI server, you'll use a command-line tool
and script the process in the build script. NUnit comes with a suitable command-line test
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Figure 6.4 If a single test fails, you get a red result in the right pane. The left pane shows an X inside

a red circle for failing tests, which bubble up all the way to the top-level assembly. One test,
CalculateRate (), passed. The IgnoreTest () method didn’t run, so it displays a question mark
inside a yellow circle.

runner. Add the nunit-console.exe file and all the dependencies (nunit-console-runner.
dll, nunit-console.exe, nunit.core.dll, nunit.core.interfaces.dll, nunit.framework.dll,
and nunit.util.dll) from the NUnit zip file that you downloaded earlier to the tools
directory. To execute the tests you created earlier, issue the following command:
C:\Dev\CiDotNet>1ib\NUnit\nunit-console.exe
CiDotNet.Calc.Test\bin\Debug\CiDotNet.Calc.Test.dll

The console test runner will perform all the tests, as shown in figure 6.5.

In chapter 3, you chose MSBuild as your build engine of choice. You need NUnit to
run from within the MSBuild script. There’s an MSBuild Community Task (see chapter 3)
to run NUnit that you can use, but you’ll now execute it using the exec task as follows.

~
B Adrninistrator: Visual Studse 2008 Command Prompt =B = |

CrwDevsCibotMet >LlibsHUnitnunit-concole.exe CiDotMet.Cale.Test bin“Debug CilotHe—
t.Cale.Test.dll

Hinit wersion 2.4.8 T
Copyright (C) 20A2-2AA7 Charlie Poole.

Copyright (C) 2082-28084 Jamesz W. Mewkirk. Michael C. Two. Alexei A. Uorentsow.
Cugyright {C» 208B-2882 Fhilip Craig.

All Rightsz Reserwed.

Runtime Environment -

0F Uersion: Hicrosoft Windows NI &.H.6HHZ Service Pack 2
CLRE Verzion: 2.@8.58727.4200 C Met Z.08.58727.4208 2

Test: vuan: 8. Failurez: B. Mot run: @, Time: B.152 seconds

C:nDevnCibotHet >

Figure 6.5 NUnit console test runner executing from the command line and performing the tests
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Listing 6.3 MSBuild script running the NUnit tests

<Project DefaultTargets="Build;Test"
xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<Configuration Condition=" '$(Configuration)' == "' ">
Debug
</Configuration>
<TestAssemblies>
CiDotNet.Calc.Test\bin\$ (Configuration)
\CiDotNet.Calc.Test.dll
</TestAssemblies>
</PropertyGroup>
<Target Name="Build" >
<MSBuild Targets="Clean;Rebuild" Projects="CiDotNet.sln"
ContinueOnError="false" />

</Target>
<Target Name="Test" >
<Exec Command="1ib\NUnit\nunit-console.exe Launches NUnit
$(TestAssemblies) /xml=NUnitReport.xml"/> and runs tests
</Target>
</Project>

As you can see, you start the Test target that uses the exec task to execute the nunit-
console.exe application, providing it with the property that contains the DLL to test.
The /xml parameter tells NUnit to create an XML report file. You'll use this file on the
Cl server to integrate the test results within the feedback mechanism.

The build script contains the target named Build, which compiles and rebuilds
the whole solution. You can use it directly as a build script on the Cl server. If your
project resides in a revision-control system (we described how to put it there in chap-
ter 2) and you're still using the CruiseControl.NET configuration from chapter 3,
then you’re good to go. Update the MSBuild script according to listing 6.3, check
everything in, and your Cl process will snap in and perform the build followed by
the test.

Let’s quickly glance at the Web Dashboard to see if everything works correctly (see
figure 6.6).

You can see a lot on the CCNet Dashboard page. It integrates easily with various test
tools. The test tool must be able to produce XML-formatted output; CCNet applies an
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Figure 6.6 CCNet Web Dashboard with a failing project. A red bar under the project is a quick indicator
that something's wrong.
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XSL transformer to the report to show it on the Dashboard. NUnit can produce XML
output. Running NUnit as in listing 6.3 produces a test report called NUnitReport.xml.
On the CCNet server, this file needs to be integrated with the overall build report on
the Dashboard page. To do so, you’ll have to modify the ccnet.config file and the defi-
nition for the CiDotNet project by changing the publishers tag:
<publishers>
<merge>
<files>
<file>NUnitReport.xml</file>
</files>
</merge>
<xmllogger />
</publishers>
Don’t forget to enable NUnit in the CCNet Dashboard Administrator function and
include the xmllogger tag in the publishers tag. It includes the CCNet logs to the
Dashboard page.

The XSL files we've talked about are defined in the dashboard.config file discussed
in chapter 5. It’s usually located in C:\Program Files\CruiseControl.NET\webdashboard
and contains a buildPlugins section. This section controls the build-level Dashboard
page. To show the NUnit report formatted properly, it should contain this line:
<xslReportBuildPlugin description="NUnit Details"

actionName="NUnitDetailsBuildReport" xslFileName="xsl\tests.xsl" />
The NUnit XSL transformer file is provided with CCNet. Similarly, there’s an XSL
transformer for NUnit timings. It consumes the same XML report file to display dif-
ferent data.
<xslReportBuildPlugin description="NUnit Timings"

actionName="NUnitTimingsBuildReport" xslFileName="xsl\timing.xsl" />
If you apply the scenario we've just described, you’ll get an NUnit report like that
shown in figure 6.7.

We'll deal with test analysis and code metrics in chapter 8. But one interesting
code metric comes with unit testing: test coverage. Let’s look at that next.

Examining test coverage

Test coverage is the percentage of your code covered by tests. In this case, it’s the unit
test. What does “code covered by tests” mean? It's the measurement of how many lines
of code are executed by the test code. Some teams strive to cover 100% of their source
code lines with tests. Some teams settle f